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11..  IInnttrroodduuccttiioonn
Coach is a versatile Learning Environment for Science, Mathematics and Technology.
Coach integrates all the tools you need for Measurements, Control, Data Video, Modeling,
Advanced Data Processing and Data Analysis. In Coach you work in an Activity, which is
always part of a Project.

MEASUREMENT The measurement Activities of Coach enable you to collect data from
sensors (e.g. temperature sensor, pH sensor) connected to an interface
(both on-line and off-line, or manually).

CONTROL The Control Activities of Coach enable you to use and create Programs
to control actuators (e.g. a lamp or motor) connected to an interface. So
powerful automated control systems can be designed. The Coach
programming environment offers several modes for creating Programs
(ranging from simple to complex).

MODELING The Modeling Activities of Coach enable you to use and create
dynamical models. The Modeling environment offers both a Graphical
mode and a Text mode. Hypothesis testing can be done by comparing
Model results (calculated data) with experimental results (measured
data).

DATA VIDEO The Data-Video Activities of Coach enable you to collect position-time
data from moving objects in digital videoclips or in a sequence of
pictures.

The data collected from Measurements, Control, Modeling and Data Video can be further
processed with the help of many Advanced Data Processing tools.

Coach 5 offers Authoring tools to prepare tailor-made activities organized in projects, which
offer progression from a simple introduction to an advanced data acquisition or
programming.

Coach is developed by
AMSTEL Institute/CMA, Universiteit van Amsterdam,
Kruislaan 404,
1098 SM Amsterdam,
The Netherlands
E-mail: cma@science.uva.nl
Web site: http://www.cma.science.uva.nl/
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22..  CCooaacchh  aanndd  hhaarrddwwaarree
Measurement and Control activities in Coach supports many different hardware solutions:
• CMA CoachLab I and CoachLab II,
• CMA UIA and UIB interface boards,
• Texas Instruments CBL™, CBL2™ and CBR™,
• Vernier LabPro™,
• Fourier Systems EcoLog™,
• LEGO DACTA® Control Interface and RCX™.
In order to measure and control with Coach the hardware must have been installed. Some
hardware platforms like UIA or UIB cards have to be installed inside the computer, some
other make use of the Parallel or Serial ports of the computer. Manuals of interfaces give
you all technical details about it.
The installation program configures Coach 5 software to the hardware. The setting of the
program must match those made with the hardware. It is possible to change these settings
also inside Coach. See 'I. Coach User Interface, 1.2 Hardware settings'.

33..  IInnssttaallllaattiioonn  ooff  CCooaacchh  55  vveerr  22..11

3.1. System requirements
Coach 5 can be installed on a PC with at least the following requirements:
• A processor which can be compared with Intel 804861,
• 50 MB of free disk space,
• 4 MB RAM (8 MB RAM recommended),
• Recommended screen resolution 800 x 600, 256 colors or better,
• Windows operating system (see the table below).

Hardware Win 3.x Win 95/98 Win NT4 Win 2000

UIA or UIB
LEGO DACTA Interface
CoachLab
CoachLab II
SMI
Crossroads
CBL/CBL2  Data logger
CBR Data logger
LabPro
EcoLog
LEGO DACTA RCX

+
+
+
+
+
+
-
-
-
+
-

+
+
+
+
+
+
+
+
+
+
+

-
-
+
+
+
+
+
+
+
+
+

-
-
+
+
+
+
+
+
+
+
+

                                                
1 If you want to use Coach 5 with the TI CBL and CBR then you need Pentium I machine.
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3.2 Installation
To install Coach 5 ver 2.1 use the provided Coach 5 CD (ver 2.1). Follow the installation
instructions from the 'Installation guide Coach 5 CD ver.2.1'. Coach 5 will install CMA
Coach 5 group with the following icons:

Ø Author
Ø Science Investigations
Ø Control
Ø Data Video
Ø Modeling
Ø Measurements with CBL & CBR
Ø Measurements with LabPro

Installation of Coach 5 ver. 2.1 over a previous Coach version
The new Coach 5 ver 2.1 is installed in different directory (by default c:\CMAC5) then its
previous versions. It is not possible to install Coach ver. 2.1 over an existing program2. This
prevents overwriting of your own projects, activities and results created in previous version.
After new version is installed you can copy your own projects, activities and results by using
'Tools > Project manager' and redefine your profiles by using 'Tools > Profile Editor' in
Coach.
When this is done you have to uninstall a previous version of Coach.

Remark: After the RCX has been re-installed, prepare the RCX hardware for use with
Coach by clicking 'Prepare for Coach' in the RCX Control Panel.

3.3 Uninstall Coach 5
During installation Coach 5 places some information in the Windows Registry. To remove
Coach from your system you have to do following.

For Windows 3.1
• Click the Uninstall icon in the Coach 5 group.
• Remove the directory where the program is installed (default for ver. 2.1 C:\CMAC5).

For Windows 95, 98, NT
• From the Windows Start Menu choose Settings>Control Panel.
• Select Add/Remove programs.
• Select Coach 5 from the list and click Add/Remove.
• Remove the directory where the program is installed (default for ver. 2.1 C:\CMAC5).

                                                
2 In other words it is not possible to install Coach in the directory in which the program is already
installed.
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3.4 Coach 5 program icons
After installation of the software the Coach 5 group with seven icons is created.

Author
This icon starts the Author version of Coach 5 - for creating, modifying and managing
projects. This version includes all student activities described below.

Science Investigations
This icon starts the student version of Coach 5. This project-program is meant for student's
investigations in Biology, Chemistry, Mathematics and Physics.

1 Introduction measurement - for beginners who want to learn about measurement and
processing options of Coach 5. The analysis exercises can be done without hardware.

1 Exploring Biology - consists of examples of experiments related to the subject Biology.
1 Exploring Chemistry  - consists of examples of experiments related to the subject

Chemistry.
1 Exploring Physics - consists of examples of experiments related to the subject Physics.
1 Exploring Mathematics - consists of examples of activities related to the subject

Mathematics.
The experiments in these projects are prepared for a CoachLab II interface but can be used
with other interfaces. Activities are described in the 'Coach System Workbook'.

Control
This icon starts the student version of Coach 5. This project-program is meant for designing
and programming of control systems.

1 Introduction control - for beginners who want to learn about control possibilities of
Coach 5.

1 Examples control - consists of introductory exercises to aid students in learning writing
and executing simple control programs.

1 The workshop - consists of environments to design and program control systems.
Activities included in these projects are described in the 'Coach System Workbook'.

Data Video
This icon starts the student version of Coach 5. This project-program is meant for doing
measurements on digital video clips.

1 Introduction to Data Video  - for beginners who want to learn how to do video
measurement.

1 Data Video examples  - consists of examples of video measurements.
1 Data Image examples - consists of examples of image measurements.
Activities included in these projects are described in the 'Coach System Workbook'.

Modeling
This icon starts the student version of Coach 5. This project-program is meant for creating
and executing dynamical models.
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1 Introduction to Modeling - for beginners who want to learn how to create, modify and
execute models in text and graphical mode.

1 Biology models - consists of examples of models related to the subject Biology.
1 Chemistry models - consists of examples of models related to the subject Chemistry.
1 Physics models - consists of examples of models related to the subject Physics.
1 Mathematics models consists of examples of models related to the subject Mathematics.
Activities included in these projects are described in the 'Coach System Workbook'.

Measurements with the CBL and CBR
This icon starts the student version of Coach 5. This project-program is meant for student's
investigations and laboratory work in Biology, Chemistry and Physics with the Texas
Instruments CBL, CBL2 and CBR Data-loggers. Projects and activities are described in the
'Coach 5 Basic for CBL & LabPro' book.

Measurements with LabPro
This icon starts the student version of Coach 5. This project-program is meant for student's
investigations and laboratory work in Biology, Chemistry and Physics with Vernier LabPro
Data-logger. Projects and activities are described in the 'Coach 5 Basic for CBL & LabPro'
book.

44..  CCoonntteenntt  ooff  tthhiiss  mmaannuuaall
This manual describes the use and all the features and functions of the Coach 5 environment.
Sections from I to VIII of this manual are for Students (and Authors) and describe
possibilities of all Student User modes in Coach.
Sections from IX to XI of this manual are for Authors (Curriculum Developers and/or
Teachers) and describes all advanced Coach options available only for Authors.

General information 
- describes the installation of Coach 5 and Coach 5 program icons.

FOR STUDENTS

I. User Interface
- describes the structure of the Coach environment.

II. Diagrams and Tables
- describes the options of Diagram and Table windows, which can be used in all
types of activities.  

III. Measurement
- describes the features and functions of Measurement activities in Coach.

IV. Control
- describes the features and functions of Control activities in Coach.

V. Data Video
- describes the features and functions of Data Video activities in Coach.
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VI. Modeling 
- describes the features and functions of Modeling activities in Coach.

VII. Coach Language
- provides detailed information about Coach Language which can be used in
Measurement, Control and Modeling activities.

VIII. Advanced Processing 
- describes advanced data processing and analysis options available in Coach.

FOR AUTHORS

IX. Introduction
- gives detailed information about Coach User modes.

X. Projects & Activities
- describes how to create Coach Projects and Activities, how to define Sensors and
Actuators.

XI. Programming & Micro worlds
- describes how to create Micro worlds for Control activities.

XII. Coach Management Tools
- describes Profile Editor and Project Manager.

Appendix I. Network Installation
- describes how to install Coach in the Network.

Appendix I. Coach Shortcuts
- lists Coach shortcuts.

The Advanced label indicates that the information is meant for Advanced users only which
are users with the Coach profile Student.

The TIPS label indicates tips which help you use the software more effectively or to
maneuver you around problems or limitations.

Note: provides information that is generally useful.

Additionally to this guide you should read 'Coach System Workbook' that describes
examples of different Coach Activities, which are included in the software.
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11..  SSttaarrttiinngg  CCooaacchh
To start in Windows 95/98 or NT, click on the Start Menu, Move to 'Programs' and then to
'Coach 5'. Next click on one of the Coach 5 program icons.

1.1 Main Toolbar
After opening Coach (and when you are not yet in a Project), Coach shows the Main
Toolbar.

Exit Coach

Open a Project

Install hardware drivers

Log in

Help

1.2 Hardware settings
The 'Install hardware drivers' allows to install device drivers or change the port number that
an interface is connected to.

To open the Install-Hardware dialog
• Outside a Project, click on the Install-Hardware button.

Figure 1. Hardware drivers dialog.
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To add or remove a driver

• Under the header Available on disk, select the driver(s) you want to install. It is possible
to select several drivers at once by using mouse clicks in combination with <Ctrl> or
<Shift>.

• Click Add if you want to install the driver(s).
• Click Remove if you want to uninstall the driver(s).
• Click OK to confirm, or Cancel to leave the Hardware-settings dialog without making

any changes.

To modify the settings of a previously installed driver

• Under Installed, click a driver to view or modify its settings. The settings are displayed
in the pane at the right side under Settings.

• Click OK to confirm, or Cancel to leave the Hardware-settings dialog without making
any changes.

To detect Interfaces

• Select the name of the driver in the column Installed.
• In the column Settings click the button Detect. Answer the question with Yes.

The settings of the selected driver are being detected by Coach. If Coach detects the
Interface, its settings are automatically adapted. If Coach does not detect the Interface,
then a message appears.

• Click OK to confirm, or Cancel to leave the Hardware-settings dialog without making
any changes.

Note:

- The button Detect is not available for all Interfaces.

- The Interface to be detected should be connected to the computer.

Settings information about interfaces

CoachLab II (coachlb2.dll)
• Select a serial port: 1-4.
• Select the desired Baudrate.

The baudrate is the speed with which the data are being transmitted from the Interface to
the computer. The higher the baudrate, the faster the transmission.
Notes:

- When using the default setting of 9600 baud in combination with very short Measuring
times (< 1 s), the signal of CoachLab II can be somewhat delayed on the screen. If you find
this annoying, try higher baudrate values.

- If CoachLab II is not detected by Coach at all, check whether it is connected with the
original delivered cable.
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TI CBL (cbl.dll), TI CBL 2 (cbl2.dll), TI CBR (cbr.dll),
FS EcoLog (ecolog.dll),
Vernier LabPro (labpro.dll),
LEGO DACTA Interface (labdrv.dll), LEGO DACTA RCX (rcx.dll),
SMI (smi.dll)
• Select a Serial port: 1-4.
• For the CBL, CBL 2 and CBR, select the colour of the used Graph-Link cable: Black or

Gray (older type).
• If available, press the Detect button to automatically select the port.

CoachLab (coachlab.dll), Crossroads (pcross.dll)
• Select a Parallel port: 1-4.
• If available, press the Detect button to automatically select the port.

UIA/UIB board (uix.dll)
• Press the button Detect to automatically detect the settings of the board. If the computer

does not find any values, no board may be built in the computer, or there may be so-
called Interrupt interference (several devices trying to use the same interrupt level). In
the latter case, consult an administrator to solve the interference.

Notes:

- If the UIA/B board is not detected, check whether it is not accidentally connected to the 9-
pin serial port of the computer.

- UIB only: Check whether the setting for the Voltage range of channels 3 and 4 (via a jumper
on the board) is detected properly. If not, select yourself the correct range. If this range is
not correct, a problem may arise with the calibrations of sensors connected to these
channels.

- The same field is also displayed for the UIA board, but its setting is ignored, as the UIA
board has only one range for channels 3 and 4.

- Under Windows look for Control Panel > System > Device Manager > Ports to see
which ports are available.

- See the instruction manual of the interface for further information.
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1.3 Log In

To log in when Coach ask you to do so

• Enter the login name and if necessary the password for access to Coach. Ask your
Teacher if you do not know the name and password.

To log in by s user

• Click the Login button.
• Enter the login name and if necessary the password for access to Coach.

1.4 Help
You can start the Student help by clicking ? button.
Specific help can be found by right clicking a part of the screen or via the tool button  and
selecting help from the appearing context menu.

22..  CCooaacchh  ssttrruuccttuurree
A Coach application consists of Projects and Activities. Coach Project is a set of related
activities that are all stored under project name.  An activity (which is always prt of a
Project) is an individual exercise that can be performed by a student.

2.1 Coach Project
Projects have names and can have a summary and an opening graphic screen.

To open a project

• Click the Open Project button to open the
Project list. In certain situations (like when
starting Coach) the Project list will open
automatically.

• Click a Project title in the list and press OK
(or simply double click a Project title). When
the Project title is selected, its Description is
displayed in the bottom section of the Project
list.

In advanced User modes, it is also possible to
open a Project via the File menu (Main menu).
The Procedure is basically the same as described
above.

Figure 2. Select a project dialog (for students).
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2.2. Project Toolbar
When you are in a Project but not yet in an Activity, Coach shows the Project Toolbar.

Exit Project

Open an Activity

Open a Result

Log in

Help

2.3. Coach Activity
A Coach Activity is the place where students do their work in Coach. An Activity is always
part of a Project.

To open an Activity

• Click the Open Activity button to open the
Activity list. In certain situations (like after
opening a Project) the Activity list will open
automatically.

• Click the Activity title and press OK (or
simply double click the Activity title).

• If a dialog appears that the Panel for the
Activity cannot be found, click here.

In some User modes it is also possible to open an
Activity via the File menu. The Procedure is
basically the same as described above.

Figure 3. Open an activity dialog (for students.
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2.4 Coach Activity Screen

A) Title: Contains the name of the Project and the Activity that you are working with.
B) Menu: (sometimes) Contains menus for controlling of Coach.
C) Toolbar: Contains different buttons at different times. The list of all buttons is given in

the next section.
D) Information Window (with Text)
E) Information Window (with Picture).
F) Sensor Palette: This area on the bottom left side of the screen contains a set of sensor

icons that are available in this activity.  You can drag and drop a sensor from this Palette
to sensor input on an interface Panel in order to take a measurement.

G) Actuator Palette: This area on the bottom right side of the screen contains a set of
actuator icons that are available in this activity. You can drag and drop an actuator from
this Palette to an actuator output on an interface panel in order to control something.

H) Interface Panel: This area of the screen contains an image of the interface panel that you
are currently working with.  In this example the interface panel is CoachLab II.

I) Sensor Input: This area represents input on the interface panel that corresponds to the
real input connector on the real interface panel.  You can drag and drop a sensor to a
sensor input in order to take a measurement.

J) Actuator Output: This area represents an output on the interface panel that corresponds
to the real output connector on the real interface panel.  You can drag and drop an
actuator to an actuator output in order to control a device.

A: Title

B: Menu

C: Toolbar

D: Window (with Text)
E: Window (with Picture)

F: Sensor
Palette

H: Interface
Panel

G: Actuator
Palette

I: Sensor
Input

J: Actuator
Output

Figure 4. Coach Activity Screen.
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2.5 Activity Toolbar
When you are in an Activity, Coach shows the Activity Toolbar. The Activity Toolbar does
not always show all its buttons. It depends on the kind of Activity and the User mode.

Exit Activity

Open an Activity

Open / Save a Result

Print the whole screen

Show/Hide Panel

Measurement settings

Show/Hide Program window

Show/Hide Model window

Start/Stop
Depending on the settings of the Activity, the Start button is used to
Start an on-line measurement, Start a manually-triggered
measurement, Execute a Program, Execute a Model, or Start a Data-
Video measurement.
The red button is used to interrupt all these processes.
Take measurement/Stop
After clicking the Start button, click this button to take a single
measurement. The red button is used to end the counting interval for
the manual-with-counters type of measurements
Replay

Send settings/Get result

These buttons replace the green Start button in case of off-line
measurements.

Yellow buttons

A series of Yellow buttons containing Elements to fill
the Activity windows, like Diagrams, Tables, Texts,
Pictures, etc.

Help
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33..  CCooaacchh  WWiinnddoowwss
In Coach, different types of information (e.g. data, texts, pictures, videos, notes) can be
displayed in up to four windows: the ones which are shown in each Activity. Placing
information in a window can be done either via the Yellow buttons in the Activity Toolbar
or by right clicking in an empty window.

Display of data (Meter, Value, Diagram, Table) can also be placed via a Sensor icon or an
Actuator icon. Use the Show Panel button and Hide Panel button to switch between the
Panel window and the two bottom windows.
The windows have a fixed size, but each window can be maximized to fill the whole screen.
Changing the contents of windows is not possible in all User modes.

Apart from these information windows (which are usually referred to as 'window'), Coach
has a few other special windows: the Program window, the Model window, the Panel
window and the Data-Video window. These windows are always referred to by their full
name.

3.1 Types of Activity windows
The following types of information are available:

1)  Data display types:
• A Meter displays the actual value

of a sensor on a scale of a meter.
For all available Sensor icons, a
decorated Meter is available. For
actuator values, Meters are not
possible.

• A Value displays the actual value
of a sensor, actuator, Formula or
manually-entered data in large
digits.

• A Diagram is a graphical
representation of data along an x-
axis and y-axis.

• A Table displays data in tabular
columns.

• Diagrams and Tables are closely
related.

2)  Multimedia-Information types:
• Texts;
• Pictures (formats: BMP, GIF or

JPG);
• Videos (formats: AVI, MOV or

MPG);
• Notes;

Figure 5. A light sensor meter.

Figure 6. A Information window with Picture.
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• Web pages.

3) Panel window
The Panel Window is located in the lower half of the screen (its position is fixed) and
consists of:
• Sensor Palette at the left side of the window with sensor icons.
• Panel image of the interface you are currently working with. The Panel has inputs (for

sensors) and outputs (for actuators), just like the connectors on the real interface.
Depending on the mode of the Activity, you can drag and drop a Sensor icon on an
input and an Actuator icon on an output

• Actuator Palette at the right side of the window with actuator icons.
If you do not see the Panel, press the Show Panel button.

Sensor Palette: Panel: Actuator Palette:

4) The Model and Program windows:
These windows are described respectively in Modeling and Control sections.

Depending on the User mode, you can:
• Place information via its Yellow button
• Place information via an Empty window
• Display data via a Sensor icon or Actuator icon
• Display a Diagram as a Table, or a Table as a Diagram

It depends on the User mode whether you are allowed to make changes to what is displayed
in a window, and if and which Yellow buttons are present.

- If you want to know about the function of a Yellow button keep your mouse on the
button and a ToolTip with a short description will appear.

Figure 7. The Panel Window.
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- In some User modes it is possible to empty a window by 'closing' it (standard Windows
User interface). By doing so, the information is not lost, only currently not displayed on
the screen. Via the procedures referred to above it can be redisplayed.

- Each Window can be printed or copied to the Clipboard via their Tool menu.

3.2 Handling Window contents
Handling Window contents is not possible in all User modes.

To place information via a Yellow button

• In the Toolbar, click the Yellow button which corresponds to the Information type you
want to display. A list opens with all available items of that type.

• Select an item from the list.
• Click OK, (or click Stop to cancel). The shape of the mouse cursor changes to indicate

the information type you have chosen.
• Click in a window to display the item, or click <Esc> to cancel.

- You can also double-click on the chosen item in the list.
- In more advanced User modes, the lists contain additional buttons to Add, Remove or Edit

Information items.
- When a press on a Yellow button does not lead to opening a list, the only item of that type

is already displayed, or the list is empty.
- A Diagram, Table, Meter or Value can be placed in more windows at the same time. In

this case, the settings for each window are remembered individually (e.g. in one window
you can display the Diagram with the grid on, in another the same Diagram without Grid).

To place information via an empty window

• Right click in an empty window, or press the Tool button.
• Select the desired Information type from the Tool menu. A list opens with all available

items.
• Select an item from the list. The shape of the mouse cursor changes to indicate the

information type you have chosen.
• Click OK to display the item, or click Stop or <Esc> to cancel.

- You can also double-click on the chosen item in the list.
- In more advanced User modes, the lists contain additional buttons to Add, Remove or Edit

Information items.
- When a press on a Yellow button does not lead to opening a list, the only item of that type

is already displayed, or the list is empty.
- A Diagram, Table, Meter or Value can be placed in more windows at the same time. In

this case, the settings for each window are remembered individually (e.g. in one window
you can display the Diagram with the Grid on, in another the same Diagram without
Grid).

To display data (via a Sensor icon or an Actuator icon)
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Data can be displayed on a Meter, as a (large) Value,
in Diagrams or in Tables.
• Make sure the Panel is displayed.
• Right click the Sensor icon or Actuator icon on

the Panel from which you want to display the
data.

• From the Tool menu, select the desired option:
Display as a Meter (only available for sensors),
Display as a Value, Display as a Diagram or
Display as a Table. The shape of the mouse
cursor changes to indicate the type you have
chosen.

• Click in a window to display the item, or click
<Esc> to cancel.

- You can also double-click on the chosen item in the list.
- In more advanced User modes, the lists contain additional buttons to Add, Remove or Edit

Information items.
- A Diagram, Table, Meter or Value can be placed in more windows at the same time. In

this case, the settings for each window are remembered individually (e.g. in one window
you can display the Diagram with the Grid on, in another the same Diagram without
Grid).

To display a Diagram as a Table

• Right click the Diagram window or press the Tool button.
• Select Display as a Table.
• Click in a window to display the Table.

To display a Table as a Diagram

• Right click the Table window or press the Tool button.
• Select Display as a Diagram.
• Click in a window to display the Diagram.

- For display of data: As soon as a Sensor/Actuator icon is placed on the Panel, its Meter,
Value, Standard Diagram and Standard Table are available via their Yellow buttons.

- When your Activity has multiple Text items you can easily browse through them via the
Text Tool-menu (options Previous Text or Next Text) or via the shortcut keys
<Ctrl>+<PgUp> (Previous Text) and <Ctrl>+<PgDn> (Next Text).

- There is only one Notes window possible. So for Notes no list opens and the Notes can be
placed immediately in a window. It is possible, however, to save or open Notes files.

- Notes can be entered and edited by typing (or pasting) in the Notes window.
- When placing a Video, Video play buttons appear.
- Web pages are not displayed in a Coach window, but in the Browser program. After

selecting a Web page from the list, your Browser opens to display the selected Web page.
- For File types for which an association exists in Windows, it is also possible to put a

reference to another program in the Web-page list. I.e. a reference to 'mydoc.doc' will

Figure 8. Displaying data via a Sensor icon.
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open 'mydoc.doc' in Word. The path to the file on your hard disk should be included in the
reference. If no path is included, Coach looks in the current Project.

3.3 Print or Copy Windows
Window contents can be printed and copied to the Clipboard e.g. for use in other
applications.

To print a Value, Meter, Diagram, Table, Text, Picture, Video or Notes

• Make sure the particular item is displayed in a window.
• Right click the window to be printed or click its Tool button.
• Select Print window.

- When printing a video, the current frame is printed.
- A Diagram is printed just as it is currently displayed, i.e. Zoom information; Scan

information and Comments are printed along.

To print the whole Coach screen

• Click the Print button to print the whole Coach screen exactly as it is shown at that
moment.

To copy an Information item to the Clipboard

• Make sure the particular item is displayed in a window.
• Right click the window to be printed or click the Tool button.
• Select Clipboard Copy.
• Paste the item in another Windows program (Word processor, Text Editor, Drawing

program, Spreadsheet, etc.), by using Paste there.

A Text will be pasted as text, a Meter as a picture, a Value as a picture, a Diagram as a
picture, a Table as columns with numbers (including 2 header rows with the Quantity and
Unit of the data range). When copying a Video, the current frame will be pasted as a picture.
When you use Direct-X hardware acceleration, it may be (on some computers) that videos
can not be pasted correctly from the Clipboard.

- When copying a Diagram to the Clipboard: Zoom information; Scan information and
Comments are copied along. A Diagram is always exported as a picture.

- When copying a Table to the Clipboard: the selected part of the Table will be copied
including 2 header rows with the Quantity and Unit of the data ranges. When no selection
is made, only the visible part of the Table is copied.

- Texts, Tables, Control Programs and Models can also be copied to the Clipboard using
Text edit commands or keys (Cut (<Ctrl>+X), Copy (<Ctrl>+C) and Paste
(<Ctrl>+V)).

- When copying a Table with the Copy command (Ctrl+C), the header rows are not
included.
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- Press the Printscreen key (<PrtSc>) to copy a picture of the whole screen on the
Clipboard or <Alt>+<PrtSc> to copy the active window to the Clipboard. (Standard
Windows feature).

3.4 Add, Remove or Edit Information list items
In advanced User modes there are extra buttons available in most Window content lists
(Information lists). Use these buttons to create, add, remove or edit list items.
The function of the buttons which can appear in Information list dialogs are described
below:

 New
Create a new Diagram (Diagram list)
or Table (Table list):
• Fill in the Create/Edit dialogs.

Create a new Text:
• Enter a Title.
• Select the Title from the list.
• Place the empty Text in a Window.
• Create the Text by typing (or

pasting).

Add
Add a Picture or Video:
• Browse the disk to find a Picture

(Picture list) or Video (Video list).
• Answer OK to the question to copy

the item to the current Project.

Add a Web Page to the Web-page list
• Add a URL (i.e. a Web page address) and the Title which is displayed in the Web-pages

list.

Edit
Edit the selected list item.

Delete
Delete the selected list item
Warning: Deleting list items is irreversible. The only way to recover is to reopen the
Activity or Result and start again.

Browse
Browse a disk for new items.

Import Table
Create a new Table with imported data (only in the Table list).

Figure 9. Select a picture dialog. Add, Edit and Delete
buttons are available in this window.
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• Select the format of the data to import;
• Import the data.

Background graph
Create an empty Diagram with a Background graph (only in the Diagram list).
• Open a Result.
• Import the Background graph.

- List items are ordered alphabetically, but numbers take precedence. If the items in a list
should have a pre-defined order, start the titles with a number (e.g. 1,…,9, or 01…99,
etc.).

- Apart from references to URLs, the Web-page list can contain references to all registered
file types i.e. the file types which have an association to a program (e.g. a reference to
MYFILE.DOC will open MYFILE.DOC in MS-Word).

44..  FFiillee  mmaannaaggeemmeenntt

4.1 Managing results
A Coach Result is the result of your work in an Activity. It consists of all elements of the
Activity (like texts, pictures, videos, etc.) together with your changes and resulting data (for
example Notes, measurement data, your own calibrations, Modeling data, a Model, a
Control Program, etc.).
You can continue working in a Result in the same way as you do in an Activity.

To open a Result in a Project

• Open a Project.
• Click the Open Result button to open the

Result list. This list shows all Results in the
Project.

• Select the Result title and press OK (or
simply double-click the Result title).

If the Activity list was opened automatically,
first close it by clicking Close before opening a
Result.

To open a Result in an Activity

• Open an Activity.
• Click the Open Result button to open the

Result list. This list shows all Results of this
Activity.

• Select the Result title and press OK (or simply double-click the Result title).

To save a Result

• Click the Save Result as... button.

Figure 10. Open result dialog.
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• Enter the name of the Result.
• Click OK.

To delete a Result

• Click the Open Result button or –in an Activity– click the Save Result as… button to
open the Result dialog.

• If necessary click Browse to select a Result in another location.
• Select the name of a Result.
• Click Delete and click OK to confirm.

In advanced User modes it is also possible to open or save a Result via the File menu. The
Procedure is basically the same as described above.

Results are located in the current Project directory by default. In advanced User modes a
Browse button is available to browse to another location for opening/saving a Result.
Deleting a Result is only possible for Results in the current Project.

4.2 Managing Notes
Advanced users can open or save Notes as a text file (.TXT). Notes of other users are limited
to one Notes window included in the Result.

To open a Notes file

• Select File > Notes > Open (in an Activity/Result). The opened Notes file can be shown
by displaying Notes in a window via the Notes button.
A Notes file from Coach can be opened only when it was saved first.

To save a Notes file

• To save Notes in a file, select File > Notes > Save in the menu of an Activity/Result.
• Enter a filename.

Figure 11. Save Result dialog.
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• Click OK to confirm.
The Notes do not have to be displayed at the moment of saving.

To save a Notes file under a new name

• To save Notes under a new name, select File > Notes > Save as in the menu of an
Activity/Result.

• Enter a filename.
• Click OK to confirm.

The Notes do not have to be displayed at the moment of saving.

Notes files are located in the current Project by default. In the dialog under Directories, it is
possible to browse to another directory to open/save the Notes elsewhere. With the button
Current Project, you can easily return to the current Project directory.

4.3 Exchanging data with other Windows applications

Export from Coach
Direct export of information in Coach (such as Text, Data, Diagrams, Pictures, the Panel
picture (including connected Sensor icons and/or Actuator icons), is possible via the
Clipboard.
In advanced User modes, data can also be exported to files via a Table.

Pasting data in Coach
Use the procedure below to paste data
- from other applications (Excel, Ascii files, Web pages) into Coach;
- from a Table column to another column of the same Table (i.e. within the same

Activity);
- from a Table to another Table (within the same Activity).
It is not possible to paste a Diagram directly into Coach.
• Copy the desired data to the Clipboard.
• Create a new Table.
• Right click the Table window en select Text edit > Paste, or press <Ctrl>+V.

In the Table the required number of columns of type Manual input is automatically
created and the data appear in the Table. Via the Table settings you can edit the Table
(e.g. the Quantity, Unit and number of decimals).

- Data in files with different formats can be imported in Coach via the Table Tool-menu
option Import data.

- Use the Table Tool-menu option Display as a Diagram to create a Diagram from the
data.

Importing Pictures and Videos in Coach
Pictures and Videos to be imported should first be saved to disk and then be added to a
window contents list.
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55..  PPrroobblleemmss  wwhheenn  rruunnnniinngg  CCooaacchh::  TTrroouubblleesshhoooottiinngg
This section gives some solutions to problems that may arise when you try to run Coach.

L Problem: Coach is not able to communicate with connected interface on opening an
Activity or Result.
☺ Solution: This is the case when
- the Activity/Result is developed for another interface than the one you are currently using;
- there is no interface connected to the computer;
- the communication between interface and computer is lost somehow.
A dialog box tells you that 'Coach cannot initialize Panel <Name>'. It has three or four
buttons.
Read below the description of buttons
which button you can press best in
certain situations:

Abort - The Activity/Result will not
open. Nothing happens. Choose this
option if the interface is connected to
the computer to change the settings of
the driver.

Ignore – The Activity/Result opens
and the Panel will be inactive (i.e.
measurement and control are not possible). No values and states are shown on Sensor and
Actuator icons. You can however modify the Activity and save it as a Result. If this
Result is opened when the Panel is available, it will work. In advanced user-modes it is
also possible to change the Panel in the Activity via the menu option Tools  >  Switch
Panel.

Retry – Coach tries to activate the Panel again. This option can be useful with CoachLab 
II. (To reset CoachLab II, briefly disconnect it from the mains and reconnect it. The LEDs
will flash). Now press Retry.

Select Panel – (This button is not always available). A list of alternative Panels for this
Activity/Result opens. Select the Panel which is connected to your computer. If the name
is not on the list, a driver for the interface must be added to Coach in the Hardware
settings. Ask your Teacher or System administrator for help.

Which button to press?
Check whether the name of the connected interface corresponds with the name of the Panel
Coach tries to initialize.
- If the name of the connected Interface does not correspond to the name of the Panel, press

the button Select Panel (if available).
- If the button Select Panel is missing (i.e. no Alternative Panels have been defined by the

author of the Activity) press Ignore.
- If the name of the connected interface corresponds to the name of the Panel, there may be

a communication problem. Reset the Interface and press Retry. If the communication is
still not restored, ask your Teacher or System Administrator to check the Hardware

Figure 12. An error dialog box.
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settings of the Interface (e.g. is the right COM port or Parallel port selected? Is the right
IRQ and/or Adapter address used? etc.).

L Problem: Coach is not able to communicate with connected interface in an Activity (you
can see this that the values on the Sensor icons do not change at all for a longer period of
time. Normally, these values always fluctuate a little bit due to noise):
☺ Solution: Reset the Hardware. Right click the Panel and select Reset Hardware.

L Problem: When measuring with an Interface connected to the parallel port, the
measurement values jump to a certain fixed value at regular time intervals. (The result is a
graph with strange peaks at regular distances).
☺ Solution: There is still a print job in the background for a printer which is also installed
on the parallel port. The print job does not have to be given in Coach. Windows tries at
regular time intervals to execute this print job. Throw away this print job and the problem is
solved. A more rigorous solution is to install a second parallel port in the computer and
assign the Interface to the second parallel port (LPT2:) in the Hardware settings.

Advanced Problems

L Problem: The option "With a Program" is not available in my Time-based measurement
Activity.
☺ Solution: Set the Frequency in the Measurement settings to another setting than Manual
or Manual with counters.

L Problem: A Diagram/Table with variables from a Program is not filled during a
measurement run.
☺ Solution: The Activity type is set to Control with a Program and SaveData is not used
in the Program to store the values. Use the command SaveData in the Program or set the
Activity type to Time-based measurements.

L Problem: The saved *.CSV file is not interpreted correctly in another application.
☺ Solution: Do not select a comma as separator when the comma is also used as decimal
separator (e.g. use <Tab> or another symbol). If necessary check your decimal separator in
the Regional settings in Windows' Control Panel.

L Problem: The saved *.CSV file cannot be opened by another application.
☺ Solution: Check the setting of the List separator in the Number tab of the Regional
settings in Windows. This separator should be set to ',' (comma) rather then to ';'
(semicolon), which is the usual choice in languages where comma is the decimal separator.

L Problem: Coach does not react at all.
☺ Solution: Probably you are modifying a Meter Display picture in a Drawing program. As
long as the Drawing program is open, Coach is completely deactivated. Use the program's
Save command to store your Display picture (if desired) and close the Drawing program.
Now Coach is activated again.
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11..  DDiiaaggrraamm  aanndd  TTaabblleess  iinn  CCooaacchh

1.1 Introduction
Diagrams and Tables are different representations of the same information. Diagrams and
Tables share a number of settings (among which their name): irrespective where these
settings are changed, they are reflected both in the Diagram and the Table. Also the contents
of the Diagram is synchronized with the contents of the corresponding Table. This is also
called a ‘Diagram/Table pair’.
Diagram or Table can have up to eight data sets called Data ranges (columns) labeled C1  .. 
C8.

A Standard Diagram or Standard Table is created automatically when a Sensor Icon or
Actuator Icon is placed on the Panel.

Standard Diagram
A Standard Diagram is a Diagram with the Clock (time) along the horizontal axis (Data
range C1) and the quantity of the sensor/actuator along the first vertical axis (Data range
C2).
For Event-based measurements, the Row Index replaces time along the X-axis.

Standard Table
A Standard Table is a Table with the Clock (time) in the first column (Data range C1) and
the quantity of the sensor/actuator in the second column (Data range C2).
For Event-based measurements, the Row Index replaces time in C1.

To place a standard Diagram/Table in a Window

• Make sure the Panel is displayed.
• Right click the Sensor icon or Actuator icon on the Panel from which you want to

display the data.
• From the Tool menu, select the desired option: Display as a Diagram or Display as a

Table. The shape of the mouse cursor changes to indicate the type you have chosen.
• Click in a window to display the item, or click <Esc> to cancel.

Figure 13. A Standard Diagram and Table created via a Temperature sensor icon.
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1.2 Scanning data
The option Scan can be found in the Diagram Tool menu. It is used to read coordinates of
points on graphs or of other points in the Diagram window. A crosshairs in the Diagram
window marks the scanned point. The coordinates of the point are displayed in a box in the
upper right corner of the Diagram window.
If the corresponding Table is displayed while scanning, the row with the nearest x-
coordinate is selected in the Table.
In a Table, values can be read directly by using the scroll bar.

To scan points in a Diagram

• Right click in the Diagram window or
press the Tool button.

• Select Scan.
• Click a point of the graph and read its

coordinates in the co-ordinate box.
• Move through the data points with the

mouse or with the right and left arrow
keys.

• Stop scanning by pressing <Esc> or by
selecting Stop scanning from the
Diagram Tool menu.

When there are several graphs in the
Diagram, the crosshairs always sticks to
the first data range assigned to a vertical axis. The coordinates of all graphs are displayed,
however.

To scan any coordinates in the Diagram window

• Use the <Ctrl>-key together with Scan to read the coordinates of any point in the
Diagram window.
Use this option e.g. to read coordinates from Predicted graphs, or to extrapolate an
intersection with a Diagram axis.

1.3 Erasing data (runs)
This Topic describes how to remove complete data runs from the Diagram and Table.

To erase all data in a Diagram or Table

• Right click in the Diagram window or Table window, or press the Tool button.
• Select Erase all values. All data from the linked Diagram and Table are erased.

To erase data from Previous runs in a Diagram

• Right click in the Diagram window, or press the Tool button.
• Select Delete Background graphs > Previous runs.

Figure 14. Scanning data in the graph.
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Notes:

- By clicking <Shift>+Start button (or <Shift>+<F9>) you erase all Results on the screen and start
a new run.

- Old data runs are grayed. They are available on screen only, not as data. Each new run, the
Older runs will be more vague. They can be printed.

1.4 How to keep old runs active?
The default behavior of Coach is that when a measurement run is followed by another run,
the data of the previous run is overwritten, and its graph becomes gray (it is only displayed
on the screen). In this way maximal 4 previous data runs are displayed in the Diagram. The
option Copy column allows to keep more runs active.

To copy column

• After a measurement run, right click the Diagram or Table.
• Select Copy Column.
• A submenu appears with all quantities in the Diagram/Table.
• Select the quantity which has to be copied.
The column containing the data is copied into the first empty column of the Table with data-
range type Manual input and Quantity 'Old quantity'. During the next measurement run,
this data is repainted in the Diagram.
Note: When the Table is full (8 columns), the command disappears from the Tool menu.

1.5 Diagram/Table Settings
A Diagram or Table can have up to eight data sets called Data ranges (columns) labeled C1 
..  C8. The settings of the active data range are displayed in the lower part ('Column') of the
Create/Edit dialog box.

To open the Create/Edit Diagram dialog or the Create/Edit Table dialog

• Right click in a Diagram window or Table window or click the Tool button.
• Select Create/Edit Diagram or Create/Edit Table.
Or
• Click the Display-Diagram button or the Display-Table button. Or right click in an

empty window and select Display Diagram or Display Table.
• Select a Diagram/Table from the list.
• Click Edit.
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The Create/Edit dialogs
Create/Edit dialogs for Diagrams and Tables
have two section: The upper section
('Diagram' or 'Table') containing the name
and a few general settings, and a lower
section ('Column') which contains the settings
for each Data range. There are only a few
small differences between these dialogs:
- In the Create/Edit-Diagram dialog,

horizontal and vertical axes can be
assigned to Data ranges, a Diagram style
can be assigned to all Data ranges along
vertical axes, and there are options for the
Grid and to keep the axes ratio the same.

- For a Table there are options to show Row
numbers and Column letters and no axes
nor styles can be assigned to data ranges.

In some User modes it is not possible to
change pre-defined Data ranges.

1.5.1 Items in the upper section ('Diagram' or 'Table')

Name
A Standard Diagram or Standard Table automatically gets the name of the input or output
and its connected sensor or actuator. The name can be edited. For a new Diagram/Table you
have to type the name yourself.

Note: The name of a linked Diagram and Table stay the same, so when editing the Diagram's
name, the Table's name changes along, and vice versa.

Show grid  (Diagram only)
When marked the grid is displayed in the Diagram.

Keep ratio (Diagram only)
When marked, the units along the horizontal and vertical axis in the Diagram use the same
number of screen pixels.
Example: With Keep ratio marked, a circle will be displayed as a real circular shape on the
screen (rather than an ellipse).

Show Row index Show Column letters (Table only)
When marked, the Row index (the row number of the data point in the Table) respectively
the Column letters (C1, C2, etc.) are displayed in the Table.
By default, Row index=On and Column letters=Off.

Figure 15. Create/Edit Diagram dialog.
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Items in the lower section ('Column')

Data range
Each Diagram/Table can have up to eight data sets called Data ranges (the columns of a
Table) labeled C1 .. C8.
• Click one of the Data ranges to select it. The settings of the selected data range are

displayed in the lower part of the dialog.

Connection
The connection is used to couple a data set to a Data range, e.g. data from the clock or a
connected sensor or actuator, manually entered data, or a formula. To couple data to a Data
range, make sure that this Data range is selected (highlighted). Then make a selection from
the Connection drop-down selection list.

Axis (Diagram only)

Horizontal The selected Data range will be displayed along the x-axis.
Note: In a Standard Diagram or Table, C1 (the Clock, i.e. time) is
assigned to this axis. Only one Data range can be assigned to the
horizontal axis of a Diagram: by selecting another Data range for the
Horizontal axis, the previous one will be automatically set to Invisible.

First
Vertical

The selected Data range will be displayed along the first y-axis (left
side).

Note: In a Standard Diagram or Table, C2 (the quantity of the sensor or
actuator is assigned to this axis.

Second
Vertical

The selected Data range will be displayed along the second y-axis (right
side). The scale of this axis is completely independent of the first vertical
axis and will also be re-scaled automatically independent of the first
vertical axis.

Note: When a Result of a processing is added to a Diagram, this Result is
automatically assigned the second vertical axis.
This axis can be used when two quantities with very different scales have
to be displayed on a vertical axis.

Invisible
(Diagram
and Table)

The selected Data range will not be displayed.

Note: This option is useful for example when the data are only used as
source for a Formula, but do not have to be displayed in the
Diagram/Table itself.

Quantity
The quantity of the data in the active Data range.
Note: The Quantity name should be unique in the Diagram or Table. The Quantity name is also
used as a variable name in Formulas.

Unit
The unit of the data in the active Data range.
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Decimals
A local Diagram/Table setting for the active Data range. This number of decimals is
displayed along the axes of the Diagram, for the values of the Data range in the Table and in
the Coordinate box when scanning the Diagram.
Note: For a Standard Diagram or Table, the number of decimals is read from the Sensor properties
or Actuator properties. As soon as this value is changed in the Diagram/Table settings, the
specified setting is used.

Min. (Diagram only)
The minimum value along the specified axis in the Diagram for the active Data range.
Note: For a Standard Diagram, the minimum value is read from the Sensor properties or Actuator
properties.

Max. (Diagram only)
The maximum value along the specified axis in the Diagram for the active Data range.
Note:
- For a Standard Diagram, the maximum value is read from the Sensor properties or Actuator
properties.
- The duration of a measurement is only determined by the Measurement settings, not by the
maximum of the time axis in the Diagram settings).

1.6 Data-range Connection types
The Connection type can be found in the Create/Edit-dialog of a Diagram or a Table. It
specifies the type of data assigned to a Data range (corresponding to an axis in a Diagram
and a column in a Table). The following Connection types can be chosen:

Empty
A Data range without Connection (the default
setting). When the Connection of a Data range is
reset to Empty, data is erased from the
Diagram/Table. Clock data and data from Panel
inputs and outputs will still be available for selection
in other Data ranges. However, Calculated data
(from Formulas) and Manual-input data are lost
when their Connection is reset to Empty in the
Diagram/Table where they were defined.

Manual input
Select this Connection type for Manually-triggered
measurements with data entry. Then Coach prompts
to type the quantity values for all Data ranges with a Manual-input Connection each time the
Take-measurement button is pressed.
The Manual-input Connection type should also be chosen when data is directly typed in the
cells of a column. Further, Data ranges with imported data automatically are set to Manual
input.

Figure 16. The list of connection types
for a Data range.
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Manual-input Data ranges are not erased during next runs, but are redisplayed instead (with
the same data). This feature can be used to keep data of previous runs active.

Note: Manual-input Data ranges are automatically assigned a minimum value of –10 and a
maximum value of +10. If these values are not realistic for the data, adjust them manually or
press Zoom-to-fit.

Formula
This Connection type is used to assign a Formula to a Data range. In a Formula, data
assigned to other Data ranges of the same Diagram/Table can be used as variables. Data
ranges with Formulas are automatically recalculated. So during a new run, the newly
calculated values will appear in real-time.

Note: Formula Data ranges are automatically assigned a minimum value of –10 and a
maximum value of +10. If these values are not realistic for the data, adjust them manually or
press Zoom-to-fit.

Row index
The Row index is the row number of the data point in the Table. Coach assigns Row Index
to the first Data range (C1) of a Standard Diagram or Standard Table for Manually-triggered
measurements.

Clock
The Clock is the Connection type which represents time data. It is usually connected to Data
range C1 along the horizontal axis in a Standard Diagram or to Data range C1 of a Standard
Table.

Panel Inputs and Panel Outputs
These Connections depend on the inputs and outputs of the used Panel. All available inputs
and outputs are listed either with the connected sensors/actuators or as (Nothing
connected).
For example Analog In 1: Light sensor represents the data measured through the light
sensor connected to input 1 of the real interface.

Variables from a Control Program or from a Model
These variables appear in the list automatically as soon as they are defined in the Control
Program or Model.

- The box with coordinates can be moved to another position by dragging. This is .g.
handy when the box interferes with data points, or to display it more prominently.

- By clicking on a point outside the graph, Scan chooses the point of the graph which has
the same x-coordinate. When using <Alt>+Click, the point of the graph is chosen which
is closest (measured with a straight line) to the clicked point.

- Scanning is limited to the visible part of the Diagram. Zoom out when coordinates of a
graph(s) in another part of the Diagram need to be read.

- When the Diagram is printed or copied to the Clipboard, the Scan information is
included.

Note: If you want to store coordinates, you have to write them down, or type them in a Notes
window. It is not possible in Coach to store the scanned coordinates automatically.
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1.7 Create/Edit Diagram/Table
The options described in this topic are not available in all User modes.

To create a new (empty) Diagram/Table

• Click the Display-Diagram button or the Display-Table button. Or right click in an
empty window and select Display Diagram or Display Table.

• Click New. The Create/Edit dialog opens for an empty Diagram/Table.
• Fill the Diagram/Table via the Diagram/Table settings.

To edit a Diagram/Table in a window

• Right click in the Diagram window or the Table window, or click the Tool button.
• Select Create/Edit Diagram or Create/Edit Table. The Create/Edit dialog of the

selected Diagram/Table opens.
• Edit the Diagram/Table via the Diagram/Table settings.
The Diagram settings or Table settings can also be opened directly via the shortcut
<Ctrl>+Tool button (not in all User modes).

To edit a Diagram/Table via the Window contents list

• Click the Display-Diagram button or the Display-Table button. Or right click in an
empty window and select Display Diagram or Display Table.

• Select a Diagram/Table from the list.
• Click Edit.
The Create/Edit dialog of the selected Diagram/Table opens.
• Edit the Diagram/Table via the Diagram/Table settings.

To add a graph to an existing Diagram or a column to an existing Table

• Open the Create/Edit dialog of the Diagram/Table.
• Select a Data range C1  ..  C8 which Connection is Empty. In an existing

Diagram/Table often C3 is the first empty Data range.
• From the Connection Drop-down selection list, select a connection for the Data range,

i.e. a sensor connected to a Panel input or a Formula.
• Enter or modify the settings for this Data range (options are available depending on

whether you add the data to a Diagram or a Table), e.g. the quantity, unit, minimum,
maximum, number of decimals and the Diagram style, or enter the Formula.

• Click OK to confirm (the new data range appears automatically in the Diagram/Table),
or Cancel to leave the Create/Edit dialog without changes.

1.8 Create a Formula
A Formula can be used to do calculations on data in Diagrams or Tables. You can start the
Wizard to assist you to create the Formula or type a Formula yourself.

To create a Formula

• Right click a Diagram window or a Table window or press the Tool button.
• Select Create/Edit.
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• Select an empty Data range C1 .. C8. (i.e. its Connection should be Empty). In an
existing Diagram/Table often C3 is the first empty Data range.

• Set the Connection to Formula.
• Click the Formula wizard button. Depending on the User mode, you will enter the

Formula Wizard dialog (see below), or the Formula Editor dialog.
Or:
• Type the formula In the Formula-field (for experienced users).
• Enter a suitable name for the Quantity and Unit.

1.8.1 Formula Wizard (Junior student)

• Create the Formula by selecting quantities and (simple)
operations from the list.

• Select Number when you need to enter a number in your
formula.

• Select Ready to close the Formula wizard.

- Existing Formulas can also be selected as a Data range
connection in other Diagrams/Tables.

- Formulas are automatically evaluated. So in a next run,
the values of the Formula appear automatically in the
Diagram/Table.

- In a Formula, you can only select the quantities which are assigned to the data ranges of
the same Diagram or Table. If you need to include a quantity in the Formula, which is
not yet available in the list, first assign this quantity to a Data range.

- If only the result of the Formula should be shown in the Diagram, set the other Data
ranges to Invisible.
Example: Display a temperature in degrees Fahrenheit instead of degrees Celsius.

Notes:

- Some words and characters may not be used.

- Coach gives an error message when the resulting formula does not have the correct syntax.

1.8.2 Advanced Formula editor
(Senior student)
When working as a Senior Student, you
have the advanced Formula Editor for
creating Formulas rather than the
Formula Wizard.

To create a Formula with the Formula
Editor
The Formula Editor assists you to create
an advanced Formula.
Create the Formula by selecting
variables, Arithmetical operations,

Figure 17. Formula wizard window.

Figure 18. Formula Editor window.
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Standard Mathematical functions, Mathematical operations, and typing numbers.
- For inexperienced users, it is recommended to use the Formula editor to guide you in

creating correct formulas rather than free typing.
- Advanced formulas are evaluated automatically, and can be used to 'measure' the

calculated value in real-time.
- For example: a position is measured against time, via a formula with the derivative, the

velocity is prepared in the Diagram. During the measurement, both the position and the
velocity are 'measured' in real-time.

Notes:

- For mathematical operations which use more than one parameter (e.g. Filter(;)), it is necessary
to move the cursor to the position of the next parameter.

- Some of the mathematical operations are placed automatically in the Diagram/Table settings
as a result of a Processing operation (Derivative, Integral, Filtering or Approximation) in a
Diagram. They also can be entered manually. For an overview of the functions, click here.

- Coach does not allow to nest these formulas.

22..  DDiiaaggrraamm  ooppttiioonnss

2.1 Introduction
A Diagram is used to graphically display
data points in Coach. Data points can be
originating from sensors, from the clock,
from calculations, from a Control Program,
from Video measurement, from manual
entry etc.
The way the Diagram is displayed on the
screen is called the Diagram Style.
On starting a measurement (or model
execution) with the Start button, a graph is
displayed in the Diagram. A Diagram can
contain several graphs. Usually the graphs
are distinguished by means of a color.
Most options described below can be
reached via the Diagram Tool menu. Several options appear only when there are data points
available in the Activity.

To open the Diagram Tool menu

• Right click in the Diagram window or click the Tool button.

2.2 Diagram style
The Diagram style determines how the graphs in a Diagram will be displayed. Each graph
has a unique style. The Diagram style settings are stored in the saved Result.

Figure 19. A measurement graph in the Diagram
window.
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To open the Diagram-style dialog

• Right click the Diagram window or press the Tool button.
• Select Diagram style. You can change the settings for the Grid, Colours, Markers and

Connection types.

Show grid
The Grid setting applies to the Diagram as a whole.
• Mark/Unmark Show grid to switch the grid On/Off.

The settings in Colours, Markers and Connection types section apply to individual
graphs. Each graph is linked to a Data range (C1 .. C8). When there are two or more graphs
in the Diagram:
• Click the Data range (C1 .. C8) for the graph to change its style attributes.

Colour
The colour applies to the Markers and Line style used for this graph. The colour is also used
for the name of the corresponding Quantity and Unit along Diagram axes.
• Select a colour from the drop-down list. When setting the Colour of the graph the same

as the background colour of the Window (white by default) the graph becomes invisible.

Marker
A Marker is used to mark the individual data points.
• Select a Marker (None , Cross, Small dot, Big dot) from the drop-down list. If

Marker=Small dot and Connection type=Line, the Small dot is not visible (the dots
are overlapped by the line). The same may apply to other markers when the Line width
is set to a thicker line.

Connection type
Connection type specifies if and how individual data points are connected. When
Connection type = Line, all data point are connected by straight lines. When Connection
type = Histogram, all data points are connected to the X-axis by a vertical bar.
• Select a Connection type (None, Line, Histogram) from the drop-down list.

Line width
• Select a line width (5 grades of thickness) from the drop-down list.

Figure 20. Diagram style window.



GGUUIIDDEE  TTOO  CCOOAACCHH  --  4455

The setting of Line width does not display when Connection type = None.

Reset
Press Reset to reset all the above attributes to their default setting. The default settings are:
Grid  =  Off, Marker  =  None, Connection type  =  Line, Line width  =  <Thinnest>

- The style of a Background graph can also be edited. As soon as the Diagram contains a
Background graph, the Diagram style dialog has an extra pane for the style settings of the
Background graph.

- The style of the graphs can also be edited in the Create/Edit Diagram dialog (not possible
in all User modes).

- If no graphs appear in the Diagram, check whether both Marker and Connection type
are set to None. With this setting, the particular graph will be invisible.

- The defaults Marker  =  None and Connection type = Line are chosen for reasons of
visibility only. The best way to display data from computerized measurement process is to
select a Marker  and setting Connection type = None, but when a measurement consist
of many points, there may be confusion which point follows which. The connection with
lines neutralizes this confusion.

 Examples of diagram styles

Marker=None Connection type=Line

Marker=None Connection type=Line (thicker line width)

Marker=Cross Connection type=Line

Marker=Big dot Connection type=Line

Marker=Big dot Connection type=None

Marker=Big dot Connection type=Histogram

2.3 Zoom
By zooming in an area of the Diagram will be enlarged, e.g. for closer inspection.
- The Zoom-out button in the Diagram window title bar indicates that the Diagram is in a

zoomed-in state. This may be the reason that you do not see the data properly displayed.
Press <Ctrl>+Zoom out to restore the Diagram in its unzoomed state. If you still do not
see your data, press Zoom to fit to optimally display the data in the Diagram.
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- The zoom state is remembered by Coach (unless you change the Measurement settings). If
you change other settings which you do not see immediately in the Diagram, you are
probably in a zoomed-in state. Zoom out to see the changes.

- If you want to zoom in before a measurement: Make sure the zoom frame is as long as the
whole x-axis, otherwise the measured data is partly visible the Diagram.

- A zoomed Diagram is printed or copied to the Clipboard exactly as it is displayed on the
screen.

To zoom in
If the mouse cursor has the shape of a magnifying glass in the Diagram window:
• Drag an area to zoom in. The area will be enlarged to fill the whole Diagram.
Otherwise:
• Press <Esc>, or Right click the Diagram window or press the Tool button.
• Select Zoom in.
• Drag an area to zoom in.
• When desired, repeat the procedure to zoom in further.

To zoom in automatically
With this option, Coach automatically evaluates all values in the Diagram and re-scales the
X-axis and Y-axes to optimally display all graphs.
• Click the Zoom-to-fit button, or select the option Zoom to fit from the Diagram Tool

menu.

- The shortcut <Ctrl>+Zoom to fit only zooms automatically in the vertical direction. This
is a handy feature when zooming during a measurement: the horizontal time axis will be
left alone. (With the regular zoom-to-fit option, the next measured point will be already
outside the visible part of the Diagram).

- When several Data ranges are displayed along a vertical axis, the zoom factor is
determined such that all quantities are displayed optimally in the Diagram.

- Data along the second vertical axis are re-scaled independently of the data along the first
vertical axis.

- If a graph displays more or less as a horizontal line (i.e. without much detail) after Zoom-
to-fit, its scale probably differs too much from the scale of one of the other quantities
along that axis. Assign the other vertical axis to this Data range and press Zoom to fit
again to zoom it independently from the other data along a vertical axis.

- If two graphs occupy only a small range along a vertical axis after Zoom-to-fit, there
scales probably differ too much. Assign one to the other vertical axis and press Zoom to
fit again to zoom both graphs independently.

- Also Background graphs are included in determining the zoom factor for the first vertical
axis.

To zoom out

• Click the Zoom-out button to return to the previous zoom state.
• When desired, repeat the procedure to zoom out further.
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The shortcut <Shift>+Zoom out immediately restores the Diagram to its original zoom
state.

2.4 Predict
With Predict you can draw a graph in a Diagram window. Most of the time this is used to
predict a graph of a measurement or model. After the run, the shape of the predicted graph
can be compared with the measured graph. A predicted graph is only a picture, i.e. it does
not consist of real data.

To predict a graph

• Right click the Diagram window or
press the Tool button.

• Select Predict.
• Draw a smooth curve by dragging to

the right. Erase by dragging to the
left.

Or:
• Click several points to 'draw' a point-

to-point graph (straight lines).
• Stop Predicting by pressing <Esc> or

by selecting Stop predicting from
the Diagram Tool menu.

- Switching on the grid may help to draw more accurately.
- Double click a point in the predicted graph to erase the part of the graph beyond this

point.

To erase prediction

• Right click the Diagram window or press the Tool button.
• Select Erase prediction. The whole prediction is erased from the Diagram.
• After you stop predicting and select Predict again an existing Prediction is erased.

2.5 Add a Comment
It is possible to place descriptive labels on a Diagram (e.g. who did which measurement and
when). These labels are displayed in the Diagram window and also appear when the
Diagram is printed or copied to the Clipboard. Comments can also be used e.g. to label
individual graphs in a Diagram (even with the same colour as the graph).

To add a Comment

• Right click the Diagram window or press the Tool button.
• Select Add a Comment to open the Add-comment dialog.
• Type the desired text.
• Select the text colour.
• Select/Deselect Framed to frame the Comment or not.

Figure 21. Drawing prediction in the Diagram
window.
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• Click OK to confirm or Cancel to
return to the original Diagram.

• Drag the Comment to the desired
position of the Diagram (make sure
the mouse cursor has the shape of a
hand).

• When desired, repeat this procedure
to create more Comments.

To edit or delete a Comment

• Right click a Comment (make sure
the mouse cursor has the shape of a
hand).

• Select Edit Comment or Delete
Comment.

2.6 Background graph
A Background graph is used to visually compare data on disk with data in an Activity (i.e. in
hypothesis testing in Modeling). Contrary to regular graphs, the data of a Background graph
is not available in the Activity: the graph is displayed as a picture in the Diagram only. It can
be shifted horizontally, however.
Importing graphs with data must be done in a Table.

To import a Background graph in a Diagram
A Background graph is created from data stored in a result on disk.
• Right click in the Diagram window or press the Tool button and select Import

Background Graph… or
• Press the Display-diagram button and press the Background-graph button. In this case a

Diagram is created which only contains a Background graph (i.e. a graph without data).
• Select a Result file from the list. The list shows all Results of the current Project. If you

need a Result which is stored in another location, press Browse.
• Click OK. Now the Import-Background-graph dialog opens.

The Import-Background-graph dialog
The Import-Background-graph dialog makes it possible to specify settings for the import
process. This dialog has three sections.
The Upper section gives information about the chosen Result file:

- The file name;
- The number of rows;
- The number of Data ranges (columns);
- For the selected Data range: the Quantity, Unit, Minimum and Maximum of the data in

that Data range.
• Use this section to inspect what data is available in the Result file.
In the Middle section the Data range from the Result which has to correspond to the
Quantity along the horizontal axis of the Diagram can be selected.

Figure 22. Comments in different colors are added to
measurement graphs.
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• Select a Data range.
• When desired enter a Label (Quantity

name).

In the Bottom section the Data range from
the Result which has to correspond to the
Quantity along the vertical axis of the
Diagram can be selected.
• Select a Data range.
• When desired, enter the Quantity and

Unit.
• Select whether the data should be

displayed along the left (first) or right
(second) vertical axis.

• Specify the style settings (Colour,
Marker, Line) for the Background
graph.

• Click OK.
Although this dialog box looks rather
complex, its use is most of the time very simple as you can rely on the default settings.

To shift the Background Graph
You can shift the Background graph to facilitate comparison with calculated or measured
graphs. This feature is used mostly in hypothesis testing in Modeling.
• Right click in the Diagram window or press the Tool button.
• Select Shift Background Graph.
• Drag the Graph to the left or the

right with the mouse or with the
arrow keys for pixel steps. Use
<Shift>-arrow-keys for large
steps.

• It is possible to zoom the Diagram
during the shifting process, by
pressing the <Shift>-key.

• Right click in the Diagram
window or press the Tool button.

• Select Stop shifting background
graph

To delete the Background Graph

• Right click in the Diagram window or press the Tool button.
• Select Delete Background Graph.
• Select Imported to delete the Background graph from the Diagram.

Note: Background graphs are included in determining the zoom factor after pressing Zoom-to-fit.

Figure 24. Shifting the background graph.

Figure 23. Import Background Graph Dialog.
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33..  TTaabbllee

3.1 Introduction
A Table is used to display data points
numerically in columns. Data points can
be originating a.o. from sensors, from
actuators, from the clock, from formulas
(calculations), from manual entry, from a
Control Program, from a Model
calculation and from a Video
measurement.
On starting a measurement with the Start
button, a Table is filled with values.
When doing a new run, the existing data
is overwritten by the new data. A Table
can maximally contain eight Columns
(Data ranges) and 16,380 rows with data.

Most options described below can be
reached via the Table Tool menu. Several options appear only when there are data points
available in the Activity.

To open the Table Tool menu

• Right click in the Table window or click the Tool button.

3.2 Rows
The option Rows in the Table Tool menu gives a submenu with various options applying to
Table rows. Not all options described here are available in all User modes.
With most of these options it is handy to select the desired rows in the Table prior to the
Rows operation.

Sort
This option rearranges all rows in a Table according to the sorted quantity in ascending or
descending order. Sorting is useful when the quantity along the x-axis of a Diagram is not a
continuously increasing or decreasing series of values. It is also useful in Manually-
triggered measurements.
• Right click in the Table window or press the Tool

button.
• Select: Rows > Sort (in some User modes: Sort).
• Type the number of the column (1  ..  8) which

contains the quantity to be sorted. The column in
which the cursor was located is pre-selected.

• Select the sort order: Ascending or Descending.
Notes:

- The sorting process of a column with a Formula can take some time to complete.

Figure 25. The measurement data in the Table window.

Figure 26. Sort rows window.
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- Other Diagrams/Tables which also use the quantity being sorted are rearranged accordingly.

Example
If Connection type in the Diagram style is set to Line, the points in the Diagram are
connected from point-to-point. When the values along the x-axis are not in increasing order,
this setting will result in a messy Diagram. (This may happen e.g. during Manually-triggered
measurements if the measurements are not taken in increasing order of the independent
quantity). Use the Sort option to remedy this problem.

As an example take the
function y = x².
In Diagram A, this function
has been drawn with its x-
coordinates in random order.
In Diagram B, this function
has been drawn after sorting
its x-coordinates in
ascending order.

Insert
This option inserts a number of empty Rows at the row in which the cursor is located.
You can pre-select the number of rows to be inserted by selecting several rows.
• Click the row at which to insert empty rows or make a selection of rows at the point to

insert empty rows.
• Right click in the Table window or press the Tool button.
• Select: Rows>Insert.
• The first and last row index are taken from the selection you made. When necessary

change the first or last row index.
• Click OK. The selected rows are shifted down and the specified number of rows is

inserted at the selection (point).

Delete
This option deletes a number of Rows at the row in which the cursor is located from the
Table. You can pre-select the number of rows to be deleted by selecting several rows.
• Click the row at which to delete rows or make a selection of rows.
• Right click in the Table window or press the Tool button.
• Select: Rows>Delete.
• The first and last row index are taken from the selection you made. When necessary

change the first or last row index.
• If desired, specify the Step value for the rows to delete. The Step value indicates the

number of rows which will be skipped during removal (see Example below)
• Mark either Delete rows (the selected rows are deleted), or Keep rows (the not-selected

rows are deleted).
• Click OK. The specified number of rows is deleted.
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Example:
- With Step = 1 and Delete Rows marked (the default settings), all selected rows will be

deleted.
- With Step = 1 and Keep Rows marked, all not-selected rows will be deleted.
- With Step = 2 and Delete Rows, all odd rows will be deleted from the selection.

With Keep Rows the even rows will be deleted.
- With Step = 3 and Delete Rows the first of each three rows in the selection will be

deleted.
With Keep Rows  the second and third of each three rows will be deleted. Etc.

- A selected number of Rows can also be deleted manually by pressing <Ctrl>+<Del>.
- Values from selected cells can be erased by pressing <Del>.

3.3 Edit Table cells

To edit a value in a single cell
Editing the value in a cell of a Table works the same as in any major spread-sheet package.
• Click a cell in the Table.
• Type a value. Press <Enter>, or press <Tab>, press one of the arrow keys or click in

another cell to confirm. The old value will be overwritten.
Or
• Double click a cell or press <Enter> to display the cell value with all its decimals and

change the value. Press <Enter>, or press <Tab>, press one of the arrow keys or click in
another cell to confirm. The old value will be overwritten.

• Undo the last change with <Esc> before confirming, and with <Ctrl>-Z after
confirming.

Values in the corresponding Diagram are automatically adapted.

To erase a value in a cell

• Click a cell in the Table, or make a selection of cells.
• Press <Del>. The contents of the cell(s) will be emptied.

To insert Rows in a Table

• Click the row at which to insert empty rows or make a selection of rows at the point to
insert empty rows. You can pre-select the number of rows to be inserted by selecting
several rows.

• Press <Ins>. Empty rows will be inserted in the Table.

To delete Rows from a Table

• Select the rows to be deleted from the Table.
• Press <Ctrl>+<Del>. The rows will be removed completely from the Table.
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To edit a selection of cells in a Table (Cut, Copy, Paste)
With the Text option in the Table Tool-menu standard Windows commands like 'Cut',
'Copy' and 'Paste' are available.
• Drag a selection in the Table, or use the arrow keys in combination with the <Shift>-

key. With <Ctrl+A> the whole Table can be selected.
• Right click in the Table window or press the Tool button.
• Select: Edit.

- Use Cut <Ctrl+X> to move the selection to the Clipboard (the cells remain empty).
- Use Copy <Ctrl+C> to copy the selection to the Clipboard (the cells remain as they

were).
- Use Paste <Ctrl+V> to paste values from the Clipboard to the Table (starting at the

selected cell or in the selection). The option is not available if the Clipboard does not
contain data.

- Use Undo <Ctrl+Z> to undo the last action.
These commands can be used also to transport data from/to other Window applications.

Notes:

- Use the Table option Export data to export only data to other file formats like text format
(ASCII) or spreadsheet format (DIF).

- Use the Table option Import data to import data from other file formats like IP-Coach 4 format,
text format (ASCII), or a spreadsheet format (DIF), or to add Coach (Junior) Results to existing
Results in Tables.

3.4 Import data
With the option Import data from the Table Tool menu, data from external files can be
imported into the current Activity or Result. There are four formats available:
- Coach (Junior),
- IP-Coach 4,
- Text and
- DIF.
Data can be imported in a New Table, or be added to an existing Table.
Note: The import dialogs described on this page look quite complex. That is because all their
possibilities are described. In most cases you can just rely on the Default settings, however.

To import data in a new Table

• Click the Display-Table button.
• Click Import Table.
• Select the file format to be imported.

- For Coach (Junior) data the Open Result dialog appears. Select a Result.
- For IP-Coach 4 data select a *.dt0 file. For these types proceed below under 'The

Import dialog'.
- For Text files and DIF files first a dialog appears in which parameters about the

structure of the file to be imported should be specified. The displayed information is
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adapted as much as possible from the structure of the selected file already. In most
cases only minor changes are required.

• See below for a description of importing the various file formats.
• Place the Table in a window.

To add data to an existing Table

• Right click in the Table window or press the Tool button.
• Select Import data.
• Select the file format to be imported.
• Specify the file name.

- For Coach (Junior) data the Open Result dialog appears. For IP-Coach 4 data select a
*.dt0 file. For these types proceed below under The Import dialog.

- For Text files and DIF files first a dialog appears in which parameters about the
structure of the file to be imported should be specified (proceed here for Text files
and here for DIF files). The displayed information is adapted as much as possible
from the structure of the selected file already. In most cases only minor changes are
required.

• See below for a description of importing the various file formats.

The 'Define Text-file structure' dialog for Text files
This dialog makes it possible to specify parameters for the import process for Text files. It
has three sections:

• In the Upper section 'File settings', specify the decimal separator, Text qualifier and
Thousands separator. Use None when the item does not apply.

• The Middle section 'Import range and meaning' gives the possibility to specify which
rows to omit (e.g. when the rows do not contain numbers) and how the first row(s) will
be interpreted. It is possible that the original file uses the first one or two rows as a
header containing e.g. the Quantity and Unit of the column. Check the options as
desired.

• In the Bottom section ('Column Delimiters) specify the column delimiter, i.e. the symbol
which separates the values of the various Data ranges in the file.

Figure 27. Define Text File Structure dialog.
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• Press OK to confirm your settings. The Import dialog opens. Proceed as described
below.

The 'Define DIF-file structure' dialog for DIF files
This dialog makes it possible to specify parameters for the import process for DIF files. The
displayed settings are adapted as much as possible from information in the selected file. It
has two sections:
• In the Upper

section 'File
settings', specify
the decimal
separator and
Thousands
separator. Use
None when the
item does not
apply.

• In the Middle section 'First rows interpretation' specify how the first row(s) will be
interpreted. It is possible that the original file uses the first one or two rows as a header
containing e.g. the Quantity and Unit of the column. Check the options as desired.

• Press OK to confirm your settings. The Import dialog opens. Proceed as described
below.

The Import dialog
This dialog makes it possible to
specify parameters of the import
process. The dialog has three sections.
The Upper section ('Original data')
gives information about the original
file:
- The file name;
- The number of rows;
- The number of columns;
- Click the column to display

information about: Quantity, Unit,
Minimum and Maximum.

• In the Middle section ('Import as'),
select the Table column (C1 .. C8)
where the column of the original
file (specified under 'Original
data') should be imported. By
default the first empty column is
selected.

• If you do not want to import a column, select (None).
• If necessary edit the suggested Quantity, Unit and number of decimals.

Figure 28. Define DIF Structure dialog.

Figure 29. Import Data dialog.
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• Repeat these steps for all columns of the original file.
• In the Bottom section ('Import range'), specify the Row indices (one setting for all

columns) to be imported.
• When necessary change the first and last Row index.
• If desired, specify the Step value for the rows to be imported. The Step value indicates

the number of rows which will be skipped during import.
• Mark either Import selected (the selected rows are imported), or Import complement

(the not-selected rows are imported).
• Click OK. The specified columns are imported with the specified number of rows.
Example:
- With Step = 1 and Import selected marked (the default settings), all selected rows will be

imported.
- With Step = 1 and Import complement marked, all not-selected rows will be imported.
- With Step = 2 and Import selected, all odd rows will be imported.

With Import complement the even rows will be imported.
- With Step = 3 and Import selected the first of each three rows in the selection will be

imported.
With Import complement the second and third of each three rows will be imported. Etc.

3.5 Export data
With the option Export data from the Table Tool menu, Coach data can be written in other
file formats. There are two export file formats available: Text and DIF. The Export option
always exports all values of the Table (independent of a selection). See Tip below.

To export to Text format

• Right click in the Table window or press the Tool button.
• Select Export data.
• Select Text file.

Now the 'Define-Text-file-structure' dialog opens.
This dialog makes it possible to specify parameters of the export process. It has three
sections:

Note: This dialog looks quite complex. That is because all its possibilities are described. In
most cases you can just rely on the Default settings, however.

Figure 30. Define Text File Structure window.
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In the Upper section ('File settings'), specify the decimal separator. Use this option to
specify another decimal separator then the default Windows separator (specified in the
Regional settings in Control Panel). In most cases the default value will do.

In the Middle section ('First rows interpretation') specify how the first row(s) will be
interpreted. It is possible to use the first one or two rows as a header containing the
Quantity and Unit of the column. Check the options as desired.

In the Bottom section ('Column Delimiters') specify the column delimiter, i.e. the
symbol which separates the values of the various Data ranges in the file. For ∗.TXT files
all kinds of delimiters can be chosen. Usually Tabs are used. For ∗.CSV (Comma-
Separated Values) files, the comma should be chosen.

Note: Do not select a comma as separator when the comma is also used as decimal
separator. The Result is a file which will not be interpreted correctly by the other program.
(If necessary check your decimal separator in the Regional settings in Windows' Control
Panel).

• Press OK to confirm your settings.
• Type a file name including the right extension (8.3 format!) and/or path in the final

Dialog.
Type a file name (maximally 8 characters!) and/or path in the final Dialog. The file
automatically gets the extension .CSV if Comma were chosen as delimiter. Otherwise it
gets the extension .TXT.

Note: Without path, the file will be saved by default in the current Project directory or in the last
location where a previous file was opened/saved.

To exporting to DIF format

• Right click in the Table window or press the Tool button.
• Select Export data.
• Select DIF file.
Now the 'Define-DIF-file-structure' dialog opens.
This dialog makes it possible to specify parameters of the export process. It has two
sections.

Note: This dialog looks quite complex. That is because all its possibilities are described. In
most cases you can just rely on the Default settings, however.

In the Upper section ('File settings'), specify the decimal separator. Use this option to specify
another decimal separator then the default Windows separator (specified in the Regional
settings in Control Panel). In most cases the default value will do.

Figure 31. Define DIF File structure dialog.
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In the Lower section ('First rows interpretation') specify how the first row(s) will be
interpreted. It is possible to use the first one or two rows as a header containing the Quantity
and Unit of the column. Check the options as desired.

• Press OK to confirm your settings.
• Type a file name (maximally 8 characters!) and/or path in the final Dialog. The file

automatically gets the extension .DIF. Without path, the project will be saved by default
in the current Project or in the last location where a previous file was opened/saved.

Often it is much simpler to export data via Copy and Paste. Use these commands also when
you want to export a selection of the Table:
- First make a selection, Copy it to the Clipboard and Paste it in another program (e.g.

Notepad, another Text editor, etc.). Save the file in that Program.
- A second way is to delete the non-selected rows from the Table and select Export data as

above.



GGUUIIDDEE  TTOO  CCOOAACCHH  --  5599

IIIIII..  MMEEAASSUURREEMMEENNTT

TTaabbllee  ooff  CCoonntteennttss

1. INTRODUCTION........................................................................................................................................... 60
2. INTERFACE PANEL...................................................................................................................................... 60

2.1 Sensor icons on the Interface Panel ................................................................................................... 60
2.2 Lost communication............................................................................................................................ 61
2.3 Alternative Panel ................................................................................................................................ 61
2.4 Switch Panel ....................................................................................................................................... 62

3. SENSORS .................................................................................................................................................... 63
3.1 Sensor Icons........................................................................................................................................ 63
3.2 Use an Analog sensor as a Counter (for CoachLab II only) .............................................................. 64
3.4 Modifying the Sensor Palette.............................................................................................................. 64
3.3 Sensor properties ................................................................................................................................ 65

3.3.1 Sensor properties: Sensor naming................................................................................................................. 66
3.3.2 Sensor properties: Scaling and Display ........................................................................................................ 67
3.3.3 Sensor properties: Signal type ...................................................................................................................... 68
3.3.4 Sensor Calibration ........................................................................................................................................ 69
3.3.5 Advanced Calibration ................................................................................................................................... 71

4. MEASURING ............................................................................................................................................... 75
4.1 Measuring methods in Coach ............................................................................................................. 75
4.2 Start/Stop a measurement ................................................................................................................... 77
4.3 Measurement settings ......................................................................................................................... 77

4.3.1 Timing/Counter settings ............................................................................................................................... 78
4.3.2 Trigger settings............................................................................................................................................. 79

4.4 More about Manually-triggered measurements ................................................................................. 81
4.4.1 Set up Coach for Manually-triggered measurements.................................................................................... 81
4.4.2 Set up Coach for Manually-triggered measurements with counters ............................................................. 81
4.4.3 Set up a Diagram/Table for Manually-triggered measurements with data-entry .......................................... 82
4.4.4 Executing manually-triggered measurements............................................................................................... 82

5. ACTIVITY TYPES FOR MEASUREMENT ........................................................................................................ 83



GGUUIIDDEE  TTOO  CCOOAACCHH  --  6600

11..  IInnttrroodduuccttiioonn
Measuring is one of the main functions of Coach. If an interface with a sensor is connected
to the computer, the Sensor icon on the Panel in Coach shows the actual values measured by
the sensor. These values can also be displayed on the screen in large digits (Value) or on a
Meter (if these elements are set ready). However, these sensor values are not yet stored.
Coach is standby for measuring.

Coach stores measuring data according to the Measurement settings. In most of Activities,
measurements are stored at regular time intervals (Time-based measurements) according to
the Sampling Frequency (Measurement Frequency) - the number of measurements per unit
of time.

It depends on the User mode if you are allowed to modify the Measurement settings. Often,
these settings are already prepared. You only have to start the measurement process.

Coach offers a number of different Measurement methods. Advanced users can modify the
measurement method in the Activity options.

22..  IInntteerrffaaccee  PPaanneell
The Interface Panel is located in the Panel Window, in the lower half of the screen. The
panel is the screen image of the interface panel that you are working with and has inputs for
sensors just like the connectors on the real interface. Depending on the mode of the Activity,
you can drag and drop a Sensor icon on input.

2.1 Sensor icons on the Interface Panel
The operations below cannot be performed in all User modes. Sometimes an icon is locked
then you cannot move it. If this is the case, the mouse cursor stays an arrow when moved
over the icon. If an icon can be moved, the mouse cursor becomes a 'hand' when moved over
the icon.

Figure 32. CoachLab II interface with connected Motion
Detector and Force sensor icons.
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To place a Sensor icon on the Panel
Drag the icon from the Sensor Palette to an input of the Panel. When the Sensor icon jumps
away, the sensor cannot be connected to the particular input of the Panel. Make sure your
real sensor is connected to the same input of the interface as its icon is on the Panel.

To replace a Sensor icon on the Panel
Drag an icon from the Sensor Palette to input with an icon. Coach will replace the existing
Sensor icon with the new one. Diagrams, Tables, Meters and Values are automatically
adapted.

To move a Sensor icon the Panel
Drag the Sensor icon on the Panel to another input. Diagrams, Tables, Meters and Values
are automatically adapted.
On CoachLab II, it is not possible to move a Counter icon from one input to another. To
place a Counter on another input, first place it back on the Palette (this happens
automatically when you try to move it), then place it on the new input.

To remove a Sensor icon from the Panel
Remove a Sensor icon by dragging it from the Panel. Coach automatically places the icon
neatly back in its Palette position.

2.2 Lost communication
When the communication with the interface is lost in an Activity, you have to reset the
Panel. How do you know whether the communication is lost?
The sensor values do not change at all for a longer period of time. (Normally, the sensor
values fluctuate a little bit because of noise, unless the number of decimals is set to low
values). Or nothing happens when you press the green Start button.

To reset the Panel

• Right click the Panel.
• If necessary reset the Interface (for CoachLab II, disconnect and reconnect the Power

supply).
• Select Reset Hardware.

- This option is only available if the Panel is active (Activate hardware = On).
- If you are outside an Activity/Result, Coach will show the message that the Panel can not

be found. If the Panel is connected properly to the computer (i.e. it did work before), then
probably the communication with the interface is lost. Reset the interface, and press
Retry.

2.3 Alternative Panel
For every Activity an interface is already chosen. By right clicking the screen panel another
so-called Alternative panel can be chosen.

To select an alternative Panel
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• Right click the Panel.
• Select Alternative panel. If this option is not available, Alternative Panels have not

been set by the developer of this Activity.
• Select a Panel from the list. The connected Sensor icons and Actuator icons will be

connected automatically to the equivalent position on the new Panel provided they can
be used with this Panel.

- The list of Alternative Panels is
limited to the installed Panels.

- When the Panel is not found on
starting an Activity, the button
Select Panel opens the list with
alternative Panels.

- It may be that the new Panel
does not support all sensors or
actuators, which are predefined
in the Activity. Coach will
announce this and upon
confirmation will remove not
supported Sensor icons and/or
Actuator icons.

2.4 Switch Panel
In an Activity it is possible to switch Panels.
• Select the Menu option: Options > Switch Panel…
• Select another Panel from the list. The connected Sensor icons and Actuator icons will

be connected automatically to the equivalent position on the new Panel provided they are
supported by the new Panel.

Coach automatically selects which Sensors and Actuator icons are suited for the current
Panel. A message may appear that certain selected Sensor or Actuator icons will be removed
from the Activity.

- Switching Panels may have serious implications for the existing results. So it is
recommended to save your results.

- To remove the Panel (switch the Panel to No Panel) is useful only when you want to
change the Activity type to Modeling or Data Video.

- By default, the Panel list only shows those Panels for which the drivers have been
installed. To show all Panels supported by Coach, mark Show all Panels.

- Unmark the option Activate Hardware, if you want to prepare a Result for a Panel,
which is not connected to the computer. Then Coach does not bother you with messages
that the Panel could not be found. Instead, it places a 'dead' picture of the Panel, which can
be used to prepare the Result. As soon as the Result is opened on a computer which has
the Interface connected (and if the option Activate Hardware is marked again) it will
work normally.

Figure 33. Selecting an Alternative panel.
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33..  SSeennssoorrss

 3.1 Sensor Icons
A Sensor icon is a small picture representing a sensor. A Sensor icons are
available only in one location: on the Sensor Palette (at the left side of the
Panel) or on Panel inputs or in the Sensor Library (or Project directory).

There are two Sensor icons, which do not correspond to a real sensor:
Voltmeter icons and Counter icons.

Voltmeter icons
For measuring voltages, there are special Voltmeter icons in the Library. These icons do not
correspond to any real sensor, but they display the voltage (uncalibrated signal) of any
connected sensor to the input instead.

In case of an experiment yielding voltages between 0 and 5 V or between - 10 and 10, a
Voltmeter icon of the corresponding range (see the Tool tip of the icon) can be used to
monitor these voltages.
When using the CMA Adapter 0519, it is only possible to measure voltages between 0 and
5 V.

3.2 Counter Icons
For counting purposes, there is a special Counter icon in the Library.
This icon does not correspond to some real sensor, but it counts the signal from
any connected sensor to the input. In order to count a signal, the sensor should
generate pulses.
The counter counts pulses incrementally, so the number of pulses in each
individual interval can be obtained by means of a Delta formula.
The result can be converted to a frequency by means of the Formula: 1/n.

A Counter can be reset to zero with a little '0'-button on its icon.

Counter threshold (only for CoachLab II )
A counter counts pulses. With CoachLab II it is possible to define what Coach will regard as
a pulse:
- A Threshold value: the value the signal has to pass to be counted; and
- A Direction (should the threshold be passed Upwards (increasing signal values) or

Downwards (decreasing signal values).

To set Threshold settings for a Counter

• Right click a Counter icon on the Panel.
• Select Set Threshold.
• Enter the Threshold value and the direction (Up/Down)

which the signal should pass to be counted as a pulse.
The total range of the sensor is also displayed.

• Click OK to confirm or Cancel to cancel.

Figure 34. Sensor
Palette with Sensor
icons.

Figure 35. A
Counter icon.

Figure 36. Set Counter Threshold
dialog.
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3.2 Use an Analog sensor as a Counter (for CoachLab II only)
With CoachLab II it is possible to use an analog sensor as a counter. Sometimes it is useful
to count the signal from an analog sensor as pulses (e.g. to measure how often the screen is
refreshed (use a light sensor as counter) or to measure the rate with which your heartbeats
(use a heartbeat sensor as a counter), etc.). In order to count a signal, the sensor should
generate pulses (an oscillating signal). The counter input is evaluated at 10kHz (i.e. it is not
possible to measure higher frequencies than 10kHz with a counter).

To use an Analog Sensor as a Counter

• Right click a sensor icon on the Panel.
• Mark Use as a Counter.
• A dialog pops up which consists of two parts: Threshold

(top section) and Counter definition (bottom section)
- Enter the Threshold value in calibrated units and the

direction (Up/Down) which the signal should pass to be
counted as a pulse. The total range of the sensor is also
displayed.

- Under Counter definition enter the properties for this
counter: for Max the maximum number of expected
pulses (defines the vertical axis in a Diagram), the
Quantity and the Unit.

• Click OK to confirm or Cancel to cancel.
You can only define one counter at a time. If you want to
define another sensor as counter, first reset the first one to
analog sensor.

To modify Threshold settings for a Counter

• Right click the icon of an analog sensor used as counter.
• Select Set Threshold.
• Modify settings.
• Click OK to confirm or Cancel to cancel.

To stop using an Analog Sensor as a Counter

• Right click the analog-sensor-defined-as-counter.
• Unmark the option Use as a counter.

3.4 Modifying the Sensor Palette
A Sensor icon is available only in one location: it is either located in the Library (or Project
directory), on the Sensor Palette or on a Panel output.

To add a Sensor icon to the Sensor Palette (from the Library or the Project)

• Right click an empty location in the Sensor Palette.
• Select Add from disk (change between Library directory or Current Project

directory if necessary (and if possible)).

Figure 37. Set Threshold for
Analog Sensor dialog.
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• Choose a sensor from the list.
• If necessary change the Number of icons.
• Click OK.

To increase the number of icons of the same sensor
It is possible to add icons of already placed sensors on the Sensor Palette afterwards.
• Right click a Sensor icon on the Sensor Palette.
• Select Add.
• Type the number and click OK (Coach indicates the maximum possible number).

To create a Sensor icon

• Right click an empty location on the Sensor Palette.
• Select Create new.
• Enter the Sensor properties (see next section).

To remove a Sensor icon from the Sensor Palette
It is possible to reduce the number of icons of a sensor, or to remove all icons of a sensor.
• Right click a Sensor icon.
• Select Delete one to delete a single icon, or Delete all to delete all icons of this type.

Also the icons placed on the Panel will be removed, including existing data.

To replace a Sensor icon by an Alternative sensor

• Right click a Sensor icon.
• Select Alternative sensor.
• A list opens. Select the desired alternative sensor. Coach will replace the sensor by the

alternative and automatically adapt Diagrams and Tables.

3.3 Sensor properties
The Sensor-properties
dialog displays all
information regarding a
Sensor icon in Coach.
This dialog does not
always show all its
sections. It depends on the
User mode.

To open the Sensor
properties dialog

• Right click a Sensor
icon and select Edit
properties.

or
• Right click an empty

Figure 38. Sensor properties dialog window.
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position in the Sensor Palette and select Create new.

The Sensor-properties dialog consists of four sections:

1. Sensor naming (top section)
2. Signal type (left-middle section)
3. Scaling and Display (right-middle section)
4. Calibration (bottom section)

3.3.1 Sensor properties: Sensor naming
The name information of a Sensor icon is displayed in the 'Tool tip'. The Tool tip displays:
Sensor name, Article number, Brand and the Sensor icon's measurement range. The article
number is listed for CMA sensors only and cannot be modified by the user.

The information in the Sensor-icon's Tool-tip uniquely determines which real sensor should
be used.
Example: Temperature sensor (016&bt) (CMA) (-18..110°C)

It depends on the User mode which fields are available to the user. Items for Senior students
are marked 'Advanced'.

Name
The full name of the sensor. If you want to create a self-defined sensor with a new name,
select Name = Self-defined sensor. Enter a new name in the name field, which now
appears.

Short name
When the sensor is on the Sensor Palette then the short name of the sensor is displayed on
the icon. When a Sensor icon is placed on the Panel, the (current) signal value is displayed
on the icon, while the sensor's short name marks its (empty) position in the Palette.

Icon
The picture which is used on the Sensor icon. The setting of the icon also determines to
which family the sensor belongs: sensors with the same icon are each others alternative
sensor.

Brand (Advanced)
The brand of a sensor like 'CMA', 'Vernier' or 'Self-made' is displayed in a sensor Tool tip. It
is meant for information for the user only. The list of sensors can be sorted alphabetically on
sensor Name or on sensor Brand.

Figure 39. The Sensor naming section.
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Kind (Advanced)
There are four different 'kinds' to be selected. For the majority of sensors the default setting
'General' applies.

General: almost all sensors belong to this category.
Yellow: for yellow LEGO DACTA sensors only.
Blue: for blue LEGO DACTA sensors only.
Sonar: for ultrasonic sensors.

Note: The field Kind is only available if the Sensor properties are accessed when all Sensor icons
of this type are in the Sensor Palette (and none on the Panel).

3.3.2 Sensor properties: Scaling and Display
A Sensor icon's scale settings are used when the sensor's signal is displayed in a Diagram.
Enter:

- Min the minimum sensor value
- Max the maximum sensor value
- Quantity the quantity which the sensor measures
- Unit the unit of the sensor's quantity
- Decimals the number of decimals.
The number of decimals is used for the sensor value in an icon, a window, a Diagram and
a Table.
Besides this decimals setting, a Diagram and Table have their own decimals setting which
overrules the setting in the Sensor properties for the Diagram or Table.

Advanced Scaling and Display options
Modify these settings only when you want to create your own Sensor icons. Otherwise,
leave them at their default values.

Display
Each Sensor icon has its own Meter to display its signal. With the option Display you can
select the basic display of the Meter. It is possible to draw a picture around this display (to
make it more fancy). Most Sensor icons in the Library have already such a decorated Meter.
• For Display, select a suited basic display shape.

Figure 40. Scaling and display section.
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• Click the Edit button to modify an existing appearance. This starts a Drawing program
which is associated with the ∗.BMP file extension. In this program you can edit the
picture around the chosen Display.

• When you are ready use the program's Save command to save the picture. Do not
change the extension of the file! The Display picture will be saved in the current Project.

As long as the Drawing program is open, Coach is completely inactive.

Input range
The Input range setting is necessary to specify how the sensor and the Panel work together.
The Input range can be set only for analog sensors which use an Interface-input which
supports multiple Voltage ranges.
When you select a range, which the interface does not support, the range will be
automatically set to the nearest useful range. (See also the technical manual of the Interface
used).
In most cases leave the default setting unchanged (i.e. Input  range  =  Ignore).

For CoachLab  II & CBL
The Input range setting applies only to BT inputs of the Interface. Sensors with a BT
connector have two different signal pins: One for the range 0..5V and one for –10..10V. It
depends on the sensor to which pin the Interface should 'look'. If a sensor does not give off a
correct signal in Coach with the default setting of Input range, set the range to - 10..10V.
For the 4mm-inputs it does not matter which setting is chosen.
For CoachLab  II, the Input range -1..1V will be automatically changed to –10..10V, the
Input range 0..1V will be changed to  0..5V.

For UIB
Channels 3 & 4 of the UIB-board can be set to different Voltage ranges with a jumper on the
board. (See also the Hardware settings). If a non-default Voltage range is chosen is may be
necessary to modify the Input range setting for some sensors used specifically on inputs 3
& 4.

3.3.3. Sensor properties: Signal type
Each sensor should be set to a suitable Signal type. Coach supports four different types. It
depends on the Interface which signal types can be chosen.
The Signal-type setting is only available (active) if the Sensor properties were accessed via
an icon on the Sensor Palette (make sure that there is also no icon
of the on the Panel).

Analog
The majority of sensors are of this type. It is used for sensors
which measure analog (i.e. continuously varying) quantities.

Up-counter
An Up-counter sensor counts pulses. Up-counters are not able to
detect a direction: all pulses are added to each other (e.g. for the
Smart pulley: independent of the direction of rotation). This

Figure 41. The Signal
type section.



GGUUIIDDEE  TTOO  CCOOAACCHH  --  6699

signal type is used e.g. for counting (GM sensor; Smart pulley) or for Event-based
measurements.
What is considered as a pulse depends on the setting of the Threshold.

Up/Down-counter
An Up-Down-counter sensor counts pulses. Up/down-counters do detect a direction.
Depending on the direction, pulses are added or subtracted. This type of sensor is very rare
and is supported only by CoachLab II. What is considered as a pulse depends on the setting
of the Threshold.

Digital
This sensor type is also very rare and only supported by the Control box. The sensor's signal
consists of a few discrete states depending on the selected number of bits (Bits = 1: 2 states;
Bits = 2: 4 states, etc.)
• Under Bits, select the number of bits.
• Select the state.
• Press the Edit button to enter the text for the state.
• Repeat the above two steps to assign a text to all states.
• Example for a push button: State = 1, Text = HIGH

State = 0, Text = LOW
Note: If no text is assigned to the states of a digital sensor, Coach displays the bit number of the
state.

3.3.4 Sensor Calibration
A calibration gives the relation between the Voltage values produced by a sensor (or the
values of a counter) and the values of the measured quantity. With this relation, Coach is
able to display the measurement data in the right quantity and unit.
You can choose from three types of calibration: no calibration, simple linear calibration and
advanced calibration.

Calibration = None
 The sensor's Voltage signal is displayed (uncalibrated).
• Right click a Sensor icon and select Edit properties.
• Select in the lower part of the Sensor properties dialog None.

Figure 42. The Calibration section.
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Calibration = Linear
A Linear calibration is determined by two calibration points (X0, Y0) and (X1, Y1). It is
used to calibrate sensors which signal varies linearly with the measured quantity, or to
calibrate counters.
X0 is the voltage (or counter value) corresponding to the quantity value Y0.
X1 is the voltage (or counter value) corresponding to the quantity value Y1.
• Right click a Sensor icon and select Edit properties.
• Select in the lower part of the Sensor properties dialog Linear.
• Enter the coordinates of two calibration points.

- When calibrating the sensor on the Panel, a digital Voltmeter appears on the right side of
the Sensor properties dialog. This Voltmeter displays the actual sensor Voltage or actual
Counter value. This is very useful information during the calibration process.

- The calibration becomes more accurate when the calibration points are farther apart from
each other.

Calibration = Advanced
In the Advanced calibration screen you can modify and create advanced calibrations (e.g. for
non-linear sensors). The Advanced calibration screen shows a table with the calibration
points, and a calibration graph. This calibration is described in details in the following
section.
• Right click a Sensor icon and select Edit properties.
• Select in the lower part of the Sensor properties dialog Advanced.
• Click the Calibration button.
• The Advanced Calibration screen opens. (See 3.3.5 Advanced calibration)

Shift the calibration
If the value of the calibrated sensor is systematically too high or too low, you can shift the
calibration line through a third calibration point. The option Shift the calibration works
both for Linear and Advanced calibrations.
• Right click a Sensor icon and select Edit properties.
• Select in the lower part of the Sensor properties dialog Shift the calibration.
• Enter the coordinates of the third calibration point. (X, Y). The slope of the calibration

line stays the same.
If the range of the sensor changes quite a bit, it may be necessary to adapt its minimum and
maximum values.
An advanced calibration can also be shifted through one additional calibration point (e.g. to
perform a single-point calibration). The shape of the calibration curve stays the same.

The option Shift the calibration can be used e.g. to
• reset the equilibrium force of a mass on a spring connected to a Force sensor to zero.

Then forces with respect to the equilibrium position can be measured.
• set the reading of a temperature sensor to zero at Room temperature. Then temperature

differences can be measured.
• calibrate a temperature sensor at room temperature more accurately: use a thermometer

to read the room temperature and shift the sensor's calibration to this value.
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• change the calibration of a position sensor from 0..240° to –120..120° (more useful for a
pendulum).

3.3.5 Advanced Calibration
In the Advanced calibration screen you can modify and create advanced calibrations (e.g. for
non-linear sensors). The screen shows a table with the calibration points, and a calibration
graph. There are three calibration methods available, or an IP-Coach  4 calibration can be
imported.

To open the Advanced-calibration screen

• Right click a Sensor icon and select Edit properties.
• Select Advanced in the lower part of the Sensor properties dialog.
• Click the button Calibration.

Calibration steps
1. Select the calibration method: Measurement, Manual or Function.
2. Under Range, enter the X-range (if available) and the Y-range.
3. When desired select the options Periodic and/or Cut on Y.
4. Select the desired Function-fit type: Point-to-point; Linear; Quadratic; Spline; Bezier.
5. Perform the calibration: Execute the calibration measurements; or Enter the values; or

Enter the coefficients of the calibration function;
or
6. Import an IP-Coach 4 calibration
7. When desired delete a calibration (see below).
8. When desired click Test to show the actual voltage (counter value) and the value of the

quantity.
9. Click OK to close the Advanced calibration window and start using your calibration.

Figure 43. The Advanced Calibration window.
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To delete a calibration point (row)

• Select a row in the Calibration table.
• Click Delete row.
• Click Yes to confirm that you want to delete the marked calibration point. The

calibration point is removed from the table.

To delete all Calibration points (all rows)

• Click Delete all.
• Click Yes to confirm that you want to delete all calibration points.
• To switch off a calibration at all, select Calibration=None in the Sensor-properties

dialog.

To import an IP-Coach 4 calibration

• Click Import.
• Browse to the IP-Coach 4 calibration file (extension: *.CAL).
• Click OK. The imported calibration information appears in the Advanced calibration

screen.

Advanced Calibration: Measurement Method
The following calibration methods are available in Coach:

q Calibration by Measurement
During a calibration by measurement the actual sensor voltage value is measured and the
value of the corresponding quantity is typed. This is the only method for very accurate
calibration of a specific sensor.
Only available if the icon of the sensor to be calibrated is on the Panel!).

To perform the calibration by measurement
Make sure an experimental setup is available to do measurements. And have instruments
available to determine the right value of the Quantity (e.g. a thermometer, melting ice and
boiling water, etc.).
• In the Advanced calibration screen: Select Method = Measurement.
• To add calibration point click Add row. The actual sensor Voltage is displayed in the

Voltage field. If necessary wait for the Voltage to stabilize.
• Click the Value field (at which moment the Voltage is fixed) and type the corresponding

quantity value.
• Click OK to add the calibration point to the table and the diagram.
• Repeat the above three steps until sufficient calibration points have been obtained.

q Calibration by Manual
During a calibration by manual input both the voltage value and the corresponding quantity
value of each calibration point are typed in by the user. This method is e.g. useful for
entering calibrations from tables in books.
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To perform the calibration by manual

• In the Advanced calibration screen: Select Method = Manual.
• To add calibration point click Add row.
• Type a Voltage value in the Voltage field and the corresponding quantity value in the

Value field.
• Click OK to add the calibration point to the table and the diagram.
• Repeat the above three steps until sufficient calibration points have been obtained.

q Calibration by Function
In a calibration via a function (linear or quadratic), the required calibration function
coefficients are typed in. This method is e.g. useful to enter standard calibrations from the
sensor's technical specification.

To perform the calibration by function

• In the Advanced calibration screen: Select Method = Function.
• Click the button Coefficients.
• Type the coefficients in the fields.
• Click OK to confirm.
• The calibration curve appears in the diagram.
It is always possible to modify the coefficients later by again clicking the button
Coefficients.

Advanced calibration: Ranges

X - range
Along the X-axis of the calibration diagram, the sensor voltage (or the counter value) is
displayed. Xmin and Xmax determine the interval on the X-axis. In a calibration by
Measurement or a Manual calibration, Coach automatically determines Xmin and Xmax (the
values cannot be changed).
In a calibration by Function you should enter the values Xmin and Xmax yourself.

Note: The values can be changed during the calibration process.

Y - range
Along the Y-axis of the calibration diagram is the quantity that is being calibrated. Ymin
and Ymax determine the interval on the Y-axis.
The values Ymin and Ymax are copied from the 'Scaling and Display'-section of the Sensor
properties. Changing these values in the Calibration window only leads to an adaptation of
the Y-axis range in the Calibration diagram: the Min and Max values in the Sensor-
properties window are not changed.

Note: The options Cut on Y and Periodical make use of the data Ymin and Ymax.
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Periodic
Select the option Periodic to
repeat the calibrated interval
along the whole X-range.
Note: For the majority of
calibrations the option Periodic
will not be selected.

Cut on Y
When the option Cut on Y is
selected the calibration curve
will not be extrapolated
beyond Ymin and Ymax.
Instead all Y-values below
Ymin and above Ymax are
kept constant at Ymin and
Ymax respectively.

Note: For the majority of
calibrations the option Cut
on Y will not be selected.

Advanced calibration: Function-fit

Point-to-point
The calibration points are connected by lines. The
first line is extrapolated towards Xmin and the last
line is extrapolated towards Xmax.
dot   = calibration points
cross = calculated value

Linear
A linear best fit (straight line) through the calibration
points is calculated by the Least-squares method.
This calibration line will be extrapolated to cover the
whole X-range.

Notes:

- In case two calibration points are entered, the
result of an Advanced Linear calibration is the
same as a linear two-point calibration directly
entered in the Sensor properties dialog. A linear
two-point calibration is also shown in the calibration diagram.

- By entering more points, a more accurate calibration line results.

- To obtain make the calibration as accurate as possible when only few calibration points are
used, select the points near the limits of the quantity range (i.e. select points which are as
far apart as possible).

Figure 44. Periodic - Off.          Periodic - On.

Figure 45. Cut on Y- Off. Cut on Y - On.
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Quadratic
A quadratic best fit (parabola) through the calibration
points is calculated by the Least-squares method.
This calibration parabola will be extrapolated to cover
the whole X-range.

Note: This setting is rarely used.

Function-fit Spline
A smooth curve forced through all calibration points
is calculated using a polynomial approximation. The
resulting curve may have a 'bumpy' character. This
calibration curve will be extrapolated to cover the
whole X-range.

Note: This setting is used often for non-linear
calibrations, to obtain a smooth calibration curve. If the
curve is too bumpy, try to correct the calibration point
which causes the bump.

Bezier
A smooth curve is calculated through the first and the
last calibration points. The values in between only affect
the curvature. The curve will not exactly follow the
calibration points and therefore will have a less 'bumpy'
character than the Spline curve. This calibration curve
will be extrapolated to cover the whole X-range.

Note: This setting is less often used than a Spline
function-fit.

44..  MMeeaassuurriinngg

4.1. Measuring methods in Coach

In Coach different Measurement methods can be used. Here follows a short overview of the
possible methods.

Time-based measurement
In this mode, measurements are taken at regular time intervals: The time is the independent
variable, the measured quantities are the dependent variables. The measurements lie from
each other at regular distances in time.
Time-based measurements can be done On-line (with the Interface connected to the
computer during the measurement) and Off-line (a Data-logger, not necessarily connected to
the computer, is used to store the measurement data).
Most measurements (approx. 90%) are of this type.
Examples of time based measurements:
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• Sample 100 values during 10 seconds (i.e. a sample frequency of 10 Hz) from a
temperature sensor.

• Sample 1 hour with a sample frequency of 100 Hz.
• Sample 0.2 seconds with a sample frequency of 40,000Hz.

Manually-triggered measurement
With this term, various measurement methods are indicated in which a single measurement
is taken every time you click a button.
- In 'Manually-triggered measurements with data-entry', you have to type the value of one

or more quantities.
- When a Counter is used, pulses can be counted during a certain time interval after a button

press.
More detailed information about manually triggered measurements you can find in section
'4.4 More about Manually triggered measurement'.

Event-based measurement
This is a measurement method where measurements are taken each time a pulse (event) is
received on a Counter input. Event-based measurements are used to measure the time at
which an event takes place, or to measure another quantity, which depends on the event.
The pulse is the independent variable, the time and other measured quantities are the
dependent variables. Often a light gate is used to generate pulses, but also other sensors can
be used.
- It is possible to change the pulse settings (i.e. to specify the conditions when is a signal

considered to be a pulse).
- For a description how to do automatic counts during a number of equal time intervals,

click here.
Note: For Event-based measurements an interface with a counter input is required.

Examples of event-based measurements
• Titration: the falling droplets generate pulses, the pH or temperature is measured (light

gate);
• Smart pulley: the spokes of the wheel generate pulses, the distance and/or time is

measured (light gate);
• Measurements of radioactive decay. The decay events generate pulses, the time is

measured (GM sensor);
• Measure when a rabbit visits its manger. The rabbit (which must walk through a light

gate to reach its manger) generates pulses, the time is measured (light gate);
• Physiology. Measure the heart rate per minute. The heart beat generates pulses, the time

is measured (heart-beat sensor);
• Stroboscopic light. The light flashes generate pulses, the time is measured (light sensor).
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4.2 Start/Stop a measurement

There are two situations, depending on the Activity options of the Activity:

1) On-line measurement
The Activity Toolbar shows the green Start button.
For On-line measurements, an interface has to be connected to the computer during the
measurement and data are stored directly in the computer.
• Click the Start button (or press <F9>) to start the measurement process. Now three

things can happen:
1) In most cases, Coach automatically stores the measurement data from the connected

sensors according to the specified Measurement settings. Diagrams and Tables are
filled with data.

2) If Trigger conditions were specified, Coach displays a message that it will start to
store data as soon as the Trigger conditions are met.

3) The 'Take measurement button' appears in the Toolbar. You have to take
measurements manually using this button.

• If you want to interrupt the measurements process, click the Stop button (or press
<Esc>).

- Once a measurement is finished, you can replay it.
- The combination <Shift>  +  Start button (<Shift>+<F9>) erases the current

measurement run and starts a new one.

2) Off-line measurements
The Activity Toolbar shows two buttons: a Send button and a Receive button instead of the
green Start button.
For Off-line measurements, a Data-logger is not connected to the computer during the
measurement. The data are stored in the Data-logger and have to be transferred to Coach
afterwards.
• Click the Send button to send the Measurement settings to the Data-logger.
• Now you can disconnect the Data-logger from the computer and perform your

measurement. When the measurement is finished reconnect the Data-logger to the
computer.

• Click the Receive button to retrieve data from the Data logger. Remember to keep the
same Measurement settings as send before.

For more detailed instruction about Off-line measurements, click here.

- Once a measurement is finished, you can replay it.
- The combination <Shift> + Receive button erases the current measurement data and

loads new data from the Data Logger.

4.3 Measurement settings
In the Measurement-settings dialog you can specify how Coach will measure. This dialog
does not always show all its sections. It depends on the Activity type and the User mode.
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To open the Measurement settings dialog

• Click the Measurement settings button to open the Measurement-settings dialog.

4.3.1 Timing/Counter settings

Measurement time (appears for all measurements)
The measurement time specifies the duration of the measurement.
• Type in the desired measurement time.
• Select a unit of time from the drop-down list.

- In some measurement methods, this setting is used only to specify the range of the time
axis in Diagrams.

- A change of duration is not accomplished by changing the time axis in the Diagram
settings.

- A change of Measuring time erases all graphs and resets the zoom state of Diagrams. So
first save your Result if you want to keep it.

Frequency (appears for time-based-measurement)
The measurement Frequency specifies how often a measurement is done per unit of time
(regular time intervals), or whether measurements are taken manually (at the moment of
pressing a button by the user). It is often pre-defined and can be changed only in Advanced
User modes.
For Time-based measurements
(the majority of cases):
• Enter a value for Frequency.
• Select a time unit from the

drop-down list.
For Manually - triggered
measurements:
• Select Manual or Manual

with counters from the drop-
down list.

Number of samples
(appears for manually-triggered
time-based measurements and
event based measurements)
• Type in the desired number of

measurements, which has to be
stored.

Sample duration
(appears for manually-triggered
time-based measurements with counters)
• Select Manual Start/Stop.

Figure 46. The Timing/Counter section for Time-based
measurements.

Figure 47. The Timing/Counter section for Event-based
measurements.
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• Select a time unit from the drop-down list and type in the time interval during which
pulses are counted.

Pulse source (appears for event-based measurements)
• Select the input to which a counter is connected from the drop-down list.

First Pulse at t=0 (appears for event-based measurements)
• Select this option if you want that the first pulse in Event-based measurements to

correspond with a time value of zero. Otherwise, the first pulse will be stored with the
time lapsed since the Start button was pressed.

4.3.2 Trigger settings
With the Trigger settings you can specify a signal condition from which the computer can
decide when to start a measurement. This is amongst other things useful when using very
short measurement duration or for objective comparison of different measurement runs.
There are two Trigger settings, which completely determine the state of the signal on the
Trigger channel:
1. The level of the signal (Trigger level).
2. The direction at which the signal passes the Trigger level: Up (increasing signal values)

or Down (decreasing signal values)
The Trigger conditions are indicated by a solid arrow displayed on the Diagram axis of the
Trigger channel.

The Pre-trigger time is an additional Trigger setting. The history of the signal prior to the
trigger moment is continuously stored and, as soon as the signal meets the Trigger
conditions, it is displayed with negative time values.

To define Trigger settings
In the Measurement-settings dialog:
• Select a direction of the trigger signal: Up or Down.
• Specify the Trigger channel (the input to which the sensor is connected which provides

the trigger signal).
• Type the Trigger level in the calibrated units of the sensor on the Trigger channel.
• If desired type in a value for the Pre-trigger time. The maximum possible Pre-trigger

time is equal to the Measurement time (in which case only history is displayed).

Figure 48. The Trigger settings section. When the Temperature signal measured
on the Analog input 1 will increase and reach the value 200C then the
measurement will be started. Coach will also displays the temperature signal up
to 1 minute (pre-trigger time) before the start of the measurement.
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• Select None to switch off triggering.
After starting the measurement with the green Start button Coach will show a message that it
is waiting for the Trigger conditions. As soon as this is the case, the data will be stored and
will be displayed (if e.g. a Diagram is on the screen).

- When using a Data-logger with short measurement times (< 1 s) it is strongly
recommended to use Trigger settings. Otherwise the Data-logger reduces its
measurement frequency by half to monitor whether its Start button is pressed.

- In some Activity types (like Event-based measurements), Trigger settings have no
meaning and will not be available.

- For the CBL, CBL 2 and CBR Data loggers in on-line measurement mode, the Trigger
settings are not available.

Use of trigger settings
Use trigger settings for instance for the following measurement types:
- The phenomenon you wish to measure lasts very short (in the order of the human reaction

time (~200 ms)).
- You wish to measure someone's reaction time. Then the computer should start measuring

unbiased at for instance at a sound or light signal.
- Comparing different runs of an experiment and keeping the start conditions the same. E.g.

when measuring the motion of a pendulum with different masses: via trigger settings all
runs will start at the same point of the pendulums motion thus making comparing the
influence of the mass on the pendulum's motion more easy. Or cooling down hot water,
without and with isolation. To compare the runs genuinely, they should start at the same
temperature.

- When you want to start a measurement under specific conditions (e.g. when it becomes
dark) and you are not able to be near the computer at that moment.

Use of the Pre-trigger time
- Some signals can not be triggered at their zero level. For instance it is useless to trigger a

sound at a sound level of zero, as every sound will trigger the measurement, or a
Voltmeter at zero as the noise will trigger the measurement. In these cases use a higher
trigger level. However, if you are interested in the behaviour of the signal from its zero
level (which lies in the past of the trigger moment), you can make it visible via the Pre-
trigger-time option.

- The falling magnet experiment also makes use of the Pre-trigger time. The generated
voltage curve depends on which pole of the magnet falls first through the coil. The Pre-
trigger time reduces the chance of a half visible graph (so you do not have to remember
which pole of the magnet has to fall first). The total measuring time should be about twice
the falling time of the magnet through the coil.
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4.4 More about Manually-triggered measurements

4.4.1 Set up Coach for Manually-triggered measurements
Use the procedure below to set up Coach for Manually-triggered measurements (i.e. without
counters):
• Click the Measurement-settings button.
• Set Frequency to Manual. The measurement Frequency is available only when the

Activity type is set to 'Time-based measurements'.

Coach will prompt to type the Quantity value(s) for all Data ranges with a Manual-input
Connection each time the Take-measurement button is pressed (see Manually-triggered
measurements with data-entry).

Examples of manually triggered measurements with data-entry
Most of the time manually triggered measurements are combined with data-entry.
- Boyle's law experiment: Measure the pressure in a gas syringe and type the corresponding

volume.
- Measuring a cooling process with an ordinary thermometer. The time is recorded by the

computer, the temperature is typed in. If the thermometer is replaced by a Temperature
sensor, the experiment will be a pure Manually-triggered measurement (i.e. without data-
entry).

- Acid-Base titrations: The pH is measured, the volume is typed in.
- Determining concentration with a colorimeter: the light absorption is measured, the

concentration of the sample is typed in.
- Filling a Table or Diagram with data for display or analysis in Coach (pure data-entry).

4.4.2 Set up Coach for Manually-triggered measurements with counters
Use the procedure below to set up Coach for Manually-triggered measurements with
counters.
• Click the Measurement-settings button.
• Set Frequency to Manual with counters. The measurement Frequency is available only

when the Activity type is set to 'Time-based measurements'.
• Type the desired Number of samples.
• Select a Unit in the drop-down list and type a Sample duration. On a press on the Take

measurement button, Coach counts during the specified time interval.
When the interval counting should be stopped manually as well, select Manual
Start/Stop in the Unit drop-down list behind Sample duration. Then Coach keeps
counting until the User ends the counting interval by a press on the button Stop interval
counting.

Coach will prompt to type the Quantity value(s) for all Data ranges with a Manual-input
Connection each time the Take-measurement button is pressed (see Manually-triggered
measurements with data-entry).
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Examples of manually triggered measurements with counters:
- Investigating the relation between radiation level and distance from the radiation source:

measuring the number of counts with a GM-sensor during a fixed time interval for
different distances to the radiation source.

- Measuring the mean background radiation by measuring several series of counts during a
fixed time interval.

- Measuring half-life time.

4.4.3 Set up a Diagram/Table for Manually-triggered measurements with data-entry
A 'Manual-input' Data range should be prepared in a Table or Diagram for all quantities for
which Coach should prompt the user to type a value.
• Right click in the Diagram window or Table window, or press the Tool button.
• Select Create/Edit.
• Select a Data range: C1 .. C8.
• Set the Connection of this Data range to Manual input.
• Enter the Quantity and the Unit.
• If desired, repeat the procedure to define more Manual-input Data ranges.

4.4.4 Executing manually-triggered measurements

• Press the Start button to start the measurement process.
• Press the Take-measurement button (or <F8>) to take a single measurement.

Now several things can happen:

1) Manually-triggered measurements
A single measurement is done by the computer for all connected sensors. At
least one sensor must be connected to the Interface.
Note:
- Sensor values are stored at the moment this button is pressed.
- Often this method is combined with data-entry, see point 3) below.

2) Manually-triggered measurements with Counters
Coach starts counting pulses during a certain time interval. The end of this
time interval can be automatically determined by the computer, or manually
by a click on the button Stop interval counting. Follow the instructions on the
screen.
In this case, a Counter must be connected to the Interface (only possible with
CoachLab II and UIB).

3) Manually-triggered measurements with data entry
Coach asks to type the values of one or more quantities.
In this case a sensor or Counter may be connected to the interface to combine
data entry with measured values.

• If Coach asks for input, type the value(s).
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• If Coach asks for several values, press <Tab> to confirm each value.
• Click OK to confirm your entry.

• Continue pressing the button until the specified number of samples is reached
or
• Press the Stop button to stop the measurement process.

55..  AAccttiivviittyy  ttyyppeess  ffoorr  MMeeaassuurreemmeenntt

To open the Activity option window

• Click the Options menu.
• Select the Activity options…

q On-line Time-based measurement (without a Program)
This is the usual setting for measuring. It is used for Measurements taken at regular time
intervals according to the Measurement settings. The interface should be connected directly
to the computer. This setting can also be used for a number of Data loggers: CBL, CBL 2,
CBR and EcoLog, which have to be connected to the computer during the measurement
process. The green Start button is available to start a measurement run.
• Select Time-based measurement.
• Deselect With a Program.
• Deselect Off-line.

q Off-line Time-based measurement (without a Program)
This setting prepares for time-based measurement with a Data logger, used to store the
measurements. The Data logger is not necessarily connected to the computer during the
measurement process. The green Start button is replaced by the Send settings button and the
Get result button.
• Select Time-based measurement.
• Deselect With a Program.
• Select Off-line.
If the current Panel is not able to do Off-line measurements, then the option Off-line is not
available.

q Time-based measurement with a Program (On-line)
Use this setting for Measurement and Control (!) Activities in which only signals from
sensors and/or actuators have to be stored in Diagrams or Tables while a Program is used to
control e.g. the Control model (Program variables can not be displayed in Diagrams/Tables
with this setting). The duration of the Control process is determined by the Program, while
the sensor and actuator signals are evaluated according to the Measurement Frequency. The
advantage of this is, that the signals are evaluated independent of the Program speed. In this
way the behavior of the Control systems can be monitored easily during Program execution.
The green Start button is available to start a measurement run and Program execution.
• Select Time-based measurement.
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• Select With a Program.

Example: A Temperature control system, of which the temperature is displayed in a
Diagram.
Notes:

- If the Frequency in the Measurement settings is set to Manual or Manual with Counters, then
"With a program" can not be selected.

- If the setting Time-based measurement is not available, probably a Program variable is used
in a Diagram or Table. First remove all connections which refer to Program variables.

- If Program variables should be available for display in Diagrams or Tables, use Control with a
Program (see below). In that case, the Control Program will also determine the rate at which
the measurements are being taken.

q Event-based measurement (without a Program)
This setting is used for measurements triggered by a pulse on a counter input. The Quantity
which generates the pulses is the independent variable, the time and other measured signals
are stored as dependent variables. The green Start button is available to start a measurement
run.
• Select Event-based measurement.
• Deselect With a Program.
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11..  IInnttrroodduuccttiioonn
The control environment of Coach is a programming environment which is mostly used to
create Programs to control systems, like for example an automated temperature control
(thermostat) or a robot-arm.
The kernel of a Control system is a Control Model with sensors (e.g. temperature sensor)
and actuators (e.g. motor, fan, and heating element) which are connected to the Inputs
respectively Outputs of the Interface. Through the Interface, Coach gets information from
connected sensors (the temperature) and controls the connected actuators.
Actuators can be controlled manually (often the first stage in developing an automated
Control system), or automatically via a (Control) Program.

A Program is a sequence of instructions in Coach Language. With a Program:
- Coach can perform control tasks automatically (such a Program is often called a Control

Program). A Control Program is often based on sensor values: e.g. if the temperature is
too high, switch on the fan; if the temperature is too low, switch off the fan and switch on
the heating element, etc.

- Coach can control measurements or manipulate measurement data: e.g. convert Voltage
signals from a sound sensor to deciBels (something which cannot be done via a
calibration).

A (Control) Program can be developed in various ways (also depending on the User mode):
• With Instruction buttons;
• By selecting Commands from a Command list. This can be a pre-defined Command list

(made specifically for a certain Control model), called a Micro-world, or via the full
Command list.
In more advanced User modes, the Command list can be extended with Own Commands
made by yourself.

• By freely typing Commands from Coach Language in the Program Editor area.

22..  IInntteerrffaaccee  PPaanneell
Some of Interfaces (CoachLab,
CoachLab II, LabPro + Digital
Control Unit, LEGO DACTA
Interfaces) can be used in
Control system. They have
outputs to connect actuators
(like motors, lamps, and
buzzers). An Interface Screen
Panel in Coach has outputs for
actuators just like the
connectors on the real interface.
Depending on the mode of the
Activity you can drag and drop
an Actuator icon on an output.  

Figure 49. The CoachLab II panel with a motor connected
to the output A and a lamp connected to the output B.
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2.1 Actuator icons on the Interface Panel
The operations below cannot be performed in all User modes. Sometimes an icon is locked
then you cannot move it. If this is the case, the mouse cursor stays an arrow when moved
over the icon. If an icon can be moved, the mouse cursor becomes a 'hand' when moved over
the icon.

To place an Actuator icon to the Panel
Drag the icon from the Actuator Palette to an output of the Panel. When the Actuator icon
jumps away, the actuator cannot be connected to the particular output of the Panel. Make
sure your real sensor is connected to the same input of the interface as its icon is on the
Panel.

To replace an Actuator icon on the Panel
Drag an icon from the Actuator Palette to an output with an icon. Coach will replace the
existing Actuator icon with the new one. Diagrams, Tables and Values are automatically
adapted.

To move an Actuator icon on the Panel
Drag the Actuator icon to another output. Diagrams, Tables and Values are automatically
adapted.

To remove an Actuator icon from the Panel
Remove an Actuator icon by dragging it from the Panel. Coach automatically places the icon
neatly back in its Palette position.

2.2 Lost communication, Alternative panel, Switch panel
These topics are described in details in the section 'III. Measurement'.

33..  AAccttuuaattoorrss

3.1 Actuator icons
Actuator icon is a small picture representing an actuator.
An Actuator icon is available only in one location: it is located on the
Actuator Palette, or on a Panel output, or in the Library (or Project
directory).

3.2 Manual control of actuators
With Manual control you can switch an actuator ON or OFF via the
Panel.
This feature works only for outputs which have an Actuator icon placed on them.

Figure 50. The
Actuator  Palette with
Actuator icons.
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Click the LED next to any output to toggle between ON or OFF.
If you drag the mouse away from the LED while switching the output
ON, the output remains ON until you click it again.

The LED indicates the state of the output: e.g. ON or OFF (see note
below)

Note:

- In case of a 2-bit actuator (with 4 states) on an Interface which supports 2-bit actuators (e.g.
CoachLab II), the output LEDs indicate up to four states of the output by means of different
colours (e.g. Off, Green, Orange, Red).

- Even when there is no Actuator icon placed on the Panel, you can switch outputs ON and OFF
in the way described above.

Warning: On older version of software if an output of CoachLab II without Actuator icon
is switched ON, the output always has the maximum voltage (12 V). This voltage may be
too high for several actuators (like bulbs). Connecting an actuator to an output which is
switched may result in a damaged actuator.

3.3 Power control of actuators
This feature is only supported by the CoachLab  II interface.
With the Power slider on an Actuator icon, the user can specify the output power of the
interface for the connected actuator (e.g. to adjust the speed of a motor or the brightness of a
bulb).

Click an arrow at the right side of the Actuator icon.

The height of the red bar indicates the level of the output.

Note:

If an output of CoachLab  II (older types) without Actuator icon is switched ON, this output always
has the maximum voltage (12 V) which may be too high for several actuators (like bulbs) and result
in damage. In the newer type (from 2001), the outputs can not be switched on without a connected
Actuator icon.

3.4 Modifying the Actuator Palette
An Actuator icon is available only in one location: it is either located in the Library (or
Project directory), on the Actuator Palette or on a Panel output.

To add an Actuator icon to the Actuator Palette

• Right click an empty location in the Actuator Palette.
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• Select Add from disk (change between the Library directory or Current Project
directory if necessary (and if possible)).

• Choose an actuator from the list.
• If necessary change the Number of icons.
• Click OK.

To increase the number of icons of the same actuator
It is possible to add more icons of actuators already placed on the Actuator Palette
afterwards.
• Right click an Actuator icon on the Actuator Palette.
• Select Add.
• Type the number and click OK (Coach indicates the maxixum possible number).

To create an Actuator icon

• Right click an empty location on the Actuator Palette.
• Select Create new.
• Enter the Actuator properties (see next section).
Note: Also the icons placed on the Panel will be removed, including existing data.

To remove an Actuator icon from the Actuator Palette
It is possible to reduce the number of icons of an actuator, or to remove all icons of an
actuator.
• Right click an Actuator icon.
• Select Delete one to delete a single icon, or Delete all to delete all icons of this type.

To replace an Actuator icon by an Alternative actuator

• Right click an Actuator icon.
• Select Alternative actuator.
• A list opens. Select the desired alternative actuator. Coach will automatically replace the

actuator by the alternative.

3.5 Actuator properties
The Actuator properties window displays all information regarding an Actuator icon in
Coach.

To open the Actuator properties window

• Right click an Actuator icon and select Edit properties,
or
• Right click an empty position in the Actuator Palette and select Create new.

The Actuator properties window consists of three sections:
1. Actuator naming (top section)
2. Signal type (bottom-left section)
3. Display (bottom-right section)
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3.5.1 Actuator properties: Naming
The actuator's name information is displayed in the 'Tool tip'. The Tool tip displays:
Actuator name, Actuator Brand and the number of bits the actuator uses (i.e. a measure for
the number of different states the actuator can have).
The information in the Actuator-icon's Tool-tip uniquely determines which real actuator
should be used.
Example: Motor (Generic) (1)

It depends on the User mode which fields are available to the user. Items for Senior students
are marked 'Advanced'.

Name
The full name of the actuator.
If you want to create a self-defined actuator with a new name, select Name = Self-defined
actuator. Enter a new name in the name field which now appears.

Figure 51. Actuator Properties dialog window.

Figure 52. The Naming section.
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Short name
When the actuator is on the Actuator Palette then the short name of the actuator is displayed
on the icon. When an Actuator icon is placed on the Panel, the specified text is displayed on
the icon, while the actuator's short name marks its (empty) position in the Palette.

Icon
The picture which is used on the Actuator icon. The setting of the icon also determines to
which family the actuator belongs: actuators with the same icon are each others alternative
actuator.

Brand (Advanced)
The brand of an actuator like 'CMA', 'Generic' or 'Self-made' is displayed in an actuator Tool
tip. It is meant for information for the user only. The list of actuators can be sorted
alphabetically on actuator Name or on actuator Brand.

Kind (Advanced)
There are four different 'kinds' to be selected. For the majority of actuators the default
setting 'General' applies.

General: almost all actuators belong to this category.
Black: for black LEGO DACTA actuators only.
Special 1: reserved for future actuator types.
Special 2: reserved for future actuator types.

Note: The field Kind is only available if the Actuator properties are accessed when all Actuator
icons of this type are in the Actuator Palette (and none on the Panel).

3.5.2 Actuator properties: Signal type
To change the actuator's Signal type, all Actuator icons of this type should be located on the
Actuator Palette.

Digital
A digital actuator has discrete states.
The actuator's signal consists of a few discrete states depending on the
selected number of bits (Bits = 1: 2 states; Bits = 2: 4 states, etc.).
• Select the number of bits that is required to express all possible

states.
• If desired, edit the Text which appears in the Actuator icon for each

state.
• If desired, enable the power slider on the Actuator icon (only for

CoachLab II)

Step motors
A step motor rotates a given number of steps in a given direction. It
can be set to a certain position very accurately (as the number of steps corresponding to one
turn is very high). Select the type that corresponds to your step motor:
− 2 bits (states) - The outputs control the step motor in the following order: 01  11  10

Figure 53. The Signal
type section.
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− 2 bits (dir step) - One output controls the direction of rotation, the other the number of
steps.

− 4 bits - The outputs control the step motor in the following order: 0011  0010  0110  0100
1100  1000  1001

− 4 bits (fast) The outputs control the step motor in the following order: 0001  0010  0100
1000

Note: The number of bits of the actuator and the number of bits of the output (which differs per
Interface) determine how many outputs the Actuator icon occupies. However, you do not have to
worry about this as Coach does not allow to connect more Actuator icons than possible.

3.5.3 Actuator properties: Display

Edit the Text on the Actuator icon
For each state the Actuator displays a text on its
icon. This text can be edited.
• Select the state.
• Press the Edit button to enter the text for the

state.
Example for a motor (2 bit):
State = 0, Text = OFF
State = 1, Text = LEFT
State = 2, Text = RIGHT
State = 3, Text = OFF (not used)

Enable a Power slider on an Actuator icon
The use of a Power slider is only supported by CoachLab II. See also the CoachLab II
manual about how Output power control is implemented.
• Mark the option Power slider to display a Power slider on the Actuator icon.
• Select for Range the Voltage range which corresponds to the real actuator.

Example for a 3V bulb: Power slider = ON; Range = 0..3V
Note: A Power slider has to be enabled for actuators which have a maximum Voltage lower
than the 12V output voltage of CoachLab II (e.g. a 3V bulb). Otherwise the actuator may be
damaged.

Note: The outputs of CoachLab II do not have any power when no Actuator icon is connected to
them.

Figure 54. The Display section.
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44..  CCrreeaattiinngg  pprrooggrraammss

4.1 Program window
The Program window is the place where you can create Programs. The Program window can
consist of up to three areas:
- The Instruction button area, where buttons are located. By clicking these buttons you can

perform certain actions.
- the Program Editor, where the Program lines appear.
- the Command list area from where you can select commands for the Program.

Note:

In most cases only one or two areas of the Program window are available, depending on the
choices of the developer of the Activity.

4.2 Manual Control
With Manual control students can turn outputs (connected actuators) 'On' and 'Off' via the
Panel on the screen. While designing a program, this mode offers a convenient way to check
the effects of certain operations.
• Click the LED next to any output to toggle between ON or OFF. If you drag the mouse

away from the LED while switching it ON, the output remains ON until you click it
again.

• The LED indicates the state of the output: e.g. ON or OFF. In case of an 2-bit actuator
(with 4 states) on an interface which support 2-bit actuators (e.g. CoachLab II), the

Instruction Editor area  Menu area
Button area Command list

Figure 55. The Programming window.
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output LEDs indicate up to four states of the output by means of different colours (e.g.
Off, Green, Orange, Red).

Warning: In older version of Coach: if an output of CoachLab II without Actuator icon is
switched ON, this output always has the maximum voltage (12 V) which may be too high
for several actuators (like bulbs) and result in damage.

4.3 Programming via Instruction buttons

Note: The Program Window at least shows the Instruction button area. Instruction buttons are
buttons with pre-defined actions. By controlling the Control Model with these buttons, Coach
keeps track of your actions by translating them into Program lines. This Program can be visible
on the screen in the Program editor area (but it does not have to). By executing the Program,
Coach can repeat your actions again.

An Instruction button performs a certain action. This action is explained
in a Tool tip, which appears when you point the mouse cursor over the
button (without moving it). Often also the picture on the button gives an
idea about its action.

Use the buttons to control the Control Model:
• Some buttons require a simple mouse click, like 'Stop'.

• Other buttons (like 'Turn-left') must be pressed for a while, because
the computer needs to measure also how long the button was
pressed.

• When you are ready, click the green Start button and the computer will repeat your
recorded actions.

• If you are not satisfied with the result, you can erase it (even when the Program itself is
not visible).

4.4 Programming via the Command list
The Command list helps you to write correct Programs. It is
displayed at the right side of the Program window.
The Command list contains a series of useful Commands. Sometimes
it contains only a few pre-defined Commands which are developed
specifically for your Control model (this is called a Micro World).

To create a Program via the Command list

• If necessary, click the P-button to open the Programming
window.

• Click a Command from the Command list at the right side.
• If a new list appears the Command is not yet finished: Select an

additional Command (e.g. an output). Repeat this step until the
Command is finished. Click -BACK-, or press <Esc> in the
Command list if you want to return to the previous stage

Figure 56. The
instruction buttons.

Figure 57. The limited
Command list.
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(without making a selection). Some lists may be used to enter several items (e.g. several
outputs). These lists have a Command Ready. Click Ready when you are finished
selecting from this list.

• If an Entry box appears the Command needs a value: Type the value (e.g. a number of
seconds) and press <Enter>. If you want to return to the previous stage, first press
<Esc>, and then click -BACK-, or press <Esc> again.

• The Command is placed in the Program. Coach indents the Command automatically
according to general Program conventions. If the indentation is lost due to Program
editing, click a Program line, and press <Tab> or <Shift>+<Tab> to restore the right
indentation.

- If you get a message that a command cannot be inserted because the line is not blank,
click in the Program where you want to insert the Command and press <Ins>. Then
proceed programming via the Command list as described above.

- If an action does not seem to work, make sure the pane of the Program window is made
active. This can be done by clicking in it.

4.5 Advanced Programming
Experienced students can program freely by choosing Commands
from the complete Command list of Coach Language or by typing
Commands directly in the Program Editor area.
In the last case, Coach does not guide you to write Commands
correctly (syntax of Coach-Language Commands), until the Program
is executed. Then Coach will show an error message and place the
cursor at the point where the error is.

4.6 Creating Own Commands
Users can create Own Commands and add a reference to them to the
Command list. These Commands are created from the Command list
(including other Own Commands). References to Own Commands
appear in blue in the Command list.

To open the Own-Commands list

• Right click in the Programming window or click the Tool button.
• Select Own Commands.

To create an Own Command
1) To create an Own Command and insert a reference to it at a

specific position in the Command list:
• Right click the Command in the Command list after which the

Own Command should appear.
• Select Insert (after).

Figure 58. The Coach
Language commands.
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• In the 'Add new Main-menu item' dialog box,
Select New Command.

• Type the name of the Command.
Or
2) To create an Own Command and insert a reference to

it at the end of the Command list:
• Open the Own Command list (see above).
• Click New Command.
• Enter a name and click OK. It is not allowed to

use <space> or Reserved words in Coach
Language.

The Own-Command Editor opens. It has a grey
background to indicate that you are creating/editing an
Own Command. The Commands appear in red.

• Create your Own Command by selecting commands from the list.
• When you are ready, right click in the Program editor area of the Programming

window, or click the Tool button.
• Select Back to Main Program to return to the Programming window. The reference

to the Own Command appears in blue.

To edit an Own Command
1) Short route:

• Right click the Own Command in the Command list.
• Select Edit Own Command.

Or
2) Editing via the Own-Command list:

• Open the Own-Command list (see above).
• Select a Command from the list.
• Click Edit.
• Modify the Commands. Use the same procedure as editing a Program.
• When you are ready, right click in the Program editor area of the Programming

window, or click the Tool button.
• Select Back to Main Program to return to the Programming window.

To delete an Own Command

• Right click the Own Command in the Command list.
• Select Delete Own Command.

Note: It is not possible to delete an Own Command while it is used in the Main Program. First clear
the lines in where the Own Command appears (by selecting the line and pressing <Del>) or erase
the Main Program.

To rename an Own Command
1) Short route:

• Right click the Own Command in the Command list.

Figure 59. Own Commands window.
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• Select Rename Own Command.
• Type the new name. It is not allowed to use <space> or Reserved words in Coach

Language.
• Press OK.

Or
2) Editing via the Own-Command list:

• Open the Own-Command list (see above).
• Select a Command from the list.
• Click Edit.

To print an Own Command

• Open the Own-Command list (see above).
• Select the Command.
• Click Edit.
• Again right click the Programming window, or click the Tool button.
• Select Print Own Command.

To insert a reference to an Own Command in the Command list
1) Existing command:

• Right click the Command list.
• Select Insert (after).
• Select Command exists already.
• Select an Own Command from the drop-down list.

2) New command:
• Right click the Command list.
• Select Insert (after).
• Select New command.
• Enter the name.
• Create your Own Command by selecting commands from the list.
• When you are ready, right click in the Program editor area of the Programming

window, or click the Tool button.
• Select Back to Main Program to return to the Programming window.

Note: A reference to an Own Command can appear more than once in the Command list.

To delete a reference to an Own Command from the Command list

• <Ctrl>+Click the Own Command in the Command list.
• Press <Del>.

Notes:

- Only the reference to the Own Command is deleted from the Command list. The Own
Command itself still exists.

- It is only possible to remove references to Own Commands from the Command list.
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To move an Own Command reference in the Command list

• Open the Own-Command list (see above).
• Right click an Own Command.
• Select Cut.
• Right click the Command after which you want to appear the Own Command.
• Select Paste.

To copy an Own Command reference in the Command list

• Open the Own-Command list (see above).
• Right click an Own Command.
• Select Copy.
• Right click the Command after which you want to appear the Own Command.
• Select Paste (after).

Note: A reference to an Own Command can appear more than once in the Command list.

4.7 Edit a Program
In some User modes, editing a Program can be done only by whole lines. In the advanced
User mode, it is also possible to type in the Program Editor.

To insert an empty line
• Click the line above which you need an empty line.
• Press <Ins>. An empty line will be inserted. You can select a new Command.

To replace a line

• Click the line.
• Press <Enter>.
• The Command on the line is removed. Select a new Command.
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To delete a selection

• Make a selection (in some User modes whole lines only).
• Press <Del>.

To move a selection of Program lines

• Make a selection (in some User modes whole lines only).
• Right click the selection and select Text edit>Cut (or press <Ctrl-X>).
• Right click the line above which you want to paste the cut lines.
• Select Text edit>Paste (or press <Ctrl-V>).

To copy a selection of Program lines

• Make a selection (in some User modes whole lines only).
• Right click the selection and select Text edit>Copy (or press <Ctrl-C>).
• Right click the line above which you want to paste the copied lines.
• Select Text edit>Paste (or press <Ctrl-V>).

To copy the whole Program to the Clipboard

• Right click in the Programming window, or click the Tool button.
• Select Clipboard copy.
• Use the Paste command in another Windows application (E.g. Word Processor) to paste

the text of the Control Program.

To erase the whole Program

• Right click in the Programming window, or click the Tool button.
• Select Erase main program.

Notes:

- Press <Tab> or <Shift>+<Tab> to restore the right indentation of the Program Commands.

- With <Ctrl-Z> (or Text edit>Undo) you can Undo (and Redo) the last change.

- With <Ctrl-A> you select the whole Program.

4.8 Management of Control Programs
In general, Control Programs are saved together with all other Activity settings in the Coach
Result. It is also possible, however, to open only the Control Program from another Coach
(Junior) Result in the Activity or Result you are working in.
It is possible to Import an IP-Coach 4 Program or Export as IP-Coach 4 Program.

To open only a Control Program from another Coach (Junior) Result

• Right click in the Program-editor area of the Programming window or click the Tool
button and select: Load Program from Result.

or
• Click File>Load Program from Result.
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• Select a Result and click OK.

Note:  The current Program and its Command list are overwritten by the new one. So save your
work before opening a Result in this way, or your work is lost.

To print a Program

• When necessary, click the Program button to open the Programming window.
• Right click in the Program-editor area of the Programming window, or click the Tool

button.
• Select Print main program.

To import an IP-Coach 4 Program (not in all User modes)

• Click File>Import a Coach 4 Program
• Select a Coach 4 Program (∗.ASC) and click OK.

Notes:

- The current Program and its Command list are overwritten by the new one. So save your work
before opening a Result in this way, or your work is lost.

- The other windows remain unchanged, including the sensors/actuators and their settings.

To export as an IP-Coach 4 Program (not in all User modes)

• Click File>Export a Coach 4 Program.
• Type a name and click OK.

55..  PPrrooggrraamm  EExxeeccuuttiioonn
When a Program exists, you can execute it. That means that the computer will carry out all
instructions in the Program. This can be done in two modes: with the Monitor (Slow) or
without the Monitor (Fast). Whether the Monitor will start is specified with the Monitor-
option or in the Tool menu of the Program window or in the Options-menu.

Execute a Program via the Monitor (default)

• Click the Start button to start
Program execution. By
default, the Monitor windows
opens. The Monitor window
is a special window in which
the execution of Programs
can be followed line-by-line.

• Adjust the speed of the
Monitor with the slider (this
can be done also during
execution).

• Execute a single line of the
Program with the 1-button in

Figure 60. Executing a program in the Monitor window.
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the Monitor bar.
• Click the green Start button in the Monitor bar to start line-by-line Program execution.
• Click the red Stop button in the Monitor bar or keep <Esc> pressed to interrupt Program

execution.

Fast Program execution
The Program is executed in the background. This happens a lot faster than execution in the
Monitor.
• Make sure the Monitor-option is turned Off. (You can find this option in the Tool menu

of the Program window or in the Options-menu).
• Click the Start button to start Program execution.
• Click the Stop button or keep <Esc> pressed to interrupt Program execution.

66..  PPrrooggrraammmmiinngg  tthhee  LLEEGGOO  DDAACCTTAA  RRCCXX

The LEGO DACTA RCX can be used in two ways:

On-line: The RCX functions just like any other interface for control. You can manually
control actuators via the RCX Panel in Coach, read values of sensors in Coach, execute
control Programs in Coach.

Off-line: In this mode, Programs are downloaded to the RCX. After downloading, the RCX
can be used independently of the computer.

To download Programs to the RCX

• Create a Program in a Coach Activity for the RCX.
• Click the Send-Settings button to download the Program into the RCX and the

measurement settings (for time-based off-line measurements with program).
• During the downloading process the RCX displays animated dots. When the

Transmission is finished, the RCX plays a little melody.
• Now the RCX is ready to be taken to another place to execute the Program.

To re-establishing the connection between the RCX and Coach

• Place the RCX in front of the IR Transmitter. The RCX will go automatically when it is
'in sight' of the tower.

• Click the Get-result button to upload the measurement result.

In general, the on-line mode is used to create and test your Program. After the Program is
perfected, you can use the RCX in off-line mode.
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77..  AAccttiivviittyy  ttyyppeess  ffoorr  CCoonnttrrooll

To open the Activity option window

• Click the Options menu.
• Select the Activity options…

qq Control, without a Program
This setting should be used for Activities in which actuators are controlled manually.
Neither the P-Button nor the Start button is available in this Activity type.
• Select Control.
• Deselect With a Program.

qq  Control, with a Program
This setting should be used when the Control Program has to determine the way
measurements are being taken and when a Program is used to do calculations on measured
signals. All Program variables appear in the Data-range Connection automatically and can
be chosen in Diagrams and Tables. However, the values are stored in memory (and appear in
the Diagrams/Tables) only when the standard Procedure SaveData is used in the Program.
The disadvantage of this setting is that the sensitivity to signal changes depends strongly on
the execution speed of the Program.
• Select Control.
• Select With a Program.
Note: If a high sensitivity to signal changes is required, use Time-based measurements with a
Program. In that case, Program variables are not available for display in Diagrams or Tables.

qq Time-based measurement with a Program (On-line)
Use this setting for Control for activities in which only sensor and actuator signals have to
be stored in Diagrams or Tables!
The Program determines the duration of the Control process, while the sensor and actuator
signals are evaluated according to the Measurement Frequency. The advantage of this is that
the signals are evaluated independent of the Program speed. In this way the behavior of the
Control systems can be monitored easily during Program execution.
• Select Time-based measurement.
• Select With a Program.

Example: A Temperature control system, of which the temperature is displayed in a
Diagram.

Notes:

- If the Frequency in the Measurement settings is set to Manual or Manual with Counters, then
"With a program" can not be selected.

- If the setting Time-based measurement is not available, probably a Program variable is used in
a Diagram or Table. First remove all connections which refer to Program variables.

- If Program variables should be available for display in Diagrams or Tables, use Control with a
Program (see above). In that case, the Control Program determines the rate at which the
measurements are being taken.
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11..  IInnttrroodduuccttiioonn
In a Data-Video Activity position and time data can be collected from digital videoclips
(format: AVI, MOV or MPG) or a sequence of pictures (format: BMP, GIF or JPG). (A
sequence of pictures is also referred to with the term 'videoclip').

From the number of frames per second with which the videoclip is recorded (or the time
between the successive pictures from the sequence), time information is deduced, while
position information can be measured on the two dimensions of the video image (picture),
after calibration.

With Data Video it is possible to 'measure' phenomena which can not be measured in a
regular experiment, like the motion of high divers, bungee jumps, soccer kicks, basketball
shots, amusement-park rides, plant growth, jump on the Moon, car crashes, etc.

Data (position-time) is collected by clicking in successive (selected) frames on (a point of) a
moving object (e.g. a ball, a hand). The Video Points measured this way can even serve to
calculate the locations of other points, e.g. the Center of Mass.
The video data can be displayed in a Diagram or Table and be used for further processing
and analysis.

Data Video Window
The Data-Video window is always the upper-left window in a Data-Video Activity.
It is a special window which contains:
• the videoclip (or sequence of pictures),
• the controls for playing the video and for measuring points in the videoclip (Play buttons

and Frame controller),
• the Tool button for the Data-Video Tool menu.

There is only one Data-Video window per Activity. The Data-Video window can be
maximized for more accurate measurements or better display to an audience.
Apart from the Data-Video window, up to three Information windows are available (e.g.
with Texts, Diagrams, regular Video, etc.).

To open the Data Video Tool menu

• Right click in the Data-Video window or click the Tool button.

A few remarks about creating digital videoclips…
A digital videoclip is a file which consists of digitized video information.
Digital videoclips for use in Data Video can be found on the Coach CD-rom, the Internet or
you can make your own clips.
If you want to record your own videoclips, you need a (analog) video camera (camcorder)
and a video-capture card to shoot movies or you can capture clips from popular movies or
other sources (e.g. video tapes). Some of the newest types of digital (photo or video)
cameras allow direct recording of digital videos in AVI, MOV or MPG format. In this case
you do not need a video-capture card for the digitizing process.
Via special software (often included with the camera) you can:
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- edit digital videoclips;
- select a special scene from the clip;
- convert one video format into another
- store the video using another CODEC (a CODEC is a compression algorithm for video

files).

22..  CCoonnttrroolllliinngg  aa  vviiddeeoo
The Video Control bar is located at the bottom of the Data-Video window.

This bar consists of the Control buttons and the Frame controller. The Frame controller,
which looks like a railroad of which the ties (small vertical bars) are the video frames, by
default shows all frames. Selected frames are black and non-selected frames gray. Every
frame has a number, which is shown, at the right side of the Frame controller. The
magnifying glass serves to zoom in the frames in the Frame controller in case the videoclip
has many frames (the ‘ties’ are lying side-by-side and form on single broad bar).

To control a videoclip, use the following buttons:

Start to play a videoclip

Stop to play a videoclip

Go to the first frame of a videoclip

Go to the next frame of a videoclip

Go to the previous frame of a videoclip

The Slider button on the Frame controller indicates actual selected frame

Zoom button to zoom in/out a part of the Frame controller

You can jump to an arbitrary position in the videoclip by clicking a frame on the Frame
controller or by dragging the slider button. The selected video frame appears on the screen
and the Frame number is shown at the right side of the Frame controller.

33..  SSiimmppllee  VViiddeeoo  MMeeaassuurreemmeenntt
With Data Video you can collect position and time data from a videoclip or a picture
sequence. This process is also referred to as ‘doing a Video measurement’. The data is
collected by clicking on the location of (a point of) a moving object which motion you will
measure on the successive video frames.
In this chapter is assumed that videoclip is already opened in Coach and prepared
(calibrated) for the video measurement. If this is not the case read first chapter
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'6. Opening a new video or sequence of pictures' and chapter '7. Preparation for Video
Measurement'.

3.1 Do a Video measurement

• Start the measurement by clicking the Start button. Coach will automatically bring the
first selected video frame on the screen.

• Move the cursor over the video image (the cursor changes its shape to a viewfinder) to
locate the Video Point, for example a ball or the head of a runner.

• Click to store the first Video point. Now three things can happen, depending on the
settings of the Activity:
1. If the videoclip advances to the next frame, click the next point of the object. (In this

case you only measure the position of one object per frame).
2. If the first Video Point was set up to be the origin of the measurements for this

frame, then a coordinate system appears with its origin at the clicked point. Next
click the Video point(s) to determine the position(s) of another object(s).

3. If nothing happens you have to click another Video Point. Repeat this step until the
Videoclip advances to the next frame. In this case you measure more than one Video
point per frame.

If a Diagram or Table is available, the Video Points will appear automatically in the
Diagram or Table.
• Repeat the procedure for each frame until you reach the last selected frame of the

videoclip or press the Stop button to interrupt the measurement.
Once you have collected data from the video you can still update, delete or add points after
the measurement has been finished.

3.2 Replay a Video measurement
One of the greatest features of Data Video is the ability to Replay the video scene and at the
same time watch the graphs in the Diagram evolve (as if it were a real-time measuring
process). The Replay button is available after a measurement is done. When replaying a
Data-Video measurement, the Diagrams and Tables are updated simultaneously.

3.3 Scan
In Data Video, Diagrams and Tables are synchronized with the video frames. Each point in a
Diagram/Table has counterpart in a video frame. This is because the timing information in
the videoclip is related directly to the number of frames per second with which the video is
recorded.
Start scanning via the Tool menu of the Diagram by selecting Scan. When scanning (e.g.
with mouse clicks or with the cursor keys) in the Diagram or Table, Coach shows the
corresponding video frames in the Data-Video window. Now it is also possible to update
Video Points. When a Table is displayed, the exact row of the Table is also selected
automatically.
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- If a calculated Video Point is defined in an Activity, this point is also displayed in the
video frame during the measurement (unless the calculated point is defined to be
Invisible).

- If the Origin is chosen as a First point clicked at each frame (in the Coordinate-settings
dialog), then the first point clicked in each selected frame defines the Origin of the
coordinate system and is not displayed.

3.4 Editing Video Points
After the Data-Video measurement is finished, there are a number of possibilities to modify
the data set.

To edit Video Points
If you are not satisfied with some of your marked Video Points you can come back to a
frame and move a Video Point to another location. To update the measured Video Point:
• Click a frame on the Frame controller in which the measured point must be corrected.
• Drag a Video Point to the desired location.
• The Diagrams and Tables update simultaneously.

To update the Origin of Video Points

• Right click in the Data-Video window or click the Tool button.
• Select Coordinate settings.
• Click OK.
• If Origin  =  Same at all frames

- Drag the Origin to the desired new position.
• If Origin  =  First point clicked at each frame

- Select the Frame where you want to update the chosen origin.
- Drag the Origin to the desired new position.
- If necessary, repeat the procedure for the origin of other frames.

To delete Video Points
You can delete Video Points after the measurement is finished. To delete a Video Point:
• Click a frame on the Frame controller in which the measured point must be deleted.
• Use <Del> to deselect a frame and delete a point. The de-selected frame becomes gray in

the Frame controller.
• The Diagrams and Tables update simultaneously.
Video Points can only be removed via the Video Tool menu. In a Data-Video Activity, the
option Rows in the Table Tool menu is not available.

To add extra Video Points
You can also add extra data points after your measurement is finished, e.g. when the
selected frames are too far apart to follow the motion sufficiently accurate. To add a new
Video Point:
• Click an additional frame on the frame controller and manually select this frame by

using <INS>-key. The selected frame becomes black in the frame controller.
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• Click the green Start button. The first selected extra frame automatically appears on the
screen.

• Locate a new Video Point.
• Repeat this for all extra selected frames.
• The Diagrams and Tables are updated simultaneously.

It is possible to jump to a frame by clicking a point in the Diagram or Table, provided Scan
mode is on.

44..  VViiddeeoo  DDiiaaggrraammss  aanndd  TTaabblleess
The Video Points can be displayed in a Diagram or a Table. The Diagram or Table can be
setup prior to starting a video measurement or after it. The advantage of preparing the Video
Diagram and Video Table before the measurement is that the data are displayed during the
measurement.

Video data in the standard Video Diagram
A standard Data-Video Diagram is a Diagram of which the points are synchronized with the
Video Points on frames of the videoclip. It is possible to define more than one of such
Diagrams.
• Right click in the Data-Video window or click the Tool button.
• Select the option Display as a Diagram.
• Click in a window to place the standard Video Diagram. This will plot the horizontal

(Px) and vertical (Py) Cartesian coordinates of the Video Points versus time.

Video data in the standard Video Table
A standard Data-Video Table is a Diagram of which the points are synchronized with the
Video Points on frames of the videoclip. It is possible to define more than one of such Table.
• Right click in the Data Video Table window or click the Tool button.
• Select the option Display as a Table.
• Click in a window to place the standard Video Table. The time data and the horizontal

(Px) and vertical (Py) Cartesian coordinates of Video Points are displayed in Data ranges
C1, C2, and C3 of the Video Table.

Notes:

- If more Video Points are measured per frame, then the coordinates (Px and Py) of all Video
Points are displayed in the standard Video Diagram and Video Table during the measurement
process.

- If you want to display data in a different way in the Diagram or Table, then you can can edit it.

- By default the Cartesian coordinates of Video Points are displayed. It is possible to display the
Polar coordinates of the Video Points: PAngle and PDistance. In this case the connection of
Data ranges in Diagram /Table should be changed.

- The unit with which angles are measured on the protractor can be radians or degrees,
depending on the pre-defined settings for the Activity in the 'Activity options'.



GGUUIIDDEE  TTOO  CCOOAACCHH  --  110099

55..  AAddddiittiioonnaall  sseettttiinnggss
The Data-Video window offers some additional Data-Video settings which can be reached
via the Data-Video Tool menu.
• Right click in the Data-Video window or click the Tool button.

You have possibilities to mark/unmark the following options:

Axes
a toggle to display or remove the displayed scale and origin in the video image.

Full size
to enlarge the video image to its maximum size.

Playing speed
to choose a playing speed for the video.
• Select the option Playing speed… to display the Playing-speed dialog.
• Adjust the speed of playing with the slider:

1000% means that the video will be played 10 times faster than the 100% setting.
10% means that the video will be played 10 times slower than the 100% setting.

• Click OK.

Trace
to display markers of all measured Video Points on the video image.

Ruler
to measure any distance between two points on the video image.
• Check the option Ruler. The horizontal Ruler (red by default) appears on the video

image.
• Drag the ruler's end points to the positions between which you want to measure the

distance. The distance is displayed next to the ruler.

Protractor
to measure an angle on the video image.
• Check the option Protractor. The Protractor (yellow by default) appears on the video

image.
• Drag the protractor and its end points to match an angle between two points. The

measured angle is displayed next to the protractor.
Angle units can be radians (default) or degrees, depending on the setting in the Activity
options.

66..  OOppeenniinngg  aa  nneeww  vviiddeeoo  oorr  sseeqquueennccee  ooff  ppiiccttuurreess

6.1 Opening a video
A new video can be opened in the Data-Video window.
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Coach supports the following digital video file-formats:
- ∗.AVI – Abbreviation for ´Audio Video Interleaved', the most common digital format for

Windows;
- ∗.MOV – QuickTime format, standard for Macintosh computers but can be played on

Windows computers;
- ∗.MPG – Abbreviation for Motion Pictures Expert Group, standard for the compression of

moving images.

To open a new video

• Right click in the Data-Video window or click the Tool button.
• Select the option Open video…
• Select a title from the list.
• If the list is empty or if the desired videoclip is not in the list, add a videoclip to the list

by clicking the Add button.
• A screen showing the first video frame appears in the Data-Video window. Notice that

all frames in the Frame controller are selected by default (i.e. the frames are black).

6.2 Opening a sequence of pictures
A new sequence of pictures can be opened in the Data-Video window.
Coach supports the following picture formats:
- ∗.BMP– Windows or OS/2 bitmap
- ∗.GIF – Graphic Interchange Format, a format which is widely used on Internet
- ∗.JPG – Abbreviation for Joint Photographic Experts Group. The standard format for the

compression of images. JPGs are 16-bit color pictures of reasonable small size. Is also
widely used on Internet.

To open a new sequence of pictures

• Copy the picture sequence to the
Current Project directory or the
Graphics directory. Coach places
the picture files in alphabetical
order. Recommended is to
rename the pictures of the
sequence to a name including a
number, like ball01, ball02,
ball03, ball04, etc. The name
should follow the 8.3
convention.

• Right click in the Data-Video
window or click the Tool button.

• Select the option Open
pictures…

• Select the picture sequence from the list (by using the <Ctrl>-key or the <Shift>-key).
• Enter the number of frames per second the pictures were taken with (each picture

represents a frame).

Figure 61. Opening a sequence of pictures.
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• Click OK.
• A screen showing the first frame appears in the Data-Video window. Notice that all

frames in the Frame controller are selected by default (i.e. the frames are black).

77..  PPrreeppaarraattiioonn  ffoorr  VViiddeeoo  MMeeaassuurreemmeenntt

7.1 Coordinate settings
Before you start the video analysis you need to scale (calibrate) the new video. You have to
define the following items:
- The Scale to specify which distance on the video image corresponds to which known real

distance.
- Coordinate system to specify what is the coordinate system according to which the

measurements are taken.
- Time calibration to specify how fast the video was taken.

To scale a video

• Open a video if needed.
• Right click in the Data-Video window or click the Tool button.
• Select the option Coordinate settings. The Coordinate-settings dialog appears. Define

the following settings:

Scale
In the majority of videos use the default setting Same scale in all directions. In this case
the same scale is assumed in all directions. Select Different scale in horizontal and

Figure 62. Coordinate Settings dialog window.
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vertical direction if the scale is different in two directions. (This setting applies e.g.
when to compensate for a perspective).

X-axis direction
Select From left to right if the horizontal axis direction is from left to right, or select
Reversed if the horizontal axis direction is from left to right.

Y-axis direction
Select From bottom to top if the vertical axis direction is from bottom to top, or select
Reversed if the vertical axis direction is from top to bottom.

Origin
Select Same at all frames if the camera did not move during the recording of the
videoclip (i.e. a fixed coordinate system is assumed). Or select First point clicked at
each frame if the camera moved during recording of a video clip or if you want to
measure according to a moving center of mass (moving coordinate system). In this case,
the first point clicked on each frame defines the origin of the coordinate system
according to which the measurements are taken.

Time calibration
Usually this information (the number of frames per second) is included in the digital
video and you can rely on the default value specified in the box. If this information is
lacking or appears to be incorrect, type in a value of the video-recording speed.
There are three methods of choosing the starting time: Check one of the boxes:
- t=0 at first frame;
- t=0 at first selected frame.
- t=0 at frame n (enter a valid frame number for n)

Once these items have been defined, you are ready to begin the scaling process.

• Click OK to confirm.

The Scale-settings dialog appears on the
screen and the scale-ruler (red by default) and
the origin (yellow by default) appear on the

video image. If different scales in the
horizontal and vertical direction were chosen
then two scale-rulers, a horizontal ruler and a vertical ruler appear.

• If desired, move the coordinate system by dragging its origin (drag the small circle). You
can also rotate the coordinate system by dragging the yellow dot next to the origin.

• Drag and resize the end points of each scale-ruler to match them to a known length
between two points on the video image. In videos for measurement purposes a known
length can often be found in one of the first frames of the video.

Figure 63. Scale settings window.
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• In the dialog box, type in the corresponding length in reality, together with its unit. This
value should correspond to the known distance on the screen (the default value is 1.000 
m).

• Click OK when you are ready.
• Now you can start the video measurement.
Note:

You can change the coordinate settings and scale settings at any time, even after the
measurement is finished. In this case Diagrams and Tables are updated simultaneously (see also
Updating Video Points).

7.2 Video Points
Video Points are points collected on a video frame during the video measurement. It is
possible to collect up to 8 Video Points.
For a set of Video Points another point can be calculated for example the Center of Mass
location. This point can be displayed on the video image during a measurement.

To define a number of Video Points

• Right click in the Data-Video window or click the Tool button.
• Select the Points option.
• Select the Number of Measured Points.
• The Number of Calculated Points should remain 0.

To define a number of calculated points

• Right click in the Data-Video window or click the Tool button.
• Select the option Points…
• Select the Number of Measured Points.
• Select the Number of Calculated Points.

When the chosen number is higher then 0 then the 'Calculated points' section appears at
the bottom of the window.

• Select formulas to calculate X and Y coordinates of calculated point(s).
By default the Data range connections are (Empty). Formulas appear in the drop-down
lists only if these formulas have been defined in a Diagram or Table before.
All coordinates of measured Video Points can be used as variables in formulas to
calculate coordinates of calculated points.

Figure 64. The number of Measured Points dialog window. For the
calculated points the Formulas Xc and Yc are selected. These formulas
are defined in a Diagram (Table).
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If there are no formulas available in the drop-down lists of the X and Y coordinates of
calculated points, you first have to define these formulas in the Diagram (Table), and then
once more select the Points… option in Data-Video Tool menu and select these formulas
from the drop-down lists.

7.3 Markers and Colours
The Markers and Colours determine how the Video Points and other graphical elements will
be displayed on the video frame.

• Right click in the Data-Video window or click the Tool button.
• Select the option Markers and Colours…

The Markers-and-Colours dialog has two sections:
• In the Upper section ('Colours'), specify the colours of the coordinate system, the ruler(s)

and the protractor.
• In the Lower section ('Points') specify the markers and colours of measured and

calculated Video Points. Every point has its own Marker and Colour. If you do not want
to display a Video Point on the video frame, make them invisible by setting Visible=Off.
In this section the specified number of measured and calculated Video Points is
displayed once more.

7.4 Frames
After opening a videoclip, all frames are selected for the video measurement. Usually only a
number of selected frames are used in the measurement. This Topic describes how frames
can be selected.

To open the Frames dialog

• Right click in the Data-Video window or click the Tool button.
• Select the option Frames…

Figure 65. Markers and Colours dialog window.
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The total number of frames available in the
videoclip is displayed in the upper part of the
Frames dialog box. This dialog has the following
options:

Select Frames
There are four methods for selecting frames. You
can select only one method.

Use All Frames
The measurement is done on all video frames; this
is the default setting.

Select Automatically
This selection is done automatically by Coach. The
frames are equal distributed for example every 5th

frame is selected.
• Type in how many frames you want to select.

Select These
This option allows defining a list of frames to select, for example:

- 10-20: selects frames from 10 to 20
- 1,5,10: selects frames 1, 5 and 10
- 10-20$2: selects every 2nd frame between 10 and 20, which means 10, 12, 14, 16, 18,

20).
• Type in the list of frames you want to select.

Select Manually
In this case you have to click a frame on the Frame controller and select it with <INS>-key
and de-selected with <DEL>-key. The selected frames are black; the deselected frames are
gray.
• Select this option.
• Click a frame on the Frame controller.
• Use the <Ins>-key to select a frame.
• Use the <Del>-key to deselect a frame.

Zoom to Frames
With this option the frame range can be specified which is displayed in the Frame controller.
• Type in the first and last frame number of the range that should be zoomed (i.e.

displayed fully over the whole Frame controller).
• This can also be accomplished in a more direct way:
• Click the magnifying-glass button to the right of the Frame controller.
• Drag a selection of Frames in the Frame controller. The Zoom-to-Frames option now

reflects the zoomed number of Frames.

Figure 66. Frames dialog box.
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11..  IInnttrroodduuccttiioonn
A Modeling Activity offers an environment to create models of dynamical systems and do
model calculations. E.g. differential equations can be solved numerically (based on the
method of finite differences (Euler)).
In Coach you can create models models in two different ways: graphical models and text
models.

In graphical mode, the Model structure is built with graphical symbols and gives a visual
representation of all variables (represented by symbols) and their interactions (represented
by arrows between the symbols). Coach automatically translates the resulting graphical
structure into a corresponding set of model equations.

In Text mode, the Model structure consists of a sequence of equations (differential
equations, functional equations and formulas) and Initial values.

It is always possible to switch from a Graphical model to a Text model. The reverse is not
true, in general. Coach gives a warning that the Model will be lost when going from a Text
mode to Graphical mode (unless the Text model was not changed).

Based on the given Model and Initial values, iterative calculations are performed a given
number of times (max. 16,380). The result of the previous iteration are the input for the next
one. The accuracy of these calculations depends on the size of some step variable (the
smaller the step, the more accurate the result).
When executing a Text model in the Monitor, the actual value of all Model variables is
displayed. When executing a Graphical model, the values are displayed anyway.
All Model Variables can be displayed in Diagrams and Tables by connecting them to a
Data-range.
The option Simulation allows to vary an initial value or a Model parameter and observe its
effect in the Model via the shape of the graph.
Finally it is possible to compare the (calculated) Model data with experimental data. This is
called Hypothesis testing. Especially in combination with the Simulation option, this is a
powerful tool to test theories experimentally.

You can recognize a Modeling Activity to the blue M-button in the Activity Toolbar.

22..  TThhee  MMooddeell  wwiinnddooww
The Model window is the place where you can create Models.
• Click the M-button to open the Model window.
• Click the G-button to display the Model window in Graphical mode.
• Click the T-button to display the Model window in Text mode (default mode).

In fact, there are two Model windows, depending on the Model mode.

In Graphical mode the entire window is used for the Graphical structure of the Model. In
Text mode the Model window is divided into two parts. The left side of the Model window
is used for the Model equations; the right side of the window is used to specify the Initial
values of Variables and Constants.
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33..  EExxeeccuuttee  aa  MMooddeell
During Model execution, calculations of the Model Variables are done, based on the given
Model and Initial values.
The Model is evaluated a given number of times. The number of iterations is set in the
Model settings. In each iteration, the values of the variables are calculated, stored in
memory, and displayed in the defined Diagrams and Tables. In the first iteration, the initial
values are used as input. Each next iteration, the calculated values from the previous
iteration are used as input.
Model execution can be done in two ways:
- Fast (Monitor=Off) (Default setting)
- Slow (Monitor=On)
Which method is used is specified with the Monitor-option in the Tool menu of the Model
window.

To change the Model settings

• Click the Model settings button.
• Type in the Number of points - the number of times

the model will be iterated (max. 16380).

Fast Model execution (default)
• Right click the Monitor window or click the Tool

button.
• Make sure the 'Monitor' option is turned off. (You can find this option in the Tool menu

of the Model window).

Figure 68. The Model settings
dialog window.

Figure 67. The Model window in text (left) and Graphical (right) mode.
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• Click the Start button (or press <F9>) to start Model execution.
• Click the Stop button or keep <Esc> pressed to interrupt Model  execution

Slow Model execution in Monitor mode
• If necessary click the M-button to open the Model window.
• Right click in the Model window or click the Tool button.
• Mark the Monitor option.
• Click the Start button (or press <F9>) to start Model execution.
• The Monitor window opens.

The Monitor window is a special window in which the execution of Models can be followed
line-by-line (in Graphical mode cycle-by-cycle).
• Adjust the speed of the Monitor with the slider (this can be done also during execution).
• Execute a single line of the Model with the 1-button in the Monitor bar.
• Click the green Start button in the Monitor bar to start line-by-line Model execution. All

values of model variables are displayed at the right side.
• Click the red Stop button in the Monitor bar or keep <Esc> pressed to interrupt Model

execution.
During monitoring the current line which being calculated is indicated in Text mode. In
Graphical mode the digital values of the variables are shown in boxes under the graphical
symbols.

Notes:

- The Model calculations can be performed only if the Model and Initial values have been
entered correctly.

- By introducing a Stop statement in the Model, the Model is evaluated only up to this Command,
after which Model execution stops. This Command can be used e.g. in a Conditional statement
to stop Model execution after a certain condition is fulfilled.

Figure 69. Model execution in the Monitor window.
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44..  MMooddeelliinngg  iinn  GGrraapphhiiccaall  MMooddee
A Model in Graphical mode consists of graphical symbols representing Variables and
Constants that are connected to show the relations between them.
The model structure (in fact a kind of ‘concept map’ of the process to be modeled) is placed
in the Model window.

4.1 Graphical Mode Toolbar
When you are in a Modeling Activity, the Model window shows the Modeling Toolbar. In
the Graphical mode the Toolbar consists of the following buttons.

Graphical symbols

Growth variable

Variable

Constant

Connection line

Edit symbols

'Delete' respectively 'Select'/'Move'

Switching Modeling Mode

Show Model in Text mode

Model settings

Change the number of iterations (default is 2000)

4.2 Graphical symbols

Growth variables and the Step variable
A Growth Variable and a Step Variable use the same graphical symbol but have a different
color. A Growth Variable is turquoise, while the Step Variable is light gray.
- The Step Variable (only one per Model) represents the independent variable in the Model.

The Step Variable is calculated by repeatedly adding or subtracting a constant "variable-
change". The size of this change determines the accuracy of the Model calculation.
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The default Step Variable in Coach is 'time', but it is also possible to rename it into
another quantity (After this change, Coach automatically replaces the name of all Step-
Variable-changes which are part of equations in the graphical Model to the new name).
Warning: Once a Step Variable is removed from the Model, it is not possible to restore it.

- A Growth Variable is calculated by repeatedly adding or subtracting a "variable-change".
The value of the variable-change may depend on other Variables or Constants and is
defined with the help of a formula. By default, this Formula includes a factor dtime in it.
Warning: Once the Step Variable is removed from the Model, all formulas in which the
Step-Variable or the Step-Variable change is used are not valid any more. This will
probably result in a faulty Model.

Step Variable
 (by default:
d?=dtime; ?=time)

Growth Variable

The symbol consists of two parts:
- The Rectangle: this part defines a quantity. By clicking

on the rectangle, the Name and Initial value can be
entered.

- An Arrow: this part defines a quantity change.
If a quantity Name has been given, this will be carried
over into the arrow section giving its dName
automatically. This can be changed by clicking the arrow
part and changing a dName. A formula can be entered,
using the Expressions of Coach Language (Wizard
available).
The arrow part by default depends on the step-size of the
Step Variable (default: dtime). When the name of the
Step variable is changed, Coach automatically replaces
dtime with the new Step-variable change.

Variable
A Variable is calculated from other Variables (quantities) using a formula.

Variable Each Variable needs a Name and a Formula.
Once the relationships with other Variables and Constants
have been given by Connection lines, the formula can be
constructed with help of the Wizard by making choices
from a list of Variables.

Constant
A Constant is a quantity, which does not change during the Modeling process (calculations).

Constant
Each Constant needs a Name and Value.
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Connection lines
Connection lines create relations between the elements of Graphical Model. The direction of
these lines, indicated by an arrow, shows cause and effect. The Variable at the end of a line
depends on the Constant or Variable at the start of the line.
In the picture below, an example of a Graphical Model is shown. The symbols described
above are connected with Connection lines.

4.3 Edit a Graphical Model
A Model in Graphical mode consists of graphical symbols representing Variables and
Constants that are connected to show the relations between them.
The model structure (in fact a kind of 'concept map' of the process to be modeled) is placed
in the Model window.

To move a Graphical symbol

• Click the Select button or a Symbol button in the Toolbar of the Model window. The
cursor changes its shape into an arrow.

• Drag an element of the Model structure to desired place.

To edit the Name and Initial value of a symbol

• Click the Select button (or a Symbol button) in
the Toolbar of the Model window. The cursor
changes its shape into an arrow.

• Double click a symbol in the Model structure.
• Type in a Name and Initial value.
The name can be long, however long names may not
be displayed completely. For Variables you can also
edit a formula.

To delete a Graphical symbol

• Click the Delete button in the Toolbar of the Model Window. The cursor changes its
shape into a scissors.

Figure 70. Example of a part of a Model structure with connection lines.

Figure 71. Editing the Name and Initial
value of a symbol.
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• Place the cursor on a symbol and click to delete. The symbol and all its connection lines
will be deleted. When the symbol of a Growth variable (Step variable) is deleted, all the
formulas in the connected symbols are also erased.

To delete a Connection line

• Click the Delete button in the Toolbar of the Model Window. The cursor changes its
shape into a scissors.

• Place the cursor on a line (small cross should be placed over a line) and click to delete.
or
• Click the Connection line button in the Toolbar of the Model Window. The cursor

changes its shape into a connection line.
• Click the symbol where the connection line starts.
• Click the symbol where the connection line ends. The connection line between these

symbols is removed.
When you start to create a line, you can right click anywhere to delete that line.

To erase a Model

• Right click in the Model window or click the Tool button.
• Select the Erase model option.
• Click Yes when the question 'Do you want to erase model?' appears. The model

structure will be deleted.

4.4 Create a Graphical Model
The Graphical mode is a tool, which simplifies the development of mathematical models. It
improves thinking in terms of cause and effect.
The Variables and Constants of a Model are represented by Graphical symbols. The relation
between these are indicated by Connection lines drawn between the symbols.
Once the Model structure has been drawn, the real relation should be entered as a formula
and the initial values should be defined. Then the Model can be executed.

To open the Model window in Graphical mode

• If necessary click the M-button to open the Model window.
• Click the G-button to open the Model window in Graphical mode.

The pre-defined Step variable
After opening the Model window in Graphical mode the Step variable (independent
variable) is already defined. The Step variable gives a Model its dynamic character. The
default Step variable is time with an Initial value=0. The default Step size is dtime with a
value of 0.01.
This is done because time is the most common independent variable for a Model. It is
possible, however, to change these settings. To rename the Step Variable proceed as
follows:
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• Double click the Step Variable ('time'). Type a new Name. The name of the Step size
('dtime') is automatically renamed.

• If you only want to rename the Step size, double click it and type a new name
Note: The factor dtime that appears by default in formulas will be renamed automatically as well.

Creating a Model in Graphical mode
Analyze the process you want to model. Define Variables and Constants and the relations
between them. This part can be done on paper.
• Create the Graphical structure of your model:

- Click a Graphical-symbol button (Growth variable, Variable or Constant) in the
Toolbar. The cursor changes its shape. This shape is different for each symbol.

- Click in the Model window to place the symbol.
- Double click the symbol and type in its name.

• Draw Connection lines between the elements of your Model.
- Click a Connection-line button in the Toolbar. The cursor changes its shape.
- Click the element from the which the Connection line has to start, and click the

element where the Connection line has to end. It is possible to click empty spaces in
between to shape the Connection line and keep the Model 'well-organized'.
Remember: the Variable at the end of the line depends on the Constant or Variable at
the start of the line.

• Once the Model structure has been determined, the formulas can be entered. These
formulas can be created with the Formula editor. The list of variables in the Formula
editor contains the names of Variables and Constants, which have been connected to the
Variable.

• Enter the Initial values (for a Variable this is only necessary if the Variable has no value
during the first iteration) and values for the Constants by double clicking their symbol
and typing the value.

The Graphical structure prepared by the user is converted to Model equations by Coach
which are not visible for the user in graphical mode. If desired, this Model can be viewed
and or further developed in Text mode. However, after changes made in Text mode the
Model can not be converted back to Graphical mode (or changes will be ignored).

Click the links for instructions how to move, edit, or delete symbols in the Model or delete
connection lines
Note: Graphical modeling is intended for simple dynamic models. Complex models with lots of
Variables, Equations and Conditional or Loop statements are easier to make in Text mode.

4.5 Example of building a Graphical Model

Discharging a capacitor
A capacitor with a capacity of 1 mF and a potential
difference of 5V is discharged through a 700 Ù resistor.
The question is how this process works and what
determines the form of the V(t) Graph. Figure 72. Electrical circuit.
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The process to be modeled
The charge on a capacitor is proportional to the potential difference across the capacitor. If
the plates of a capacitor are connected by a circuit with resistance, a current flows and
capacitor discharges.

The relations between the quantities
There is a certain amount of charge Q on the capacitor.
This causes the potential difference across the capacitor (V) and therefore across the resistor.
The voltage across the resistor causes a current (I).
The amount of current is determined by the resistance of the resistor (R).
The electrical current consists of moving charge, which comes from the capacitor.
This in turn affects the voltage on the capacitor… The process is a loop.

Building a graphical structure
• Start a Modeling Activity with an empty Model.
• When necessary open the Model window.
• Click the growth-variable symbol and place it on the screen. Double-click the

Rectangular part of the symbol and give a name Q (charge)
• Click a variable symbol for potential difference and place it on the screen. Double-click

the symbol and give a name V (Voltage).
• Click a variable symbol for the current caused by this potential difference and place it on

the screen. Double-click the symbol and give a name I (Current).
• Add the lines, which shows cause and effect. From Charge to Voltage, from Voltage to

Current, from Current to change in charge dQ.
The resulting Model structure map shows the structure of the process.

Quantifying the relationships
• The voltage Voltage=Charge/Capacitance. So far you don't have the capacitance as a

constant.
- Click the constant symbol and place it on the screen.
- Give it a name C (Capacitance).
- Draw a line to the variable V.
- Double-click the variable V and enter the formula Q/C.

• The current Current=Voltage/Resistance. So far you do not have the resistance as a
constant.
- Click the Constant symbol and place it on the screen.
- Give it a name R (Resistance)
- Draw a line to the variable I.
- Double-click the variable I symbol and enter the formula V/R.

• The change in the charge dQ = –Current*dtime (a (–)-sign is needed, because a
capacitor discharges).
- Double-click the Arrow part dQ.
- Use the Wizard and create formula –I * dtime. Notice that multiplication by the step

size of time happens automatically.
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The final model looks like (instead of time and dtime, t and dt are used):

Enter the Initial values
• Set the Initial value of the variable Q and the value of the constants C and R. Double-

click an element and type in an Initial value. Use SI units! Notice that you do not have to
define initial values for I and V as these variables are completely determined via the
formulas.

• If you wish to begin with a particular Voltage, the corresponding Charge should be
calculated first.

• Select the time variable and look at the step size dtime. By default this is 0.01s. Choose
a smaller value (e.g. 0.005) to follow the changes more accurately.

Model execution
• Click the Model settings button to define the model settings.
• Define the Diagram V(t) (see II. Diagrams and Tables).
• Run your model.

Figure 73. Process of discharging a capacitor - the graphical model.
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55..  MMooddeelliinngg  iinn  TTeexxtt  MMooddee
The Text mode is the default mode of the Model window.

5.1 Text Mode Toolbar
In the Text mode the Modeling window Toolbar consists only two buttons.

Switching Modeling Mode

Show Model in Graphical mode

Model settings

Change the number of iterations (default is 2000)

5.2 Edit a Text Model
A Model in Text mode consists of Model equations at the left side of the Model window,
and initial values at the right side of the Model window.

Edit
The Model equations and Initial values can be edited with a simple editor. Coach does not
guide you to write equations correctly, these equations have to be built according to Coach
Language rules. However, on executing a Model with syntax errors, Coach will indicate
which equations are not correct.

To delete a selection

• Make a selection.
• Press <Del>.

To move a selection

• Make a selection.
• Right click the selection and select Text edit>Cut (or press <Ctrl-X>).
• Right click the line above which you want to paste the cut lines.
• Select Text edit>Paste (or press <Ctrl-V>).

To copy selection

• Make a selection.
• Right click the selection and select Text edit>Copy (or press <Ctrl-C>).
• Right click the line above which you want to paste the copied lines.
• Select Text edit>Paste (or press <Ctrl-V>).

To erase a Model
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• Right click in the Model window or click the Tool button.
• Select the Erase model option.
• Click Yes when the question 'Do you want to erase model' appears. The model equations

and initial values will be deleted. Only pre-selected time equation and initial values
remain.

- With <Ctrl-Z> you can Undo (and Redo) the last change.
- With <Ctrl-A> you select the whole Model.

5.3 Create a Text Model
Modeling in Text mode allows the user to build a Model by defining mathematical
equations. To type Model equations and initial values, a simple text editor and extended
programming language Coach Language are available.
Once the Model equations have been typed in and the Initial values have been defined, the
Model can be executed.

To open a Model in Text mode (open by default)

• If necessary click the M-button to open the Model window.
• Click the T-button to open the Model window in Text mode.

Pre-defined time variable
After opening the Model window in Text mode, the Step variable is already defined. The
Step variable is the independent variable and gives a Model its dynamic character. The
default independent variable is time with an Initial value=0. The default Step size is dtime
with a value of 0.01. This default is chosen, because time is the common independent
variable for Models. It is possible to use another independent variable, however.

Creating a Model in Text mode
• Analyze the process you want to model. Define variables, constants and relations

between them.
• Type in the Model equations. A few rules are given below:

- Constants may be defined either in the Model or in the list of Initial values.
- Variables obtain a new value in each iteration and so must be defined in the Model.
- Variables defined by an Expression containing the Variable itself, e.g.

capital:=capital  +  dcapital must be defined in the Model. To be able to calculate
this variable at first iteration, the Initial value of this variable must also be defined in
the Initial values.

• Type in Initial values. These values are needed to start the calculations.
In Text mode, Initial values may also be given as an expression (provided that this
expression results in a number).

Your Model should consist of a set of correctly structured lines accompanied by a set of
Initial values. Coach will check this during execution. If the syntax is not correct during
execution, an error message will result.
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- Via the default values for the independent variable, there is no Model result for time  =  0.
If you want to include a result for time  =  0, enter for time an Initial value time  =  –
dtime.

- The Coach Language interpreter (also used to interpret Text Models) is not case sensitive
(e.g. there is no distinction between t and T).

5.4 Examples of Text Models

Model 1 - Exponential growth of capital

Model
 dcapital:= interest ∗ capital/12
 capital:= capital +dcapital
 month:=month + dmonth

Initial values
 capital = 100
 interest = 0.05
 month=0
 dmonth=1

Model 2 - Linear growth of capital 

Model
 dcapital:= interest ∗ startingcapital/12
 capital:= capital +dcapital
 month:=month + dmonth
 year:=month/12

Initial values
 startingcapital=100
 capital = 100
 interest = 0.05
 month=0
 dmonth=1

66..  SSiimmuullaattiioonn
With Simulation, the value of a single Model parameter can be varied to study its effect on
the Model. For each value of the parameter, a graph (in a different colour) will be drawn in
the same Diagram. After finishing the simulation, the last graph will be placed in the
Diagram and all other simulated graphs will be drawn in grey (i.e. without data).
The option Simulation appears in the Tool menu of the Diagram window as soon as there is
a Model.

Performing simulations
• Right click in the Diagram window created in the Modeling activity click the Tool

button.
• Select the Simulate option.
• Select a parameter from the list. The list consists of all quantities defined in Initial

values.
• The first parameter value

displayed in Simulate dialog is
always the value copied from the
list of initial values.

• Type in a new parameter value. Figure 74. Simulate dialog window.
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• Click Run. The graph resulting from the Model calculation with this new value appears
in Diagram. The new graph has a different colour and the parameter value is displayed
next to the vertical axis.

• Repeat this procedure for other parameter values. The values entered are only
temporarily used for calculations. A number of graphs can be drawn in the same graph,
yet each new series of values replaces the latest values in a memory. To keep several
simulation runs active do one simulation, close it and use the 'Copy column' option. Do
the same for the next runs.

• Click Save current value to save the last typed parameter value as new Initial value.
• Click Print if you want to print the Diagram with all simulated curves.
• Click Copy to Clipboard to copy the Diagram including all simulated graphs to the

Clipboard.
• Click Close to close the Simulate dialog.

77..  TTeessttiinngg  aa  hhyyppootthheessiiss
The Modeling environment also offers powerful possibilities to compare the outcomes of
Model calculations (theory) with measured data (reality).
To verify whether the theory (calculated data) matches the reality (measured data) the option
Simulate may be used with the presence of a Background graph. One measurement graph
can be placed in the Diagram as a Background graph and may be compared with the graphs
resulting from Model calculations.
A hypothesis can be tested e.g. by varying the value of the constant of proportionality in the
Model, to investigate which value leads to the best fit of the Background graph.
If the calculated graph partially overlaps the Background graph, the option Shift
Background graph makes it possible to shift the Background graph horizontally. This
option becomes available in the Diagram Tool menu after the Background graph is placed in
the Diagram.
With the Scan option the coordinates of points of both graphs can be determined, which
makes it possible to quantitatively compare the data.

Figure 75. Testing a hypothesis. The Simulate option helps to find the
best fit of the measurement data.
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88..  MMaannaaggeemmeenntt  ooff  MMooddeellss
In general, Models are saved together with all other Activity settings in the Coach Result. It
is also possible, however, to open only the Model from another Coach (Junior) Result in the
Activity or Result you are working in. Furthermore, Models can be printed. Finally, it is
possible to Import an IP-Coach 4 Model or to Export as IP-Coach 4 Model.

To open only a Model from another Coach (Junior) Result

• Right click in the Model window or click the Tool button and select Load Model from
Result.

or
• Click File>Load Model from Result.
• Select a Result and click OK.

To import an IP-Coach 4 model

• Click File>Import a Coach 4 Model.
• Select a Coach 4 Model (∗.ASC) and click OK.
The previous Model and its Initial values are overwritten. So save your work before opening
a Result in this way, or your work is lost.

To export as an IP-Coach 4 model

• Click File>Export a Coach 4 Model.
• Type a name and click OK.

Print a Model

• When necessary, click the Model button to open the Model window.
• Right click in the Model window, or click the Tool button.
• Select Print model.
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11..  IInnttrroodduuccttiioonn  iinnttoo  CCooaacchh  LLaanngguuaaggee  iinn  CCooaacchh  55

1.1. Introduction
Coach Language is an easy programming language which can be used in various places in
Coach:
• In Formulas, to do calculations on data in Tables;
• In Modeling, to create text Models or to enter the formulas in graphical models.
• In Control Activities, to create Programs to control devices or processes.
Programs in Coach Language are interpreted rather than compiled. The Coach Language
interpreter checks whether Expressions and Statements are correct. If not, an error message
appears on the screen. The Formula, Model or Program must always be corrected before it can
be executed.

1.2. Comparison with other Programming languages
Coach Language is a relatively simple programming language derived from Pascal. If you have
some experience in languages like BASIC or Pascal, you may recognize most of the
expressions and statements. Programs written in Coach Language can only be executed within
Coach.

To write a Model or a Program in Coach Language you need to know about the order the words
in Expressions and Statements should appear (Syntax) and about their meaning (Semantics).
The more Expressions you know, the better you can write Models, and the better you can
Control devices. If you are going to learn Coach Language, you will find out quite soon that
you can have a lot of computational work done by the computer and that you can use it to
Control processes and devices.

Unlike more complex programming languages, it is not possible to define Arrays and Character
variables (‘Chars’) in Coach Language, to enter values by means of the keyboard, or handle
files while running a Program.
On the other hand, using Expressions, and Standard Procedures and Functions offered by
Coach Language you have direct control over the 'in', 'out' and 'counter' ports of the interfaces
(as far as these ports are available on the interface, of course).

22..  NNaammeess  aanndd  nnuummbbeerrss
When writing a Function, Model or Program you must use names to indicate: constants,
variables, procedures and functions. You have a lot of freedom in giving suitable names.

2.1 Names
When composing names you are allowed to use characters from the following sets:
- { A  B  C .. Z } capital letters;
- { a  b  c .. z } lower case letters;
- { 1  2  3 .. 0 } numbers;
- { £  _  &  ~  !  |  {  }  [  ] } symbols;
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When composing names certain characters and words are reserved to Coach and may not be
used (look at chapter 2.3).
The Coach interpreter does not distinguish between capital letters and lower case letters.
You can, for example, not use R for the resistance of a lamp if you have already used r for
radiated light. Identical (and correct) names are for example the following pairs:
MaleineAcid = maleineacid;
PopulationGROWTH = populationgrowth.

2.2 Numbers
When composing numbers you can use characters from the set:

{ 0  1  2  3  4  5  6  7  8  9  +  -  .  e  E }
The maximum number of significant figures is eleven. The smallest accepted positive
number is 1.0e-36, the largest positive number 1.0e+36. An error message appears when
exceeding these limits.
You may use the letter e or E to denote powers of 10, (scientific notation) e.g. :

0.5e-3  =  0.5E-3  =  0.0005  =  0.5 ∗ 10^3.

Notes:

- Decimal figures are separated by a decimal point (.).

- A number may not begin with a decimal point.

- The smallest accepted number is 1.0e-36, the largest positive number 1.0e+36. An error
message appears if these limits are exceeded.

- A number may not begin with a decimal point.

2.3 Reserved words and characters

Reserved characters
Some characters have a special meaning. It is not allowed to use them in names of constants,
variables, procedures or functions. These characters are listed in the table below.
• ASCII codes: 0 .. 31
• Symbols for arithmetic operators: (  )  -  +  ∗  /  ÷÷  ^  =  <  >
• Spaces and the symbols: '  .  ,  %  "  :  ;  $  #  @

It is not allowed to choose a number as the first character of a name;
By placing a name between square brackets the above restrictions can be ignored. The first
character of the name will be "[" and the last character "]", e.g. [2πr] is allowed as a variable
name.

Reserved words
Some words have a special meaning. You are not allowed to use them as names of
constants, variables, procedures or functions. The following words are reserved in Coach:
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 Abs
 And
 ArcCos
 ArcSin
 ArcTan
 Becomes
 Bit
 ClearData
 Column
 Cos
 Count
 Counter
 Do
 Domain
 Else
 EndDo

 

 EndFunction
 EndIf
 EndProcedure
 EndRedo
 Entier
 Exp
 Fac
 Function
 If
 Interval
 Latched
 Level
 Ln
 Log
 Max
 Min

 

 Not
 Off
 On
 Or
 Pi
 Print
 Procedure
 Rand
 Redo
 Repeat
 Reset
 ResetAbsolute
 ResetCounters
 Round
 RunningTime
SaveData

 

 Set
 SetAbsolute
 SetLevel
 Sign
 Sin
 Sound
 Sqr
 Sqrt
 Stop
 Stopwatch
 Tan
 Then
 Unlatched
 Until
 Wait
 While

The reserved words On, Off and Pi are the names of constants. The values of these
constants are 255, 0 and 3.141592654 respectively. You cannot alter the value of these
constants.

33..  EExxpprreessssiioonnss
An Expression is any combination of Variables, Operators, Constants and Functions
resulting in a single value. There are two groups of Expressions.

3.1 Simple expressions
A simple expression is:
• a single number such as 6.13 or 105
• a single constant (Pi, On, Off)
• a variable (x, time)
• a call to a mathematical function or to a standard Coach Language function. The result of a

function is always a value.

Regular Variables
A variable name can be considered as a label for a numerical value.
Assigning the value of an arithmetical expression to a variable name means that the value is
stored in a memory position of the computer under the label, e.g. "Total := 5 + 6" means that
the value "11" is stored under the label "Total". The prescriptions of names and numbers hold
for the name giving of variables.
A memory position with the name and the value, which does not change is called a Constant.

Logical variables
The result of a logical expression is also a value and stored in memory. The label is called a
logical variable (or Boolean variable).
If the result of a logical expression is On (True/High), the memory position is filled with the
value 255. If the result is Off (False/Low), it is filled with the value 0. The preference of the
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names On and Off in Coach Language has to do with the control facilities available by means
of the interface board.

In Formulas you may use either Quantity names or Column names (C1 to C8) as a variable.

Variables in a program are usually global, meaning that they are available in Functions and
Procedures as well as in the rest of the program.
A local variable is used as a parameter in the definition of a procedure or a function, it is only
understood in that procedure or function.

3.2 Expressions with Operators
An expression with operators consists of values and operators. An operator acts on one or more
values. An operator is a prescription by which values are converted into other values.
There are three different types of operators: Arithmetical operators, Logical operators and
Relational operators. In expressions with more than one operator, the priority of each operator
determines the order of execution.
For example in the expression 3∗ (V+1), the operator "∗" works on the values "3" and "(V+1)".

Expressions with operators can be used to define conditions in statements. An expression can
be used as a condition when the result is one of the Boolean values True or False (Logical 1
respectively Logical 0).
For True, Coach Language uses the term On. (On corresponds to the value 255). For False,
Coach Language uses the term Off. (Off corresponds to the value 0).

Examples of conditional expressions:
Temperature > 15
Brightness <> (l+1)/l
(Brightness > 20) AND (Colour <> Red)

3.2.1 Coach Language: Arithmetic operators

Operator Description Priority
-
^
∗
/
+
-

Reverse sign
Raise to the power

Multiply
Divide
Add

Substract

1
1
2
2
3
3

When operators in an expression have equal priority, the expression is evaluated from left to
right. The priority of an operation in a expression can always be overruled by using
parentheses.
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3.2.2 Coach Language: Logical operators
Logical operators (or Boolean operators) act on logical values, for example on the result of
relational operators. In Coach Language, there are three Logical operators:

Operator Operation Priority

NOT
AND
OR

Negation of Logical value
Logical AND
Logical OR

1
2
3

Truth tables for the Logical operators

NOT
S1 NOT S1
On
Off

Off
On

AND
S1 S2 S1 AND S2
On
On
Off
Off

On
Off
On
Off

On
Off
Off
Off

OR
S1 S2 S1 OR S2
On
On
Off
Off

On
Off
On
Off

On
On
On
Off

S1 and S2 in this table stand for statements like for instance "A>B" and"Number<1".

3.2.3 Coach Language: Relational operators
Relational operators always act on two values. These values are compared with each other. The
result is a Boolean (one of the logical constants On (True) or Off (False). All relational
operators have equal priority.
Complex relational expressions can be composed using Logical operators.
In such cases the relational expressions must always be placed between parentheses.

Operator Equation Priority
=

<>
<
>

<=
>=

equals
not equal
less than

greater than
less or equal

greater or equal

4
4
4
4
4
4
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When operators in an expression have equal priority, the expression is evaluated from left to
right. The priority of an operation in a expression can always be overruled by using
parentheses.

3.2.4 Examples of Expressions with operators

(x>1) AND (x<2)
For example if x=1.3 then the condition has the value True (On). If x=4 then the condition
has the value False (Off).

NOT (Temperature >100)
The condition has the value True (On) if the temperature is smaller or equal to 100, and
False (Off) in all other cases.

(y<-1) OR (y>1)
The condition has the value True (On) if e.g. y = 2, and False (Off) if e.g. y = 0.2.

(z>1) AND (z<2) OR (z>5) AND (z<6)
The condition has the value True (On) if z has a value between 1 and 2 or between 5 and 6,
and False (Off) in all other cases.

3.3 Syntax of Expressions

General rules
Use of Spaces and <Enter>
In a logical expression spaces must be placed to separate the logical operator from the value(s).
In arithmetic or relational expressions the use of spaces is optional. It is not necessary to write
an expression on just one line. It may for clarity be desirable to spread an expression with more
than one function over a few lines.
Expressions have to be separated from each other by spaces or by <Enter>. In the first case two
or more expressions can be placed on one line. When using <Enter> to separate expressions
each expression is placed on a new line.

Use of brackets ( )
Brackets in an expression are required if you wish to alter the priority of an operation. Brackets
may be used to increase the clarity of expressions.

Expressions with Operators
If an operator acts on a single value, then the value must be placed behind the operator. If an
operator acts on two values, then the operator must be placed between the values. Operators
with priority one are performed first, then operators with priority two, etc.
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Example: Interpretation of Expressions in Coach Language

Expressions with Arithmetic operators Interpretation

A∗B^C
A^-B∗C
A^-B-C
A/B-C
A+B∗C
A-B∗-C
a3∗x^3 + a2∗x^2 + a1∗x + a0

A∗ (B^C)
(A^(-B))∗C
(A^(-B))-C
(A/B)-C
A+(B∗C)
A-(B∗ (-C))
(a3∗x^3)+(a2∗x^2)+(a1∗x)+a0

Expressions with Logical operators Interpretation

NOT Dry+1
On OR NOT(Available)
Dry AND Wind OR Sun
Sun OR Dry AND Wind

(NOT(Dry))+1
On OR (NOT(Available))
(Dry AND Wind) OR Sun
Sun OR (Dry AND Wind)

Expressions with Relational operators Interpretation

X<Z/(Z-1)
X>=1+Y
X∗2<=Y+5
(A<=B) AND NOT(C>B)

X<(Z/(Z-1))
X>=(1+Y)
(X∗2)<=(Y+5)
(A<=B) AND (NOT(C>B))

When comparing a logical variable with a numerical variable, keep in mind the On and Off
correspond with the numerical values 255 and 0. However, a Boolean variable automatically
gets the logical value On if its numerical value is not equal to 0.
You may prefer to work with the names True and False instead of the names On and Off. This
is only allowed if you define the following assignments:

True := On
False := Off

44..  SSttaatteemmeennttss
A statement is a Program element which can be executed independently. Here, we distinguish
between simple and structured statements.
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4.1 Simple statements

4.1.1 Assignments
With an Assignment the value of a variable is replaced by the result of an expression. The
symbol for the assignment operator is := (colon equals). In Coach Language you can also use
the symbol = or the word becomes. It is not necessary to separate the operator with spaces:
variable := expression

Examples: X := Y + Z
Wet becomes (rain) AND (NOT(umbrella))

4.1.2 Procedure calls
Procedures are used to organize a program. A procedure consists of one or more statements
and carries a name. The result of a Procedure is the execution of the defined statements.
The statements are executed at the position where the call to the Procedure name is placed in
the Program. In Coach there are several types of Procedures possible:
• Standard Coach Language procedures.
• Pre-defined Procedures by the Author of the Activity (Micro-world).
• Own commands, Procedures created by the Student.

4.2 Structured statements
A structured statement is a statement which has a prescribed structure. There are two types of
these statements:
• Conditional statement (If..Then);
• Loop statements to repeat a number of statements in a loop.

4.2.1 Conditional statements
This statement conditionally executes a group of statements, depending on the value of an
conditional expression. The conditional expression must generate a Boolean value: True
(On) or False (Off). There are two different types of 'If .. Then' statements available.

If .. Then
If the condition is True (On), then statements between Then and EndIf are executed.

Syntax:
If Conditional expression Then
  Statements
EndIf

If .. Then .. Else
If the condition is True (On), then the statements between Then and Else are executed.
If the condition is False (Off), then the statements between Else and EndIf are executed.
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Syntax

If Conditional expression Then
   Statements
Else
  Statements
EndIf

 Examples of Conditional Statements in Coach Language

If x>0 Then
  y:= sqrt(X)
EndIf

If (a<2) AND (b>5) Then
  a:=a + 1
  b:=b – 5
Else
  a:=a –1
  b:=b+3
EndIf

4.2.2 Loop statements
In a Loop statement, a number of statements are executed a certain number of times. There
are three different types of Loop statement, two of which are controlled by a conditional
expression. The third is an unconditional Loop statement.

Repeat  ..  Until (Examples)
Repeat  ..  Until repeats the statements between Repeat and Until as long the condition is
False (Off).The statements will be executed at least once.

Syntax:

Repeat
Statements

Until Conditional expression

 Example

Repeat
  Set(1)
  Reset(1)
Until RunningTime > 125

Repeat
   If x>1 Then
        Set(2)
    Else
         Reset(2)
     EndIf
Until x>2
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While  ..  Do  ..  EndDo (Examples)
While  ..  Do  ..  EndDo repeats the statements between Do and EndDo as long as a
condition behind While is is True (On). If the condition is False (Off) at the start, no
execution will follow.

Syntax

While Conditional expression Do
Statements

EndDo

 Example

While t>1 Do
  Set(1)
  Reset(1)
EndDo

While r<> 3 Do
  If x>1 Then
     Set(2)
  Else
     Reset(2)
   EndIf
EndDo

Redo  ..  EndRedo (Examples)
Redo  ..  EndRedo repeats the statements between Redo and EndRedo a fixed number of
times (determined by the parameter 'Number'). The statements will be executed at least
once.

Syntax

Redo  Number
Statements

EndRedo

 Example

Redo 10
    Wait(0,5)
    Set(1)
    Wait(0,5)
     Reset(1)
EndRedo

Redo 1000
   If x>1 Then
       Set(2)
    Else
        Reset(2)
     EndIf
EndRedo
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55..  SSttaannddaarrdd  FFuunnccttiioonnss  aanndd  PPrroocceedduurreess  ooff  CCooaacchh  LLaanngguuaaggee

5.1 Standard Mathematical functions

The maximal value of x is 10^35 (if applicable)

Sin(x)
Cos(x)
Tan(x)
Arcsin(x)
Arccos(x)
Arctan(x)

sqr(x)
sqrt(x)
ln(x)
log(x)
exp(x)

entier(x)
round(x)
abs(x)

rand
max(x1;x2;.. xI)
min(x1;x2;..xi )
sign(x)
fac(x)

Sine of x
Cosine of x
Tangent of x
Inverse sine function
Inverse cosine function
Inverse tangent function

Square of x
Square root of x
Natural logarithm (base e)
Briggs logarithm (base 10)
e-power of x (ex)

Rounds a number down
Rounds off a number:
The absolute value of x

Generates a random number in the interval [0,1]
Selects the largest of i parameters
Selects the smallest of i parameters
Generates -1 for x < 0; +1 for x > 0;  0 for x = 0
Generates (round(x))!  (factorial)

x in deg/rad*

x in deg/rad*

x in deg/rad*

x in [-1;1]
x in [-1;1]

x in [-max, 81)

x in [0;+33,5)

* Depending on the settings of the Angle in the Activity Options.

5.2. Special Mathematical functions
 Special Mathematical functions use more than one cell to calculate a new value.
 These functions are used in the Advanced Formula Editor for calculations in Diagrams and
Tables
 

Delta(C)

Filter(C;n)

Difference between two successive values in the source column C. Cell(n)
is filled with the value of the expression Cell(n+1) – Cell(n). The last cell
in the target column remains undefined.

Filtering of values in source column C with inverval n. Each cell is
replaced by the average value of the cell itself, its n predecessors and n
successors (i.e. the average over 2n+1 points.
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Deltafil(C)

Domain(b;e)

Sum(C)

Integral(C;r)

Derivative(C)

Bezier(C)

Spline(C;n)

Combination of Delta(C) and Filter(C;n). Only useful if sample points
have an equidistant distribution in time. For n the fixed value of 10 is
used.

Fills all cells of the column with equally distributed values over the
interval [b,e] (b: begin value, e: end value) according to the formula:
cell(index) = b + [(e - b) * (index - 1)]/(n – 1), where n is the number of
rows.

Cell(n) contains the sum of all values in source column C which have an
index smaller or equal to n.

Numerical integration of values in column C. r is the constant of
Integration (initial value)

Numerical differentiation of the values in column C.

Bezier approximation based on the values in the column for the X-axis
and column C.

See Bezier(C). The factor n stands for the size of an interval.

5.3 Standard Functions

Bit
The Function Bit(n) returns On (True) if the digital input (n) is "High", and Off (False) if it
is "Low”. The numerical values On and Off correspond with 255 respectively 0.

Examples:
In an Assignment: State = Bit(1)
In a Conditional statement: If Bit(2) = On Then …
or shorter: If Bit(2) Then …

Counter and ResetCounters
The Standard Function Counter(n) returns the number of pulses that has been detected on
Counter input (n). All Counters are reset to 0 with the Standard Procedure ResetCounters.
Counters cannot be set individually to 0, so ResetCounters has no parameters.

Examples:
In an Assignment: State = Counter(1)
In a Conditional statement: If Counter(2) < 100 Then …

Interval
The Standard Function Interval returns the time (in seconds), which has lapsed after the
execution of the Standard Procedure Stopwatch( On ), and returns 0 after the execution of
Stopwatch( Off ).
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Example:
Stopwatch(On)
Repeat

…
Until Interval > 10

Level
The Standard Function Level(n) returns the value of the sensor which has been connected to
analog input (n). If the sensor is calibrated, the value will be expressed in the calibrated unit.

Examples:
In an Assignment: Brightness = Level(1)
In a Conditional statement: If Level(2) < 0,5  Then …

Latched
The Standard Function Latched(n) returns On (True), if the digital input (n) has been
"High" after the last call of Latched(n), otherwise it returns Off (False). The numerical
values of On and Off correspond with 255 respectively 0. Latched is the complement of the
Standard Function Unlatched

Examples:
In an Assignment: State = Latched(1)
In a Conditional statement: If Latched(2) = On Then …
or shorter: If Latched(2) Then …RunningTime

Unlatched
The Standard Function Unlatched(n) returns On (True) if the digital input (n) has been
"Low" after the last call of Unlatched(n), otherwise it returns Off (False). The numerical
values of On and Off correspond with 255 respectively 0. Unlatched is the complement of
the Standard Function Latched.

Examples:
In an Assignment: State = Unlatched(1)
In a Conditional statement: If Unlatched(2) = On Then …
or shorter: … If Unlatched(2) Then

RunningTime
The Standard Function RunningTime returns the time (in seconds) which has lapsed since
the start of the Program.

Examples:
Repeat
  …
Until RunningTime > 100

While RunningTime < 100 Do
   …
EndDo
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5.4 Standard Procedures

Count
The Standard Procedure Count(n;p) counts pulses via the counter input n. The Program
waits until the number of pulses (p) is reached. The maximal value of (p) is 65535. By
pressing any key (except <Esc>), the Program is forced to continue with the next Statement
even though the specified number of pulses has not yet been reached (this prevents the
Program from halting). <Esc> is reserved to interrupt Program execution.
The use of the Standard Procedure Count is analogous to the use of the Standard Procedure
Wait. Count counts pulses, Wait ‘counts’ time SaveData.

ClearData
The Procedure ClearData erases all data (in all Diagrams and Tables) in the current Coach
Activity. ClearData is the complement of the Standard Procedure SaveData.

Set
The Standard Procedure Set(i, j,..) sets the digital outputs i, j, .. to 'High'. The list of
parameters can be as long as the number of outputs of the interface. Set is the complement
of the Standard Procedure Reset.

Examples:
For an interface with four digital outputs is Set(1;2;3;4) allowed.
If no parameters are mentioned, Set sets all digital outputs to ‘High’. So, with four
outputs the command Set does the same as Set (1;2;3;4).

SetLevel
This procedure only works with CoachLab II and the LEGO DACTA interfaces.
The Standard Procedure SetLevel(i,p) sets the power level of the digital output i to p.
• When used with CoachLab II, i should be a number between 1 and 4, where 1

corresponds to output A, 2 to output B etc, and p should be a number between 1 and 16,
where 1 corresponds to the lowest power and 16 to the highest power level.

• When used with the LEGO DACTA Interface B, i should be a number between 1 and 8,
where 1 corresponds to output A, 2 to output B, … , 8 to output H, and p should be a
number between 1 and 8, where 1 corresponds to the lowest power and 8 to the highest
power level.

• When used with the LEGO DACTA RCX, i should be a number between 1 and 3 where
1 corresponds to output A, 2 to output B and 3 to output C, and p should be a number
between 1 and 8, where 1 corresponds to the lowest power and 8 to the highest power
level.

The highest power obtained with the SetLevel command is limited automatically by the
setting of the Power slider Range.
Higher values for p than the maximum value specified above do not lead to an error
message, they also invoke the maximum allowed power for the actuator.
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Reset
The Standard Procedure Reset(i, j, ..) sets the digital outputs i, j, .. to 'Low' and leaves the
state of the other outputs as they are.  The list of parameters can be as long as the number of
outputs of the interface. Reset is the complement of the Standard Procedure Set.

Examples:
For an interface with for example four digital outputs Reset(1;2;3;4) is allowed. If no
parameters are mentioned, Reset sets all digital outputs to ‘Low’. So, with four outputs
the command Reset does the same as Reset(1;2;3;4).

SetAbsolute
The Standard Procedure SetAbsolute(i, j, ..) sets the digital outputs i, j, .. to 'High' and all
others to ‘Low’. The list of parameters can be as long as the number of outputs of the
interface. SetAbsolute is the complement of the Standard Procedure ResetAbsolute.

Examples:
For an interface with for example four digital outputsSetAbsolute(1;2;3;4) is allowed.
If no parameters are mentioned, SetAbsolute sets all digital outputs to ‘High’. So, with
four outputs the command SetAbsolute does the same as SetAbsolute(1;2;3;4).

ResetAbsolute
The Standard Procedure ResetAbsolute(i, j, ..) sets the digital outputs i, j, .. to 'Low' and all
others to ‘High’. The list of parameters can be as long as the number of outputs of the
interface. ResetAbsolute is the complement of the Standard Procedure SetAbsolute

Examples:
For an interface with for example four digital outputs ResetAbsolute(1;2;3;4) is
allowed.
If no parameters are mentioned, ResetAbsolute sets all digital outputs to ‘Low’. So,
with four outputs the command ResetAbsolute does the same as
ResetAbsolute(1;2;3;4).

Sound
The Standard Procedure Sound(f;t) produces a sound with a frequency of f Hertz during t
seconds. The Standard Procedure Stop halts the execution of the Program at the position of
this Procedure.

Stop
Standard Procedure Stop halts the execution of the Program at the position of this Procedure.

Stopwatch
The Standard Procedure StopWatch(B) starts a time measurement (in seconds) if the
Boolean variable B has the value On (True). The elapsed time after start of the time
measurement, is recorded by the Standard Function Interval. Interval returns the value 0
immediately after the execution of StopWatch(On). The function Interval remains 0 after
the execution of Stopwatch(Off).
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Example:
Stopwatch(On)
Repeat

…
Until Interval > 10

SaveData
The Standard Procedure SaveData stores the values of variables which are present in
Diagrams or Tables. On each pass, the values of the variables will be written once. If
SaveData is not used or erroneously used, empty or wrong Diagrams and Tables will result.
SaveData is the complement of the Standard Procedure ClearData.
 
 Example: Measure during half an hour and only store the values if the temperature is higher
than 20°C:

 
Correct solution:
As long as the temperature is below 20 ºC, no values are written to the Diagram. (SaveData
is located inside the If statement which tests the temperature).

Repeat
 If Temperature > 20 Then

  Wait(1)
  SaveData
EndIf

Until RunningTime>1800

Incorrect solution:
Values are also written in the Diagram when the temperature is below 20 ºC. (SaveData is
located outside the If statement which tests the temperature).

Repeat
If Temperature > 20 Then
  Wait(1)
Endif
SaveData

Until RunningTime>1800

Use SaveData exclusively if the type of Activity in the Activity options is set to Control with
a Program. In other Activity types, data from Program variables is saved automatically.

Wait
The Standard Procedure Wait(t  pauses Program execution for t seconds. <Esc> interrupts
Program execution. By pressing any key (except <Esc>), the Program is forced to continue
with the next Statement even though the specified time has not yet been lapsed. <Esc> is
reserved to interrupt Program execution.
The use of the Standard Procedure Wait is analogous to the use of the Standard Procedure
Count. Wait pauses a time interval, while Count pauses until a specified number of pulses
has been detected.
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66..  EErrrroorr  mmeessssaaggeess  iinn  CCooaacchh  LLaanngguuaaggee
Two kinds of errors may occur:
• Syntax errors which are detected during the compilation of the model or program,

preceding the execution or preceding the selection of variables along the graph axes.
• Execution errors which are only detected while programs are executed.

6.1 Error messages during interpretation
If during interpretation an error is detected, the Program appears on the screen and an error
message pops up. The cursor flashes behind the position in the Program where the error has
been detected. The error may be corrected immediately.

Error message Cause

”Character not expected”

”Number not correct”

”This name is already in
use”

”Type conflict”

"... expected”

"... NOT expected”

”Too many variables”

”Function result not
assigned”

A character is placed where it is not expected to be.

The compiler fails to read a number.

Appears when two variables, functions or procedures have
identical names.

Occurs when a value has been assigned to the name of a
procedure, or when the function result has been assigned
outside the function definition.

The compiler expects a name or a symbol.

The compiler does not expect the symbol entered. Often
the cause is not immediately clear.

The available memory for names of variables has been
used. Solution: choose shorter names.

The function definition has not been closed with the
assignment: function_name := function_result

Example of a model with a syntax error

 t := t + dt

 If  t > 13 Then
 a := F/m
 Else
 a := F/(2 ∗ m)
 v := v + a ∗ dt

x := x + v ∗ dt

The cursor does not always flash at the exact position
where the error occurs. In the incorrect model
displayed at the left, the conclusion ('EndIf') of the 'If'-
statement fails to appear. The compiler does not detect
this syntax error until the last assignment.
The error message "EndIf expected" appears and the
cursor is placed behind the last character and not
behind the assignment "a := F/(2 ∗ m)".
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Examples of syntax errors and corresponding error messages

Program Error message

a : 1
a 1
a := / 1
a := 1e=12
If a>0 Then
  a:=1e12
Repeat a:=1e12
Redo a := 1e12
Redo a 1e12
Function a(x;y)
EndFunction

”Character not expected”
"Assignment" expected
"/" not expected
”Number is not correct”

"EndIf expected”
"Until expected”
"Assignment not expected”
"Number not expected”
"EndFunction not expected”

Function a(x;y)
  z=x∗y
EndFunction ”Function result not assigned”
Function a(x;y)
  a=x∗y
EndFunction
Procedure a(e)
  w = sqrt(e)
EndProcedure

”This name is already in use”

Function a(x;y)
  a=x∗y
EndFunction
a = 12 ”Type conflict”
Procedure a(x;y)
  z = x+y
EndProcedure
s = a(1;2)
a(1;2;3)
a(1)

”Type conflict”
”")" expected”
”";" expected”

Procedure b
  b = 12
EndProcedure

”"=" not expected”
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6.2 Error message while executing a Program and a Model
When a Program or Model has been developed, there is no guarantee that errors will not
occur during the execution. If such an error occurs, the Program/Model is halted and a
message appears on the screen. Possible execution errors and corresponding causes:

Error message Cause

”Division by zero”

“Number out of range” or
“Value not in the domain”

A variable in the denominator of a fraction has become 0.
A number becomes too large or too small.

The argument of a standard function receives a value
which is not allowed.

Example: A program, which returns error messages when executed.

Program Error messages

a := 100  w := 100
Redo 100
  a := a - 1
  y := 12/a
  y := ln(a)
  w := w∗w
EndRedo

“Division by 0 (in the last loop (when a=0))”
“Value not in the domain (in the last loop (when a=0))”
“Number out of range (in the 6th loop)”
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11..  IInnttrroodduuccttiioonn
Processing and Analysis are used to investigate data in Diagrams and Tables in depth. The
options in the Processing submenu and Analysis submenu of a Diagram all work in a similar
way. An extensive dialog with the Diagram is shown. Below the Diagram the option for the
specific operation can be set. Often the result can be viewed before deciding to further use
the processed data.
The small Copy button in the upper right corner of the Dialog (title bar) can be used to copy
the dialog to the Clipboard.
The small Print button in the upper right corner of the Dialog (title bar) can be used to print
the dialog.

Note: Statistics is available in the options of Table menu.

22..  SSeelleecctt//RReemmoovvee  ddaattaa  iinn  aa  DDiiaaggrraamm
With the option Process>Select/Remove data in the Diagram Tool menu, both a range of
data (Range) or single points (Point-by-point) can be selected for removal (or retention)
from the Diagram. The selected rows will be removed from all Diagrams/Tables.

To open the Select/Remove data dialog

• Right click in the Diagram window or click the Tool button.
• Select Process > Select/Remove data.

In the Select/Remove-data dialog, the selected graph is blue and zoomed-to-fit. The other
visible graphs in the Diagram (if any) will be gray. The boundary lines of the selected range
and the selected points are dark red. The following options are available:

Selection method
To select either Range (default) or Point-by-point.

Show Grid
To switch the Grid in the Diagram On (default) or Off.

Column
To switch between graphs if the Diagram contains several graphs. The selected graph is
shown in the Diagram. Invisible Data ranges can not be selected.

Figure 76. Analysis submenu.Figure 77. Processing submenu.
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Data Boxes (in the middle of the Bottom section)
When Selection method = Range, the boxes display the Begin and End point of the selected
interval along the x-axis. You can also type values for the boundary points. When the
original Diagram was zoomed in, the values are pre-selected corresponding to the
boundaries of the zoomed Diagram.
When Selection method = Point-by-point, the boxes display the coordinates (x-Quantity,
y-Quantity) of the selected point.

Keep selected
All non-selected points will be removed.

Remove selected
All selected points will be removed.

To select/remove a range

• Open the Select/Remove-data dialog.
• Set Selection method to Range (the default). If you came from a zoomed Diagram, the

boundary lines are set corresponding to the zoom interval along the x-axis.
• Under Column select the graph you want to select the points from.
• Select the range by dragging the boundary lines, or type the boundary values in the

boxes below the Diagram.
• Select between Keep selected or Delete selected.
• Click OK to confirm or Cancel to close the Select/Remove-data dialog without changes.

To select/remove single points

• Open the Select/Remove-data dialog.

Figure 78. Select Remove Data dialog window. Selecting data point-by-point.
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• Set Selection method to Point-by-Point.
• Under Column select the graph you want to select the points from.
• Select points on the graph by clicking them. Use the cursor keys to walk from point to

point. Click a selected point to deselect it.
• Select between Keep selected or Delete selected.
• Click OK to confirm or Cancel to close the Select/Remove-data dialog without changes.

- Via the option Undo (<Ctrl+Z>) in the corresponding Table it is possible to undo this
action. The Undo buffer only stores one action, so do not wait too long!

- Single points can also be removed via Tables.

Note: The rows will be removed from all Diagrams and Tables in the Activity.

33..  SSmmooootthh  ggrraapphh
The option Process>Smooth graph in the Diagram Tool menu is used to approximate a
smooth graph through a coarse or limited set of measured points. This option offers two
methods of Polynomial approximations: Bezier and Spline. The smoothed graph consists of
(much) more points than the original one and can successively be processed.

To open the Smooth-graph dialog

• Right click in the Diagram window or click the Tool button.
• Select Process > Smooth graph.

In the Smooth-graph dialog, the selected graph is blue and zoomed-to-fit. The other visible
graphs in the Diagram (if any) will be gray. The smoothed graph is dark red.
The following options are available:

Function type
To select type of smooth function: Bezier (default) or Spline. Bezier and Spline are two
different methods of polynomial approximation.

Show Grid
To switch the Grid in the Diagram On (default) or Off.

Column
To switch between graphs if the Diagram contains several graphs. The selected graph is
shown in the Diagram. Invisible Data ranges can not be selected.

Interval (Spline only)
When Interval = 0, the smoothed Spline function is forced through all data points. With
higher settings, this restriction is released (see Example further).

Number of points
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The number of points of which the smoothed graph will consist. The default value is 500,
the maximum 16380. This setting does not influence the shape of the resulting smoothed
graph.

Start
Press Start to smooth the graph with the specified settings and evaluate the effect of the
smoothing. The smoothed graph appears in the Diagram in dark red. If necessary, change
parameter settings and press Start again.

Replace data
For Smooth graph, this setting can not be changed: the smoothed data always replace the
original data. (So save your Result first if you do not want to lose it).

To execute Bezier-approximation
With a Bezier approximation, a curve is created, which at least contains the first and the last
of the original points. The shape of the calculated graph depends on the position of all the
intermediate points. It tends to the original graph but will generally not contain the original
points. For a Bezier approximation, the number of points in the graph must be less than 100
and all values of the quantity along the x-axis must be in ascending order.
You can reduce the number of points in a graph by selecting Processing > Select/Remove
data or by deleting rows from a Table. The number of points after the Bezier approximation
can be as high as 16380.
• Open the Smooth-graph dialog.
• Set Function type to Bezier (the default).
• Under Column select the graph of which you want to view the smooth operation.
• Enter the desired number of points for the approximated graph.
• Click Start to show the approximation. The result can be evaluated in the Diagram. If

you are not satisfied with the result, change settings and press Start again.
• Click OK to add the approximation to the Diagram or Cancel to close the Smooth-graph

dialog without changes.

Example:
The Bezier-approximation is forced through the first
and the last original point. The intermediate points
determine the degree of curvature of the graph.

To execute Spline approximation
The option Spline smoothes a curve by means of a
least mean-square method. All values of the quantity along the x-axis must be in ascending
order. The local shape of the new curve depends on the position of the points in the direct
neighborhood. The measure of approximation is influenced by the parameter Interval. For
Interval=0, a curve will be obtained which goes through all the original points. The higher
the value of Interval becomes, the more the new graph will tend towards a straight line.
This, however, depends strongly on the distribution and number of points in the original
graph. The number of points after the Spline approximation can be as high as 16380.
• Open the Smooth-graph dialog.
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• Set Function type to Spline.
• Under Column select the graph of which you want to view the smooth operation.
• Enter the desired Interval.
• Enter the desired number of points for the approximated graph.
• Click Start to show the approximation. The result can be evaluated in the Diagram. If

you are not satisfied with the result, change settings and press Start again.
• Click OK to replace the graph with the approximation or Cancel to close the Smooth-

graph dialog without changes.

A smoothed graph can also be manually added to a Diagram/Table with the Formulas
Bezier(Column) or Spline(Column;  Interval). In that case, the smoothed graph consists
of the same number of data points as the source graph.

Example:
Left:
Interval = 0, the
approximated
curve is forced
through all
original points.
Right:
Interval = 1, the curve will not be forced through all original points.
The larger the interval, the smaller the number of original points which fit the original curve,
through which the approximated graph will be forced.
Very large values of the parameter 'interval' will lead to a straight line through the first and
last point.

Figure 79. Smooth dialog window. Spline approximation of data collected in
the Boyle experiment.



GGUUIIDDEE  TTOO  CCOOAACCHH  --  115599

44..  FFiilltteerr  ggrraapphh
Filtering is used to reduce random noise in the graph. The result is a smoother graph
(consisting of the same number of points). Each point of the graph is replaced by the average
value of a range of neighbouring points. The parameter 'interval' determines how many
points will be used to calculate the difference. When Interval is set to n, each point is
replaced by the average of itself, its n predecessors, and its n successors (i.e. the filter range
is 2n+1 points). Filtering applied prior to taking the derivative leads to a far less noisy
derivative graph.

To open the Filter-graph dialog

• Right click in the Diagram window or click the Tool button.
• Select Process > Filter graph.

In the Filter Graph dialog, the selected graph is blue and zoomed-to-fit. The other visible
graphs in the Diagram (if any) will be grey. The smoothed graph is dark red.
The following options are available:

Show Grid
To switch the Grid in the Diagram On (default) or Off.

Column
To switch between graphs if the Diagram contains several graphs. The selected graph is
shown in the Diagram. Invisible Data ranges can not be selected.

Interval
The Interval determines the filter range. By default Interval  =  1 (see Example further).

Quantity
The suggested quantity for the filtered graph (the unit stays the same and cannot be
changed). You can enter any new quantity name. However, quantity names which are used
already in the Diagram are not allowed.

Start
Press Start to filter the graph with the set parameters and evaluate the effect of the filtering.
The filtered graph appears in the Diagram in dark red. If necessary, change settings and
press Start again until a suitable filtering is obtained.

Add graph
The filtered graph will be added as a formula (in the first empty Data range) to the graphs in
the Diagram.

Replace graph
The filtered graph will replace the original data in the Diagram (in the same Data range).
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New Diagram
The filtered graph will be added as a formula (in the first empty Data range) to the graphs in
a new Diagram. The original data are made invisible.

To filter graph

• Under Column select the graph to which you want to apply the filter operation.
• Enter the desired Interval.
• Click Start to show the filtered graph. The result can be evaluated in the Diagram. If

you are not satisfied with the result, change parameter settings and press Start again.
- If Interval is set low, the filtered graph may be hardly visible (as it falls together

with the original graph), or not enough noise may be filtered out.
- If Interval is set too high, there is a risk that significant details of the original data

are filtered out (especially near maxima or minima). This can be seen directly in the
Filter Diagram.

- What high and low Interval values are for a particular graph depends on the total
number of points in the graph.

• If desired, change the name of the Quantity.
• Choose between Add graph, Replace graph or New Diagram.

When you choose to replace the graph, the original data will be lost unless you saved the
Result prior to the Filter operation.

• Click OK to confirm or Cancel to close the Filter-graph dialog without changes.

- If Interval is set too high, there is a risk that significant details of the data are filtered
out.

Figure 80. Filter Graph dialog window.
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- A better result may be obtained by filtering two (or three) times with Interval=2 than
one time with Interval=5. When filtering several times, do not forget to select the last
Filtered graph under Column.

- A Filtered graph can also be manually added to a Diagram/Table with the Formulas
Filter(Column,Interval).

- Spikes (single points lying clearly outside the curve determined by the other points) can
be removed by changing/deleting the value in the Table cell. It works best in
combination with Scan to pinpoint the spike in the Diagram.

Notes:

- Only an even (equidistant) distribution of the sample points yields a reliable result of the filtering
process.

- At the borders, where not enough predecessors or successors are available, the values are
'mirrorred' at the border.

Example: filter the series of values: {1,  2,  3,  4,  5,  6,  7,  8,  9} with Interval=2.

- Mirror at the first border (mirrored values not bold), such that enough values are available to
calculate the complete filtered series: {3,  2,  1,  2,  3,  4,  5,  6,  7,  8,  9}. The value 1 is
replaced by the average of {3,  2,  1,  2,  3} (2 mirrored values required); the value 2 is replaced
by the average of {2,  1,  2,  3,  4} (1 mirrored value required); the value 3 can be filtered
completely within the original series of values, etc..

Example:
The interval size determines the degree of filtering.

Original graph Interval = 1 Interval = 2

Play a bit with the Interval-setting to obtain a suitable result: a graph with less noise, which
still closely follows the shape of the original graph.

Original graph Interval = 1 Interval = 10
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55..  DDeerriivvaattiivvee
Derivatives are a measure of the rate of change of a quantity. They are used much in science
to calculate among others the speed of processes. Use the option Derivative to produce the
derivative graph of the original graph.
The derivative function is calculated via a formula (using a difference of successive values
from C2 divided by the difference of the corresponding values in C1 (differential quotient).
Especially when data sets are used with few points (say up to 20), e.g. from a Manually-
triggered measurement or a Data-Video measurement, a boundary effect may become
noticeable.

To open the Derivative dialog

• Right click in the Diagram window or click the Tool button.
• Select Process > Derivative.

In the Derivative dialog, the selected graph is blue and zoomed-to-fit. The other visible
graphs in the Diagram (if any) will be grey. The derivative graph is dark red. The following
options are available in this window:

Show Grid
To switch the Grid in the Diagram On (default) or Off.

Column
To switch between graphs if the Diagram contains several graphs. The selected graph is
shown in the Diagram. Invisible Data ranges can not be selected.

Quantity & Unit
These fields suggest the quantity and unit of the derivative graph. In case the derived
quantity or unit has another more usual name, you can enter these. However, quantity names
which are used already in the Diagram are not allowed.

Start
Press Start to calculate the derivative graph with the specified settings and evaluate the
quality of the derivative. The derivative graph appears in the Diagram in dark red with its
scale along the second horizontal axis. If the result is too noisy, it is best to Filter the
original graph first one or two times. (see Example further)

Add graph
The filtered graph will be added as a formula (in the first empty Data range) to the graphs in
the Diagram. Both the original graph and its derivative are displayed.

New Diagram
A new Diagram will be created with the original data in Data ranges C1 and C2 (C2
automatically made 'Invisible'), together with the derivative graph in C3 (as a formula).
After pressing OK, the cursor changes shape (Diagram) and the Diagram can be placed by
clicking in a window. Or place it later.
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To calculate a derivative graph

• Under Column select the graph of which you want to calculate the derivative.
• When desired, edit the Quantity and Unit.
• Click Start to calculate the Derivative graph.

If the result is too noisy, press Cancel and first filter the data one or two times.
• Select either Add graph or New Diagram.
• Click OK to confirm or Cancel to close the Derivative dialog without changes.
• To determine a second derivative repeat the above steps and select under Column the

graph of the first derivative.

- The derivative is added to the Diagram as a formula, which will be evaluated in real
time! So on a next measurement run the original data will be measured and its derivative
will be calculated and displayed in real time. This is useful for measuring in real-time
Position-time, Velocity-time (first derivative) and Acceleration-time (second derivative)
graphs while actually only the position is measured (e.g. with an ultrasonic sensor).

- Noise in the original graph (also noise resulting from the digital measurement process)
can cause major variations in the derivative. See the examples. We recommend filtering
the original graph first.

- A small (sudden) variation in the original graph can cause a wide variation in the
derivative. The minimum and/or maximum scale value of the y-axis may change
drastically. Therefore the derivative graph is placed along the second horizontal axis and
both the original as the derivative are displayed optimally because of the independent
scales.

Figure 81. Derivative dialog window. The original position(time) graph and its
derivative.
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- A Derivative graph can also be manually added to a Diagram/Table with the Formulas
Derivative(Column), or Deltafil(Column)/Delta(time) (derivative including automatic
filtering).

- To calculate the derivative graph of a data set with few points a special formula is
available which first approximates ('inflates') the graph to 1000 points (like the Smooth-
graph option) after which the derivative is calculated and the result is 'deflated' to the
original number of points. You have to add this formula to the Diagram/Table yourself.

Note: To calculate the graph of a data set consisting of less than 200 points (e.g. resulting from
Manually-triggered measurements or Data-Video measurements), a different formula is used,
which gives more reliable results.

Example:
Graph A:
The original graph contains hardly visible noise (random fluctuations: meaning that the
direction of the curve (i.e. its slope) repeatedly varies in random directions). Because of this
noise, the derivative graph is much noisier (the noise is amplified in the derivative graph).
For a solution see graph B.
Graph B:
Prior to the derivative operation, the original graph was filtered (with Interval = 10). Now
the derivative graph shows much less noise. Sometimes two successive filterings with a
rather small Interval value may lead to an even better result.

66..  IInntteeggrraall
Use the processing option Integral to calculate the function (the primitive function) whose
derivative is equal to the displayed graph. Such an Integral function can be determined but
for a constant, the constant of Integration. The integral function is also called the 'primitive'
or the 'anti-derivative'.

To open the Integral dialog

• Right click in the Diagram window or click the Tool button.
• Select Process > Integral.
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In the Integral dialog, the selected graph is blue and zoomed-to-fit. The other visible graphs
in the Diagram (if any) will be grey. The Integral graph is dark red. The following options
are available in this window:

Show Grid
To switch the Grid in the Diagram On (default) or Off.

Column
To switch between graphs if the Diagram contains several graphs. The selected graph is
shown in the Diagram. Invisible Data ranges can not be selected.

Constant of Integration
An Integral function is determined but for a constant. The constant of Integration can be
typed here. The Constant of Integration is the value assigned to the quantity along the Y-axis
for X=0.

Quantity & Unit
These fields suggest the quantity and unit of the integral graph. In case the derived quantity
or unit has another more usual name, you can enter these. However, quantity names which
are used already in the Diagram are not allowed.

Start
Press Start to calculate the Integral graph with the specified settings and evaluate the quality
of the integral. The Integral graph appears in the Diagram in dark red with its scale along the
second horizontal axis. If necessary, change settings and press Start again until a
satisfactory result is obtained.

Add graph
The Integral graph will be added as a formula (in the first empty Data range) to the graphs in
the Diagram. Both the original graph and its integral are displayed.

New Diagram
A new Diagram will be created with the original data in Data ranges C1 and C2 (C2
automatically made 'Invisible'), together with the Integral graph in C3 (as a formula). After
pressing OK, the cursor changes shape (Diagram) and the Diagram can be placed by
clicking in a window. Or place it later.

To calculate an Integral graph

• Under Column select the graph of which you want to calculate the integral.
• When desired, change the name of the Quantity and/or Unit. The derived quantity and

unit can often be replaced by a more usual name.
• Click Start to calculate the Integral graph.
• Select either Add graph or New Diagram.
• Click OK to confirm or Cancel to close the Integral dialog without changes.
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- The Integral graph is added to the Diagram as a formula which will be evaluated in real
time! So on a next measurement run, the original data will be measured and its integral
function will be calculated and displayed in real time!

- The scale range of the Integral may change drastically compared to the source function.
Therefore the integral graph is placed along the second horizontal axis and both the
original as the derivative are displayed optimally because of the independent scales.

- The integral graph can also be manually added to a Diagram/Table with the Formula
Integral(Column).

77..  SSllooppee
Use 'Slope' to manually determine the slope of the tangent in any point of a displayed graph.

To open the Slope dialog

• Right click in the Diagram window or click the Tool button.
• Select Analyse > Slope to open the Slope dialog.

In the Slope dialog, the selected graph is blue and zoomed-to-fit. The other visible graphs in
the Diagram (if any) will be grey. The cross-hairs for point selection and the tangent line is
dark red. At the bottom of the dialog, help about the next action is displayed.
The following options are available in this window:

Show Grid
To switch the Grid in the Diagram On (default) or Off.

Figure 82. The original graph (left y-axis) and its integrated graph (right y-axis).
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Column
To switch between graphs if the Diagram contains several graphs. The selected graph is
shown in the Diagram. Invisible Data ranges can not be selected.

Data boxes
These fields display the coordinates (x-Quantity, y-Quantity) of the selected point.

Slope
The actual value of the slope of the tangent drawn in the Diagram. This field only appears
after a point has been selected.

To determine a slope

• Under Column select the graph in which you want to determine a slope.
• The Diagram in the dialog is in Scan mode. The coordinates of the scanned point,

indicated by the
dark red cross-
hairs, are displayed
in the boxes below
the graph.

• Click the point in
which you want to
determine the slope
of the tangent line.
A line appears in
the Diagram and a
Slope box appears
below the graph.

• Press <Ctrl> and
drag the mouse
horizontally to
rotate the line until
it is positioned
correctly along the graph. The only way to determine the slope is by vision; Coach does
not indicate what slope is ‘correct’.

• Read the value of the slope in the box below the Diagram.
• Click Close to return to the regular Coach screen.

- To have a calculated value for the slopes in all points of the graph, add the derivative
graph to the Diagram and Scan this graph.

- If you want to determine the slope in another point of the graph, repeat the above
procedure.

Important: You have to write down the value of the slope when you want to store it, or type
it in a Notes window. It is not possible in Coach to transport the Slope values.

Figure 83. Determining the slope in a point.
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88..  AArreeaa
Use 'Area' to determine an area between a displayed graph, the x-axis and two boundary
lines.

To open the Area dialog

• Right click in the Diagram window or click the Tool button.
• Select Analyse > Area.

In the Area dialog, the selected graph is blue and zoomed-to-fit. The other visible graphs in
the Diagram (if any) will be grey. The Area is colored dark red. At the bottom line of the
dialog, help about the next action is displayed. The following options are available in this
window:

Show Grid
To switch the Grid in the Diagram On (default) or Off.

Column
To switch between graphs if the Diagram contains several graphs. The selected graph is
shown in the Diagram. Invisible Data ranges can not be selected.

Begin & End
These fields display the x-coordinates of the boundary lines. It is possible to type values
here. When the original Diagram was zoomed in, the values are pre-selected corresponding
to the boundaries of the zoomed Diagram.

Area
The actual value of the area enclosed between the boundary lines, the function and the x-
axis in the Diagram. An area below the x-axis has a negative value.

To determine an area

• Under Column select the graph from which you want to an area.
• The Diagram shows two boundary lines between which the area is calculated. Drag the

boundary lines to the required position, or type the x-values for the boundary lines in the
boxes Begin and End.

• Read the area displayed in the Area box.
• Repeat the procedure to determine another area (if desired below another graph in the

Diagram by selecting it under Column).
• Click Close to return to the regular Coach screen.

- To obtain a calculated value for the areas in all points of the graph, add the Integral
graph (with the right constant of integration) to the Diagram and Scan this graph.

- If you want to determine another area below the graph, repeat the above procedure.
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Important: You have to write down the value of the area when you want to store it, or type
it in a Notes window. It is not possible in Coach to transport the Area value.

88..  FFuunnccttiioonn--ffiitt
Function-fit is a procedure to approximate the data on the screen with a standard
mathematical function. You can choose from a number of basic function types (see below).
The coefficients of the fit function are determined using a least-squares method.
Fitting can be done manually or automatically (Auto-fit). The manual and automatic
processes can be mixed: starting with a manual fit, one can always press Auto-fit to start
automatic fitting from that point onward.

To open the Function-fit dialog

• Right click in the Diagram window or click the Tool button.
• Select Analyse > Function-fit.

In the Function-fit dialog, the selected graph is blue and zoomed-to-fit. The other visible
graphs in the Diagram (if any) will be gray. The fit function is colored dark red. At the
bottom of the dialog box an explanation is given about what action is possible. The
following options are available in this window:

Function Type
Select the standard function to which the data should be fitted. This choice requires some
knowledge about the phenomenon, which yielded the data.

Figure 84. Determining Area under the graph.
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Show Grid
To switch the Grid in the Diagram On (default) or Off.

Column
To switch between graphs if the Diagram contains several graphs. The selected graph is
shown in the Diagram. Invisible Data ranges can not be selected.

Coefficients
These fields indicate the value of the coefficients (a, b, c and d) used in the fit function.
Depending on the function type there are one to three coefficients.

Auto fit
Press Auto fit to automatically calculate the best fit function starting from the current
coefficients. The fit function appears in the Diagram in dark red with its scale along the
second horizontal axis.
When desired, change settings and repeat the fit process until a suitable fit is obtained.

St. Deviation
Number indicating the standard deviation of the fitted function from the original data. The
lower the deviation, the better the quality.

Add graph
The fit function will be added as a Formula in the first empty Data range to the graph(s) in
the Diagram.

Replace graph
The fit function (as a Formula) will replace the original data in the Diagram (in the same
Data range).

Figure 85. Function-fit dialog window.
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To determine a Function-fit

• Under Column select the graph which you want to fit.
• Select the Function type which will be used.
• There are two methods for the Function-fit which complement each other and can be

used in any order:
1. Manual fit: to find the coefficients of a fit function by shifting and stretching it. This

can be started any time during the fit process. See below for the Manual fit
procedure.

2. Auto Fit: to find the coefficients of a function automatically. The calculation process
stops when the standard deviation remains stable. You can interrupt the fit process
with <Esc>. (Keep <Esc> pressed until the fit process stops. This may take a short
while).
- For some functions (like the exponential and goniometric types), it is useful to

start with a manual fit (to get a better estimate of the coefficients) and then press
Auto fit.

- When the standard deviation stays about the same value (and is not much smaller
than 1) or follows a certain repeating pattern, then the fit-function is locked in a
shallow part of the parameter space and a better fit function will not be found,
although a better fit may exist. Hold <Esc> to interrupt the automatic fit process
and switch to Manual fit.

• Select Add graph or Replace graph.
When you choose to replace the graph, the original data will be lost unless you saved the
Result prior to the Fit procedure.

• Click OK to confirm, or Cancel to close the Function-fit dialog without changes.

Manual Function-fit
Manual Function-fit is used e.g. when the graph consists of a repeating pattern of
exponential functions (you can try to fit the exponential fit function to one of the exponential
parts of the graph), or to help an automatic fit get going.
To obtain a reasonable result with manual function-fit, it is often necessary to go a few times
through a cycle of steps.
On the fit function, one point is marked with a pin, which can be moved along the fit
function by dragging it. The pin can be opened or closed (by clicking on it). When the pin is
opened, the fit function can be shifted, when the pin is closed the fit function can be shaped.
• Select a point on the original graph by shifting the opened pin along the fit-function. If

you can not find a suitable point continue with the next step.
• Shift the fit function itself by dragging with the mouse somewhere on the line (mouse

cursor is a hand).
• Click the pin to 'close' it, i.e. to fix the fit curve at the pinpoint.
• Shape of the fit-function by dragging a point of the curve towards the pin or away from

the pin. Dragging past the pin reverses some parameter values of the fit-function.
• Repeat the above steps until a satisfying result is obtained. Check if the coefficients have

real values. If this is not the case, type other values.
• When desired, press Auto fit to finalize the fit process.
• Select Add graph or Replace graph.
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When you choose to replace the graph, the original data will be lost unless you saved the
Result prior to the Filter operation.

• Click OK to confirm, or Cancel to close the Function-fit dialog without changes.

Using the fit-function type f(x)=a.x, the pin stays fixed in the origin. In fact, this function
can only be rotated.

99..  SSiiggnnaall  AAnnaallyyssiiss
Signal Analysis can display the frequency spectrum of the displayed graph (a signal).
It is most useful to use it to find the frequency components of periodic signals.
You can choose between to methods: Fourier Transform (FT) or Linear Prediction (LP).
Both methods differ fundamentally. The strengths of the two methods complement each
other, so it is advantageous to have both available.

Fourier Transform (FT)
With the Fourier Transform (FT), a periodic signal is decomposed into frequency
components. The basic assumption of the Fourier transform is that any oscillation can be
represented as a superposition of sinusoidal components. The spectrum is a graph of the
amplitudes (intensity) of the sinusoidal components against their frequency.
The Fast Fourier Transform (FFT) is a numerical method which is developed to rapidly
calculate the components of the spectrum. The method requires a set of 2N data points and
the number of points in the spectrum is half the number of original sample points.
This may be a major limitation in some cases: e.g. when precise determination of
frequencies is required from a small number of data points.

Advantages of FT
• Faster than LP, especially when the

oscillation consists of pure tones;
• Excellent at determining intensities in the

spectrum.

Weaknesses of FT
• Poor frequency resolution when few data

points are available.

Linear Prediction (LP)
Linear Prediction (LP) is an appropriate analysis method for the sound vibrations of the
human voice. It is based on the principle that each data point of an oscillation can be
predicted from a function of previously measured points. The value of a measured point is
approximated by the value of a function. The accuracy of the approximation depends upon
the number of coefficients and the accuracy with which these are deter mined.
Compared to the Fourier Transform, Linear Prediction always produces a convoluting curve
(a function of frequency) of the characteristic frequency areas of the spectrum (the so-called
Formants). This results in a greater frequency resolution when few data points are available.
The user is able to choose the accuracy of the calculation by specifying the number of
coefficients in the calculation. This number determines the number of characteristic peaks
that is searched for: the number of peaks will be at most half the number of assigned
coefficients (sometimes including peaks at the borders).
Naturally, increased accuracy comes at the expense of higher execution time.
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The physical relevance of the resulting spectrum peaks has to be assessed critically.

Advantages of LP
• Very good frequency resolution, even if

there are few data points;
• By using lower quality for the

coefficients, the envelope of the
spectrum (i.e. formants) can be gained.
This is useful for deter min ing resonant
frequencies for example.

Weaknesses of LP
• The more accurate the frequencies are

determined, the less accurate are the
intensities;

• Poor settings may lead to a spectrum
which lacks the import ant details;

• Slower than FT.

When to use FT or LP?
The main differences in using FT and LP concern the settings. LP offers more choices than
FT. LP allows you to choose the number of coefficients and thereby the accuracy of the
spectrum: the choice to see the general outline of the spectrum (few coefficients), or fine
detail (many coefficients), the amount of which increases with the number of coefficients.
Unfortunately the details can become too fine to be displayed, and so the limitation of LP is
that there is a risk that the most important details are missed. Unless you already know what
the spectrum will look like, it is sensible to use FT for a first calculation (to see where the
main frequency components are located) and then use LP to find the precise frequencies.
Above the strengths and weaknesses of the two methods are summarized.

To open the Signal Analysis dialog

• Right click in the Diagram window or click the Tool button.
• Select Analyse > Signal analysis.

The Signal-analysis dialog is empty until you press the Start button. Then the spectrum is
drawn in dark red. The following options are available in this dialog:

Function Type
Choose between Fourier Transform or Linear Prediction.

Column
To switch between graphs if the Diagram contains several graphs. The selected graph is
shown in the Diagram. Invisible Data ranges can not be selected.

Coefficients (LP only)
The number of coefficients determines the maximum number of peaks (formants) which will
be found by LP.

Scale
Choose between a linear or a logarithmic y-axis scale.
A linear scale gives a good overview of the size of different signals compared to each other.
A logarithmic scale, however, gives more information about how the sound signal will be
perceived by the human ear, as the human sense of hearing has a logarithmic character.
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Start
Press Start to calculate the spectrum with the specified settings. The spectrum appears in the
Diagram in dark red.

New Diagram
For Function-fit, this setting can not be changed: the only way to use the fit function in
Coach is as a new Diagram.

To determine a frequency spectrum

• In the Function type field select Fourier transform or Linear prediction
• Select Linear or Logarithmic for the intensity scale along the y-axis.
• Linear Prediction only: enter the number of coefficients (see above).
• Click Start to display the frequency spectrum of the graph.

Y-axis: For a linear scale, the highest intensity has the value 1. For a logarithmic
scale, 0 dB corresponds to 1 mV.
X-axis: The x-axis (the frequency-axis), runs from 0 Hz to a frequency which equals
half the sample frequency. The frequency 0 Hz is used to display the intensity of the
direct current (dc) component of the measured signal.

• Click OK to prepare a new Diagram of the spectrum and click in a window to place the
graph (or place the graph later). Or click Cancel to close the Signal Analysis dialog
without changes.

- If the signal contains frequency components, which are higher than half the sample
frequency, then these samples can affect the displayed spectrum considerably.

- For a successful use of FT or LP, we recommend to choose a measuring time of less
than 200ms.

- When applying LP to human voice signals it is not recommended to set the number of
coefficients higher than 14, because the expected number of characteristic formants is at
most 6.

- The spectrum is normalized, i.e. the area below the graph is always set to a fixed number
(presumably 1). If the original signal data does not have an average value of 0, then there
is a so-called d.c. (direct current) frequency component. This component may take so
much of the fixed area of the total spectrum that a lot of detail in the remainder of the
spectrum may be lost. First create a shifted set of original data (by subtracting/adding a
suitable number via a formula). Shift until the average value of the data is zero (the
average value of a data set can be calculated via the option Statistics in a Table). Then
the d.c. component will be zero as well, and all the 'energy' in the spectrum will be
available for the frequency components.

- When analysing musical tones (from instruments, or sung), the first frequency
component in the spectrum is called the 'fundamental'. The higher frequency components
(which are exact multiples of the fundamental frequency in pure tones), are called the
'harmonics'. A.o the mixture and intensity ratio of the harmonics determine the timbre of
the tone.

- Coupling between time units and frequency units. (s à Hz; ms à kHz)
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Notes:

- It is possible that very sharp peaks in the source function are not displayed on the screen.

- When the number of coefficients in LP is set very high, the spectrum approaches the Fourier
spectrum.

Example: Signal Analysis

Figure 86. Amplitude/time diagram of "u" in "cut" (left) and Linear FT-spectrum (middle) and LP-spectrum
of the "u" (right).

Figure 87. Amplitude/time diagram of "a" in "ape", basic frequency 140 Hz (left). Linear FT-spectrum
(middle) and LP-spectrum (right) of the "a". Note that the formants are badly recognized with FT.
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1100..  SSttaattiissttiiccss
The Table option Statistics displays statistical
information about the Table as a whole or about a
selection of data in the Table. For each Data range
(in the selection), the following items are shown:
- Number: Number of rows
- Max: Maximum value
- Min: Minimum value
- Average: Average value
- Sum: Sum of the values
- Sum sqr: Sum of squared values
- s(n): Standard deviation based on n values
- s(n-1): Standard deviation based on n-1 values

To display Table Statistics
• Right click in the Table window, or press the Tool button. When only a single cell is

selected information for the whole Table is displayed.
Drag a selection (e.g. a whole column, a number of rows) to get statistical information
about the selection.

• Select: Statistics.
In the Statistics box:
• Press Print to print the Statistics box.
• Press Copy to copy the statistical information to the Clipboard for use in other

Windows applications (e.g. MS-Word, useful for reports).

Figure 88. Statistics window.
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11..  CCooaacchh  aass  AAuutthhoorriinngg  eennvviirroonnmmeenntt
Coach has also Author features with which teachers or other curriculum developers (in
Coach called 'Authors') can develop and manage Coach applications for students.

Projects and Activities
A Coach application consists of a Project filled with Activities. As an Author you are able to
create, edit and manage Projects and Activities for your students.
In the Activities, students do measurements, analyze measurements, make Control
Programs, etc. etc. To facilitate easy use, Coach has an extensive Library with Sensor
definitions, Actuator definitions and Panel definitions, but manual calibration is also
possible.
An Activity can contain measurement data in various forms (Diagrams, Tables, Meters and
Values), multimedia elements like Texts, Pictures, Videos, references to Web-pages and/or
student Notes, Models and Control Programs.

Tools for organization
Special Authors tools help to organize Projects, Activities and the Library with Sensor and
Actuator definitions.
Use Project manager to copied or delete Projects, Activities in an intelligent way.
Use the Profile editor to bundle Projects into self-defined User-profiles. Each Profile is
started with a login name, (optionally) a password and a number of other settings.

Help
Coach has two Help systems:
- Student Help system, accessible to all users. This Help system (also called 'Coach Help')

describes all user possibilities of Coach.
- Author Help system only accessible to Authors. This system describes only the specific

Author tools of Coach.

22..  UUsseerr  mmooddeess
Coach has three User types:
- The Junior Student:

each Activity opens with
limited possibilities in its
Junior profile: Fixed,
Flexible or Own  Lab;

- The Senior Student:
each Activity opens with
all advanced Student
possibilities;

- The Author: Coach
opens with authoring
facilities.
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2.1 User possibilities in the different user modes

User
type Allowed Not allowed

Junior
Student

Fixed
mode

- To measure (in a measurement
Activity)

- To write a Program via Instruction
buttons or with the Command list

- To run and edit a Program (in an
Activity 'With a Program')

- To Scan a Diagram, Zoom in/out and
Predict a graph

- To add comments to a Diagram
- To read and sort a Table
- To change the Diagram style
- To change the screen layout between

two windows and Panel and four
windows

- To select an Alternative Panel (if set
up by the Author)

- To save a Result
- To print windows and the whole

Coach screen (if allowed in the
profile)

- To copy windows and the whole
Coach screen to the Clipboard

- To run a Model To do a Data-Video
measurement

- To change measurement
settings (measuring time, trigger
conditions)

- To write own commands
- To change the Diagram and

Table settings
- To enter formulas in a Table
- To move Sensor icons or

Actuator icons
- To place or remove Information

in a window
- To copy a column

Junior
Student

Flexible
mode

Everything in Fixed mode and
- To change the Measurement settings

(Measuring duration and Trigger
settings)

- To write, run and edit a Program and
to add Own Commands

- To place Diagrams and Tables in a
window

- To edit the content of Table cells
- To copy a column to an empty

column in a Diagram or Table
- To do Row operations in a Table

(Insert, Remove and Sort)
- To place and remove Sensor icons

and Actuator icons (if they are
‘unlocked’)

- To change the contents of windows

- To add multimedia elements to
the lists of yellow buttons

- To import and export data in a
Table

- To add, edit or calibrate sensors
or actuators
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via the available Yellow buttons.
Only those buttons are available for
which the Author prepared content

- To reset the Panel

Junior
Student

Own Lab
Mode

Everything allowed in Flexible mode
and:
- To change the measurement

frequency
- To add one's own multimedia

elements (pictures, videos, web pages
(texts excepted))

- To add or edit sensors and actuators,
or calibrate them with a two-point
(i.e. linear) calibration

- To shift the calibration through a
third calibration point provided by
the user

- To import a Background graph in a
Diagram

- To switch Panel
- To make settings in Data Video

- To use advanced processing and
analysis tools

- To edit a calibration curve
- To add new texts to the Activity

Senior
Student

Everything in Own-Lab mode and
- To process and analyse data
- To change the Activity type and the

unit of angle in the Activity options
- To create/edit a Model
- To setup a Data-Video Activity

- To access the menus for
Authors (i.e. Project
management and Profile editor)

- To save Activities or Projects

Author
Everything Senior Students can and
- Create, edit and delete Projects and

Activities and modify the Activity
Options;

- Create and edit Micro Worlds, Add
Procedures and Functions, and
modify the Command list and its
submenus

- Define Sensors/Actuators at Project
level and edit the Coach Library

- Use Profile Editor to create User
profiles

- Use Project Manager to copy, edit or
delete Projects, Activities, Results,
Sensors/Actuators and other Coach
related files
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33..  SSwwiittcchh  CCooaacchh  UUsseerr  LLaanngguuaaggee
It is possible to change the default language of the Coach user interface.
• In the Start menu select Options > Switch Language.
A submenu appears listing all installed languages. The current default language is marked.
• Mark another default language.
• Close Coach and restart Coach.

44..  CCoommmmaanndd--lliinnee  ooppttiioonnss  ffoorr  CCooaacchh33

Coach has a number of options, which can be included in the command-line of a Windows
icon. These options can be combined with each other.

The Language option /t
Via de option ‘/t:’, Coach can start in a specified language. When this option is used, the
default language of Coach is neglected. Add this option in the following way to the
command line of a Windows Icon:
• Create a Shortcut to Coach.exe, e.g. by copying an existing shortcut to Coach.
• Right click the icon and select Properties.
• In the Command-line type ‘c:\coach5v2\coach.exe /t:<language code>.’ For <Language

code> substitute the two-letter code of the desired language, e.g. ‘en’ for English, or ‘nl’
for Dutch.

• If necessary, rename the icon with a descriptive name.
When starting via this icon, Coach will communicate in the selected language.

Note: 

- The language of Commands in Coach Language for new Activities will be set to the
indicated language of the /t: option. If this option is not present in the command line of the
icon, then the default language is chosen. This Command language can be changed by
Authors in Coach. The Command language is saved in the Activity, so in existing Activities,
the in the Activity saved Command language is used.

- The required language files of Coach should be available from an earlier installation.

The Profile option /u:
Via the startup option ‘/u:’, Coach can directly start in an indicated Profile without the
necessecity for the user to log in. Add this option in the following way to the command line
of a Windows Icon:
• Create a Shortcut to Coach.exe, e.g. by copying an existing shortcut to Coach.
• Right click the icon and select Properties.
• In the Command-line type ‘c:\coach5v2\coach.exe /u:<Profile name>.’ For <Profile

name>, substitute the name of an existing Profile (e.g. ‘class3’).
• If necessary, rename the icon with a descriptive name.

When starting via this icon, Coach will start in the indicated Profile (e.g. in Profile ‘class3’).

                                                
3 The information here is meant for experts with Windows (9x and NT) and for system administrators.
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The Window-size options /w: en /h:
By default Coach runs in a maximized window. Via the start-up options ‘/w:’ and ‘/h:’ you
can specify the width and height of the Coach window. Add this option in the following way
to the command line of a Windows icon:
• Create a Shortcut to Coach.exe, e.g. by copying an existing shortcut to Coach.
• Right click the icon and select Properties.
• To have Coach run in an 800x600 window, type in the Command-line

‘c:\coach5v2\coach.exe /w:800 /h:600’. When the screen resolution is set to 1024x768
pixels, Coach will run in a window of 800x600 pixels.

The best results are obtained when using the default screen sizes: 800x600 (minimum
recommended size for Coach) or if necessary 640x480. When using other settings
(especially when the ratio between width and height deviates from the defaults) Coach may
behave unexpectedly (e.g. that dialog boxes do not fit within the window).

The option /i: for the location of the Coach.ini file
When using Coach in a network it may be necessary to use a Coach.ini file (the file with
default settings) on the local (client) machine instead of the server. In this way it is possible
to have separate settings per client. Add this option in the following way to the command
line of a Windows icon:
• On the client-machine, create a Shortcut to Coach.exe.
• Right click the icon and select Properties.
• To run Coach from the server (located, say, in N:\Coach5v2) with a local Coach.ini (in

C:\Coach5), enter the following command line:
N:\Coach5v2\COACH.EXE /i:C:\COACH5\COACH.INI

Note: The program netinst.exe, which is normally used for the local installation of Coach on a client
machine, automatically creates icons with this option, provided that the option ‘local settings’ is
marked. (See also: Appendix I. Network installation)

Figure 89. The shortcut to
Coach with the profile Author
(System Windows 98).
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11..  CCooaacchh  ssttrruuccttuurree
A Coach application consists of a Project filled with Activities.

Coach Project
For Student users, a Coach Project is a set of Coach Activities and Results. For Authors, a
Project is a directory, which contains Activities (located on disk in its own subdirectory of
the Projects directory).
A Project has a name, a Title picture (optional) and a Description (optional) which appears
when the Project is selected in the Project list.

Coach Activity
A Coach Activity is the place where Student users do their work in Coach. An Activity is
always part of a Project. An Activity can be modified by Authors, never by Student users.

Coach Result
A Coach Result is the result of student work in an Activity. It consists of all elements of the
Activity (e.g. like pictures, texts, videos, etc.) together with your changes and resulting data
(for example Notes, measurement data, your own calibrations, Modeling data, Models,
Control programs, etc.).

1.1 File types in a Project
All files for a Project, its Activities and Results are kept together in one folder. All project
folders are placed in Coach folder called Projects. File types which may appear in a project
folder are:

Extension Contains...
CPR Project Description file
CAC A Coach Activity including references to files which are used in the

Activity
SEN A sensor definition
ACT An actuator definition
MPL A picture of a Meter display
JRS and DAT A Coach Result
TXT A Notes file
BMP, JPG and GIF A picture for the Title screen of the Project or in an Activity.
AVI, MOV and MPG  Video files.
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22..  CCrreeaattee  oorr  EEddiitt  aa  PPrroojjeecctt

To create a Project

• Click the Open Project button.
• Click New to create a new Project.
• Enter the following items:

- Project name (obligatory)
- Title screen picture (optional)
- Short description of the Project

(optional). This description displays
when the Project is selected in the
Project list.

• Click OK. A directory will be created
in the Projects-directory. Eventually,
this directory will contain all files
which are required for the Project and
its Activities to run.

To edit a Project

• Click the Open Project button.
• Select the Project from the list you wish

to modify.
• Click Edit to edit it.
Projects can also be edited in Project
Manager.

To select a Title screen

• Click Select BMP to select a picture
(BMP, JPG or GIF) and, when desired,
click 'Yes' to copy it to the current Project
directory. The title screen is shown only
when the picture is located in the Project
directory.

To edit the Title screen
• Click Edit picture to edit the BMP file. Coach starts the Bitmap editor associated with

the BMP extension. The default association is Paintbrush (Windows 3.x), or Paint
(Windows 95).
Note: Coach will not react until the drawing program is closed. (Do not forget to save the
changed picture first!)

- For copying or deleting Projects see Tools > Project manager.
- You can create Activities only within a Project.

Figure 91. Edit project dialog window.

Figure 90. Select project window for Authors.
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33..  CCrreeaattee  aann  AAccttiivviittyy
An Activity is the 'lesson material' in Coach.
Activities can be made for different levels,
ranging from very closed to very open. The
Author has to specify the level.

To create an Activity

• Open the Project where you want to
create the Activity.

• In the Activity-list dialog, click New or
select File > New Activity to create a
new Activity. Next do the following
steps:
1. Select a Panel.

- Select a Panel from the Panel list
for a Measurement or Control
Activity.

- Select No Panel for a Modeling
Activity or a Data-Video Activity.

2. Enter a name of the Activity in the Activity options.
3. Select the Activity type.
4. Fill the Activity.
5. Save the Activity.

3.1 Panel selection
The Panel list shows all Panels for which the hardware driver is installed. If you want to
select a Panel which is not installed, mark the option Show all Panels. Probably you need to
unmark the option Activate hardware as well (see next paragraph). It is always possible to
change the Panel later with Options > Switch Panel.
For Modeling and Data Video Activity you have to select [No panel].

On the next pages you find some detailed information about panels supported by Coach.

Figure 92. Open an activity dialog window for Authors.

Figure 93. Select a panel dialog window.
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Panel picture Panel specifications
CBL This panel is used for on-line and off-line time-based

measurements with the Texas Instruments CBL Data-logger.
Panel specifications:
- 3 Analog inputs (CH1, CH2, CH 3) and
- 1 Sonic input (SONIC).
- Maximally 512 measurement points (hardware- limited)
- Maximum sample frequency for:
s time-based on-line measurements: 5 Hz (through one channel
only),
s  time-based off-line: 10000 Hz (only one channel and with
triggering).
With other settings, the sample frequency will be automatically
adapted by Coach.

CBL2 This panel is used for on-line and off-line time-based
measurements with the Texas Instruments CBL2 Data-logger.
Panel specifications:
- 3 Analog inputs (CH1, CH2, CH 3)
- 1 Sonic input (SONIC).
- Maximally 10 000 measurement points (hardware- limited)
- Maximum sample frequency for:
s time-based on-line measurements: 5 Hz (only one channel),
s  time-based off-line: 50000 Hz (when using a single channel).
With other settings, the sample frequency will be automatically
adapted by Coach.

CBR This panel is used for on-line and off-line time-based
measurements with the Texas Instruments CBR Data-logger.
The CBR is directly connected to the serial port of the computer.
Panel specifications:
- Maximally 512 measurement points (hardware- limited)
- Maximum sample frequency for:
s time-based on-line measurements: 5 Hz
s  time-based off-line: 200 Hz.

CoachLab and CoachLab
with sensor detection

Both panels are used for on-line time-based measurements and
control with the CMA CoachLab interface.
Panel specifications:
- 2 Analog inputs (1, 2)
- 2 Special Analog inputs for CoachLab Microphone (3,4)
- 4 Digital Outputs (1,2,3,4).
- Maximally 2000 measurement points (software-limited)
- Maximum sample frequency 10000 Hz(when using a single

channel).
The CoachLab with sensor detection panel recognizes the
standard CoachLab sensors: Temperature (0511bt), Light (0513bt)
and Microphone (056). As soon as one of these sensors is
connected to the real interface the corresponding Sensor icon
automatically appears on the same input of the screen panel.

CoachLab II This panel is used for on-line time-based measurements, even-
based measurements and control with the CMA CoachLab II
interface. Panel specifications:
- 4 Analog inputs (1, 2, 3, 4)
- 2 Ultrasonic inputs (5, 6)
- 4 Analog outputs (A, B, C, D).
- Maximally 1 Analog input can be used as a Counter input.
- Maximally 16380 measurement points (software-limited).
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- Maximum sample frequency 40000 (when using one channel).
Control Box This panel is used for time-based measurements and control with

the CMA Control Box and UIA or UIB board. Panel specifications:
- 4 Analog inputs (A1, A2, A3, A4)
- 4 Digital inputs (D1, D2, D3, D4)
- 8 Digital outputs (1, 2, 3, 4, 5, 6, 7, 8)
- Maximally 16380 measurement points (limited by software).
- Maximum sample frequency

• for the UIA board is 20000Hz (when using one channel),
• for the UIB board is 60000Hz (when using one channel).

Crossroads This panel is used for control with the CMA Crossroads model.

EcoLog This panel is used for on-line and off-line time-based
measurements with the Fourier Systems EcoLog Data-logger
Panel specifications:
- 5 Inputs for build-in sensors - Light, Temperature, Humidity,

Pressure, Sound
- 2 Analog inputs for external sensors (Ext1, Ext2)
- Maximally 16380 measurement points (software- limited)
- Maximum sample frequency for:
s time-based on-line measurements: 1 Hz,
s time-based off-line: 1020 Hz (when using one channel).

LabPro This panel is used for on-line and off-line time-based
measurements with LabPro Data-logger. Panel specifications:
- 4 Analog inputs (CH1, CH2, CH3, CH4)
- 2 Digital/Sonic inputs (SONIC1, SONIC2).
- Maximally 10 000 measurement points (hardware- limited)
- Maximum sample frequency for:
s time-based on-line measurements: 50 Hz (one channel only),
s  time-based off-line: 50000 Hz (when using one channel).

LabPro + DCU This panel is used for control with LabPro Data-logger and Vernier
Digital Control Unit (DCU). Panel specifications:
- 4 Analog inputs (CH1, CH2, CH3, CH4)
- 1 Digital input where the DCU with 6 1-bit outputs is connected

(1, 2, 3, 4, 5, 6).
- 1 Sonic input (SONIC2).
Other settings see description for LabPro panel above.

LEGO DACTA Interface This panel is used for control with LEGO DACTA Interface. Panel
specifications:
- 8 Analog inputs (1, 2, 3, 4, 5, 6, 7, 8)
- 8 Digital outputs (A, B, C, D, E, F, G, H).
- Only LEGO DACTA sensors and actuators can be connected to

this panel.
- Maximally 2000 Measurement points (software- limited)
- Maximum sample frequency 100 Hz.
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LEGO DACTA RCX This panel is used for control with LEGO DACTA RCX.
Panel specifications:
- 3 Analog inputs (1, 2, 3)
- 3 Digital outputs (A, B, C).
- Only LEGO DACTA sensors and actuators can be connected to

this panel.
- Maximally 2000 Measurement points in on-line mode and 500

Measurement points (depending on the program size) in off-line
mode (hardware- limited).

- Maximum sample frequency 2 Hz in on-line mode and 10 Hz in
off-line mode.

Measuring Console This panel is used for on-line time-based measurements, and
event-based measurements with the CMA Measuring console in
combination with the UIA or UIB board. Panel specifications:
- 4 Analog inputs (1, 2, 3, 4)
- 1 Counter input (C).
- Maximally 16380 Measurement points (software- limited)
- Maximum sample frequency

• for the UIA board is 20000Hz (when using one channel),
• for the UIB board is 60000Hz (when using one channel).

Measuring console with
distance sensors

This panel is used for on-line time-based measurements, and
even-based measurements with the CMA Measuring console in
combination with the UIA or UIB board and Ultrasonic Motion
Detectors.
Panel specifications:
- 4 Analog inputs (1, 2, 3, 4)
- 2 Sonic inputs (SONIC1, SONIC2)
- Maximally 16380 Measurement points (software-limited)
- Maximum sample frequency

• for the UIA board is 20000Hz (when using one channel),
• for the UIB board is 60000Hz (when using one channel).

SMI This panel is used for on-line time-based measurements, and
even-based measurements with the CMA SMI interface.
Panel specifications:
- 4 Analog inputs (1, 2, 3, 4)
- 2 Counters (C, 1)
- Maximally 2000 Measurement points (limited by software)
- Maximum sample frequency 3700 Hz.

System Board This panel is used for control with the CMA System Board and
combination with the UIA or UIB interface board. The System
Board is connected to the 9-pin plug of the UIX card and CMA 25-
pin connector (078) is connected to 25-pin plug of the UIA/B card.
Panel specifications:
- 2 Analog inputs (IN1, IN2)
- 2 Digital outputs (OUT1, OUT2)
- Maximally 16380 Measurement points (limited by software)
- Maximal sampling frequency for UIA card is 20000Hz,

for UIB card is 60000Hz (through one channel).
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3.2 Deactivate hardware
When creating Coach Activities for interfaces which are not available, it is possible to
deactivate the hardware. This means that Coach does not try to communicate with the
selected interface. As soon as the Activity is run on a computer where the hardware is
available, it will work.
Switching off the hardware can be done in three different ways:
• Outside an Activity, switch off the menu option Options > Activate hardware. Now

the hardware is deactivated for the whole Coach session, or until this option is switched
On again.

• Unmark the option Activate hardware at the bottom of the Activity/Result list dialog
box. The hardware is deactivated for the current Activity/Result only. When another
Activity/Result is opened, Coach tries to contact the interface again.

• From within an Activity/Result, the hardware can be deactivated in the Panel Selection
list via Options > Switch Panel by unmarking the option Activate hardware at the
bottom. Do not forget to select the right Panel as well.

Note: Do not forget to switch the hardware on again if you want to measure!

3.2 Activity options
The Activity options determine a number of general settings for the Activity:
- The name of the Activity;
- The type of Activity;
- The Mode in Junior Profile (privileges of the Junior student);
- Program settings;
- Other settings;

Figure 94. Activity options dialog window.
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Senior student can also modify some of these settings.

3.2.1 Activity Name
Enter a name for the Activity. The names are placed in alphabetical order. (i.e. numbers
first, then letters).

Activities are ordered alphabetically, but numbers take precedence. If the Activities should
have a pre-defined order in the list, start their names with a number (i.e. 1,…,9, or 01…99,
etc.) or letter.

3.2.2 Type of Activity
The following activity types are available:
- On-line Time-based measurement (without a Program)
- Off-line Time-based measurement (without a Program)
- Time-based measurement with a Program (On-line)
- Event-based measurement (without a Program)
- Control, with a Program
- Control, without a Program
- Modeling
- Data Video

qq On-line Time-based measurement (without a Program)
This is the usual setting for measuring. It is used for Measurements taken at regular time
intervals according to the Measurement settings. The interface should be connected directly
to the computer. This setting can also be used for a number of Data-loggers: CBL, CBL 2,
CBR, LabPro and EcoLog, for so-called on-line measurements (Data-logger is connected to
the computer during the measurement process).
The green Start button is available to start a measurement run.
• Select Time-based measurement.
• Deselect With a Program.
• Deselect Off-line.

qq Off-line Time-based measurement (without a Program)
This setting prepares for time-based measurement with a Data-logger, used to store the
measurements. The Data-logger is not necessarily connected to the computer during the
measurement process. The green Start button is replaced by the Send settings button and the
Get result button.
• Select Time-based measurement.
• Deselect With a Program.
• Select Off-line.
Note: If the current Panel is not able to do Off-line measurements, then the option Off-line is not
available.
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qq Time-based measurement with a Program (On-line)
Use this setting for Measurement and Control (!) Activities in which only signals from
sensors and/or actuators have to be stored in Diagrams or Tables while a Program is used to
control e.g. the Control model (Program variables can not be displayed in Diagrams/Tables
with this setting). The duration of the Control process is determined by the Program, while
the sensor and actuator signals are evaluated according to the Measurement Frequency. The
advantage of this is, that the signals are evaluated independent of the Program speed. In this
way the behavior of the Control systems can be monitored easily during Program execution.
The green Start button is available to start a measurement run and Program execution.
• Select Time-based measurement.
• Select With a Program.

Note:

- If the Frequency in the Measurement settings is set to Manual or Manual with Counters, then
"With a program" can not be selected.

- If the setting Time-based measurement is not available, probably a Program variable is used in a
Diagram or Table. First remove all connections which refer to Program variables.

- If Program variables should be available for display in Diagrams or Tables, use Control with a
Program (see below). In that case, the Control Program will also determine the rate at which
the measurements are being taken.

Example
A Temperature control system, of which the temperature is displayed in a Diagram.

qq Event-based measurement (without a Program)
This setting is used for measurements triggered by a pulse on a counter input. The Quantity
which generates the pulses is the independent variable, the time and other measured signals
are stored as dependent variables. The green Start button is available to start a measurement
run.
• Select Event-based measurement.
• Deselect With a Program.

qq Control, with a Program
Use this setting when the Control Program has to determine the way measurements are
being taken and when a Program is used to do calculations on measured signals. All
Program variables appear in the Data-range Connection automatically and can be chosen in
Diagrams and Tables. However, the values are stored in memory (and appear in the
Diagrams/Tables) only when the standard Procedure SaveData is used in the Program.
Disadvantage of this setting is that the sensitivity to signal changes depends strongly on the
execution speed of the Program. The green Start button is available to start Program
execution.
• Select Control.
• Select With a Program.
Note:

If the sensor signals change rapidly, you'd better use Time-based measurements with a Program.
In that case, however, Program variables cannot be displayed in Diagrams or Tables.
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qq Control, without a Program
Use this setting for Activities in which actuators are controlled manually. Neither the P-
Button nor the Start button is available in this Activity type.
• Select Control.
• Deselect With a Program.

qq Modeling
Select Modeling for Modeling Activities. The Model button (M-button) is available to open
the Model window. The green Start button is available to start a Model calculation.
Note: This setting can be selected only when the Activity has 'No Panel'.

qq Data Video
Select Data Video for video-measurement Activities. The upper-left window in the Activity
will now be reserved for the videoclip or picture sequence to be measured. The green Start
button is available to start a Data-Video measurement.
Note: This setting can be selected only when the Activity has 'No Panel'.

3.2.3 Mode in Junior Profile
This setting is used when Coach is entered in Junior mode (i.e. when the user logs in with a
Junior type of profile). See also 'I. Introduction; 2.User modes'.
• Specify the mode of the Activity for Junior Students.
• For Own-Lab mode, specify Sources.
• Check May use results if you want to allow the users to open or save Results from the

Activity. When unmarked, the Open Result button and Save Result button disappear
from the Activity Toolbar.

Note: The disk drive where the Results are stored is determined in the Profile.

3.2.4. Activity options: Sources
By selecting Sources the Author determines which Sensors and Actuators the user can
choose from the Library in an Own-Lab Activity. Sources can be selected only for Activities
in Own-Lab mode.

To select Sources

• If necessary, select Own-Lab as the Mode in Junior Profile.
• Click the Sources button.
• Select Sensors and/or Actuators.

It is possible to select several items at once by using <Ctrl> or <Shift> in combination
with mouse clicks (See Windows Help).

• Click the arrow buttons to move your selection from the list on the right ('Other:') to the
list on the left ('Used:'), or vice versa.

Note: When no Sources are selected, users in Own-Lab mode can only select Sensors or
Actuators available in the Project folder.
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3.2.5 Program-window settings

• Unmark the option May see programs to hide the Program button or the Model button
from the Activity Toolbar for all Student users.

• In the Activity options you select the Program window contents. Mark the parts of the
Program window which should be visible to your students. The parts are:

Button area Left part of the Programming window.
Here appear the Instruction buttons.

Editor area Middle part of the Programming window.
Here appear the Program lines.
Authors and Senior students can type here freely.

Menu area Right part of the Programming window.
Here appears the Command list.

• Select Stop on digital input=… to determine which of the Panel inputs is used to
unconditionally end Program execution. The Program stops as soon as the value on the
selected Input becomes High.

Note: The red Stop button of the LEGO DACTA Interface is always connected to input 9.

3.2.6 Other settings
Except for the Alternative Panels, these options are seldom used. In case of doubt, leave the
settings alone.
• Mark the option Always run in Quick mode only when fast Program execution is

required. In Quick mode, the screen is not updated during Program execution, to speed
up the execution time.

• Unmark Display all digital bits during replay for fast replay. Only bit information will
be stored for channels to which a Sensor/Actuator is connected.

• Angle units: Specify the units for angles used in the Formula editor, or measured in
Data-Video.

• Command language (i.e. the language of Coach-Language commands) This option
makes it possible e.g to use an English Control Activity in a Dutch Coach environment.

• To make an Activity suited for more interfaces, you have to specify Alternative Panels.

 3.2.7 Alternative Panels
With Alternative Panels you can make an Activity suited for more than one interface.
Students users can select an Alternative Panel by right clicking the Panel. Moreover when
the Panel for the Activity can not be found, a button 'Select Other Panel' appears which
shows the list of Alternative Panels.
Alternative Panels are not defined by selecting a particular interface, but by specifying the
minimum number of required inputs and outputs in the Activity. From this, Coach
determines which Panels meet the conditions. These Panels appear in a list.
• Click the button Alternative  Panels.
• Enter the number, select the type of connection and specify the kind of connection.

The options for Kind depend on the selected Type of Connection. In most cases General
can be selected.  Yellow, Blue (for inputs) and Black (for outputs) are used only for the



GGUUIIDDEE  TTOO  CCOOAACCHH  --  119955

LEGO DACTA Control Interface and Sonar (for inputs) is used for Ultrasonic Motion
sensors. 'Special' is reserved for future extensions of the package. Do not select it.

• If you want to specify more than one type of connection, use a new line.
• If you want to set up Alternative Panels for an Activity with Ultrasonic Motion sensors,

select Type of Connection=Analog input, and Kind=Sonar.
• Click the button Use  current  connection to automatically set the required numbers,

connections and kinds as specified by the setup of the current Activity. Use this button
only when no additional sensors/actuators will be used on the Panel.

• To disable Alternative Panels, simply delete all Number fields.

Note: Selection of an Alternative Panel may cause a change of Sensor/Actuator icons positions
on the new Panel and removal of Sensors/Actuator icons that are not supported by the new Panel.

To open the Activity options in an existing Activity

• Start the Activity in Author mode.
• Select Options > Activity options from the menu or use the shortcut <Shift> +

Measurement settings button.

3.3 Filling an Activity
In fact, filling an Activity is nothing more than preparing measurement settings, preparing
the right sensors or actuators and preparing information in windows. Most of this can be
done by students as well. The only thing that students can not do is save the Activity. When
filling an Activity an Author should keep in mind for which user level the Activity will be.

Change User mode
During the development process of a Coach Activity, Authors can immediately view and
evaluate the Activity in another User mode Student mode:
• Select the desired User mode under Options > User mode in an Activity. Except for the

menu in the menu bar (top of the screen), the Activity will behave exactly as a student
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user (Senior or Junior) would experience it. The Tools-menu stays available to switch to
Author mode again.

The following shortcut keys are available to quickly switch User modes:
- <Ctrl+D> for Author mode
- <Ctrl+S> for Senior Student mode
- <Ctrl+J> for Junior Student mode

3.4 Management of multimedia files for activities
An Activity can display different types of multimedia files, like Pictures, Videos, HTML
pages, Word Documents etc.
The Pictures and Videos are displayed in one of Coach's four windows (listed respectively
under the Display Picture button or Display Video button). The other files (in fact, any file
to which an association with an external program on your computer exists) are displayed in
their respective program (e.g. a Web Browser, MS-Word, etc.). These files are all listed
under the Web-page button.
Activities can only use multimedia files when located in the current Project directory
(default location for all external files) or the Graphics directory of Coach. E.g. when an
Author selects a Picture or Video from another directory, then the item will be copied
automatically to the current Project directory.
Decide beforehand which location suits you best (it is difficult to change it afterwards!). The
Graphics directory is a useful choice when a large file is used in several Projects (it is stored
only once and all Activities have a reference to this file).

1. To store a multimedia file in the current Project (the default location)

• Add the Picture or Video file to the Activity.
• Click OK on the message that Coach will copy the file to the current Project.
• Note: It is also possible to use Tools > Project Manager to place pictures in a

Project directory.
Or Add a link to another multimedia file to the list of Web pages.
• Copy the desired file with Project Manager or the Windows Explorer to the current

Project directory.
• In the field URL enter the name of the file. (A pathe is not required because the current

Project directory is the default location for all files which are used in the Project).

To store a multimedia file in the Graphics directory

• Copy the desired file to the Graphics directory (or other directory listed as path) with
Project Manager or the Windows Explorer.

• Add the Picture or Video file to the Activity.
Or Add a link to another multimedia file to the list of Web pages.
• Copy the desired file with Project Manager or the Windows Explorer to the current

Project directory.
• In the field URL enter the full file name including path.
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Paths for multimedia files
The default path for multimedia files (Pictures, Videos, HTML pages, Word documents) is
the Graphics-directory in the Coach 5 directory. You can change where the these filescan be
found.

To add a Path

• Select in the Start menu or Project menu: Tools > Install paths.
• Click Add.
• Browse through the directory tree to open a directory
• Click OK.

To remove a Path

• Select in the Start menu or Project menu: Tools >
Install paths.

• Click Remove  (only the path will be deleted, not
the directory itself and its contents!).

Warning: After deleting a Path, there may be Activities for
which some multimedia files cannot be found any longer!

3.5 Save an Activity

To save an Activity

• Select File > Save (F2) from within the Activity. The Activity will be saved in the
current Project directory exactly as it appears.

- To save an Activity in another Project, select Save as.. instead of Save.
However, when this directory is not a subdirectory of the Coach Projects directory, the
Activity can not be opened in Coach by Students anymore.

- For copying, moving or deleting Activities, the use of the Project manager is strongly
recommended.

Figure 95. Window to define paths to
multimedia files.
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44..  SSeennssoorrss//AAccttuuaattoorrss

4.1 Create or Edit a Sensor/Actuator icon
When creating or modifying a Sensor/Actuator icon, the Sensor editor or Actuator editor is
used to edit the Sensor properties or Actuator properties.

Sensor/Actuator icons can be stored in three locations:
1. in the Activity: icons are available only in the Activity. The information becomes part of

the Activity file (or Result file).
2. in the Project: icons are available to all Activities and Results of the Project. The

information is stored as a separate file (*.SEN or *.ACT) in the current Project directory.
3. in the Library: Icons are available to the Activites (Results) in all Projects. The

information is stored as a separate file (*.SEN or *.ACT) in the Library directory.

Notes:
- Senior Student users and Junior Student users in Own-Lab can only create, edit and store

Sensor/Actuator icons in the Result.
- Icons are only available in one location at a time! They are either in the Library, Project or in the

Activity.

 4.1.1 Create/Edit a Sensor/Actuator icon in the Activity

• In the Activity, right click a Sensor/Actuator icon or an empty Palette position.
• Select Edit or New.
• Fill in the Sensor properties or Actuator properties (see section III. Measurement and IV.

Control).
• Save the Activity or save the Result to store.

To store the icon in the Project or Library, right click the icon and select Save as… Select
the desired directory and click OK.
If the option Use the icon from the specified directory  =  On (default): the current
Activity will use a reference to the icon information saved in the Project or Library
(depending on your choice). The icon information is no longer part of the Activity.
If the option Use the icon from the specified directory  =  Off: the icon information will be
stored separately in the Project or Library (depending on your choice), but the Activity will
still use a local definition of the icon. This information is stored only after you save the
Activity.

4.1.2 Create/Edit a Sensor/Actuator icon in the Project

• In a Project select Tools > Sensor editor or Actuator editor.
• Click New to create an icon, or select a Sensor/Actuator icon and click Edit.
• Fill in the Sensor properties or Actuator properties(see section III. Measurement and IV.

Control).
• Click the Save as… button and select in the drop-down list below Library directory to

store the icon as a *.SEN or *.ACT file in the Library.
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• Click OK to confirm or Cancel to cancel the changes.

An easier way for creating an icon in the Project is to create the icon in an Activity and save
it in the Project via Save as… (see Tip above).

4.1.3 Create/Edit a Sensor/Actuator icon in the Library
Editing the Library is a task for experienced users only!
The majority of Activities contains references to Library icons. Changing Sensor/Actuator
icons in the Library has impact on all Activities where these icons are used. This may lead to
undesired effects (e.g. the icon in another Activity cannot be found any longer, because its
name was changed in the Library, or the icon behaves strangely in an Activity, because its
calibration was changed in the Library).
It is recommended not to change information in the Library, but to add new icons to
the Library. Keep a backup of the original Library before you start making changes!
• In a Project select Tools > Sensor editor or Actuator editor.
• For Directory select Library directory.
• Click New to create an icon, or select a Sensor/Actuator icon and click Edit.
• Fill in the Sensor properties or Actuator properties (see section III. Measurement and IV.

Control).
• Click the Save as… button and select in the drop-down list below Library directory to

store the icon as a *.SEN or *.ACT file in the Library.
• Click OK to confirm or Cancel to cancel the changes

A sometimes easier way for creating an icon in the Library is to start in an Activity and save
the created icon in the Library via Save as… (see Tip above).

To Remove a Sensor icon or Actuator icon from the Activity

• In an Activity, right click a Sensor icon or an Actuator icon that is defined in the
Activity.

• Select Delete all. You get a message that the icon is removed from the Activity. After
confrimation it will be removed. The icon is only then removed from the Activity when
the Activity is saved again.

• Removing an icon from a Result is done in the same way.

To Remove a Sensor icon or Actuator icon from the Project or Library

• In a Project (but not yet in an Activity), select Tools > Sensor editor or Actuator
editor.

• Select a Sensor icon or Actuator icon.
• Click Delete.

Icons in the Project or Library can also be removed with Project Manager.
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4.2 Lock or Unlock an Icon
Icons on the Panel can be locked so that Student users cannot move the icon. Otherwise, the
icon is free and it can be moved between the inputs/outputs, or between the Panel and the
Palette. For Fixed Activities, icons are always locked irrespective of the setting made here.

To lock an icon

• Drag the icon to an input or output on the Panel.
• Right click the icon and mark Icon locked.
Note: Even Authors cannot move a locked icon, they have to unlock it first.

To unlock an icon

• Right click the icon and unmark Icon locked.
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11..  OOvveerrvviieeww  ooff  tthhee  PPrrooggrraammmmiinngg  eennvviirroonnmmeenntt  ffoorr  SSttuuddeennttss
Authors can prepare a Programming environment for student users. Coach offers several
modes of programming for students. These modes are set by the Author.

Manual control mode
Students can read connected sensors and control actuators by simply clicking on the screen
Panel to find out their behavior.

To set activity for Manual control

• Open the Activity options.
• Select Type of Activity  =  Control.
• Unmark With a Program.

Instruction buttons
With the Instruction buttons students can control a model manually. The program lines,
which correspond to the actions of the user, automatically appear in the Programming
window. The Micro-world author creates functions or procedures and links these to the
states of Instruction buttons.

To set up an Activity with Instruction buttons:

• Open the Activity options.
• Select Type of Activity  =  Control.
• Mark With a Program.
• In the Program settings mark Button area.
• Create Micro-world functions or procedures if necessary.
• Define Instruction buttons and link them to standard Coach Language instructions or

Micro-world functions or procedures.

Programming via the Command list
Students create a Program by selecting Commands from a pre-defined list in the Micro
world. A Micro world usually contains only Commands that are relevant for the Activity.
The Micro-world author creates Procedures and Functions and defines the Command list for
the Micro world. Students can create Own Commands and add these to the list with
programming commands.

To set up an Activity with the Command list:

• Open the Activity options.
• Select Type of Activity  =  Control.
• Mark With a Program.
• In the Program settings mark Editor area and Menu area. In this case you get a

standard Coach Language Command list which you can further modify. (see next
section).

• Create Micro-world functions or procedures if necessary.
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• Modify the standard Command list.

Advanced Programming
Senior-student users can program freely by choosing commands from the complete list of
available Coach Language commands or by typing commands directly in the Program
editor. It is also possible to create Own Commands and add these to the list with
programming commands.

To set up an Activity with the Command list:

• Open the Activity options.
• Select Type of Activity  =  Control.
• Mark With a Program.
• In the Program settings mark Editor area (only the Program editor area is available to

type in Programs). Mark Menu area to get also a Command list with the standard Coach
Language commands.

22..  MMiiccrroo  wwoorrllddss
A Micro-world consists of pre-defined set commands - functions or procedures - tuned to a
particular control model. A number of standard functions or procedures are available in
Coach Language. Author uses these to create Micro-world functions or procedures in the
Procedure window.

Micro-world commands are used to:
• Define the actions of Instruction buttons
• Add commands to the command list.
Note: Coach Language standard Procedures and Functions are described in the section VII.
Coach Language.

2.1 How to open the Procedure window
The Procedure window is placed in the Programming window and it is hidden behind the
Program Editor.
• If necessary click the

P-button to display
the Programming
window.

• Place the mouse
cursor on the bottom
line of the title bar
until it changes its
shape to:  

• Drag the top edge
down. The Procedure window (indicated by the red arrow in the picture) will open.
In this window procedures, functions, constants and initial values of variables can be
entered.
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2.2 Defining Micro world Functions
In a function a number of statements are defined under the name of the function.
The result of a function is a calculated value.

To define functions the syntax should be as follows:

Function Function_name(p1, p2)
Statements
Function_name:= expression (assign a value to the function's name)

EndFunction

The function is defined between the words Function and EndFunction.
- First enter the Function_name including the parameters p1, p2, which are treated as local

variables in the statements and the expression. The function name must be separated
from the reserved word Function by a space.

- Then defined the statements, separated from each other by (spaces or) <Enter>.
- The definition of the function must be concluded with the assignment statements (of an

expression to the 'Function_name').

Keep the following in mind:
- The function name may not be identical to the name of a reserved word, a variable, a

procedure or of an already defined function.
- The parameters, as defined in the function name, act as local variables. The names of

each parameter must be unique. It is not allowed to use the same names at other
positions in the Micro world.

- The parameters have to be separated from each other by a semicolon (;).
- Only functions with 0, 1 or 2 parameters can be used in the command list.

The following options may be used:
- In a function it is allowed to call an already defined function.

To define a function:

• Open the Procedure window.
• Type the function.

Examples of functions

Function Mean(A; B)
  C =  A+B
  Mean = C/2
EndFunction

Function Light
    If LightIntensity > 50
Then
        Light = 1
    Else
        Light = 0
    EndIf
EndFunction
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2.3 Defining Micro world Procedures
In a procedure a number of statements are defined under the name of the procedure. The
result of a procedure is the execution of the defined statements.
The definition of a procedure is very similar to the definition of a function. The difference is
that the definition of a function ends with an assignment and the definition of a procedure
does not.

To define procedures the syntax should be as follows:

Procedure Procedure_name(p1; p2; ...)
Statements  

EndProcedure

The procedure is defined between the words Procedure and EndProcedure.
- First enter the Procedure_name including the parameters p1, p2, which are treated as

local variables in the statements. The procedure name has to be separated from the
reserved word Procedure by a space.

- Then defined the statements, separated from each other by (spaces or) <Enter>.

Keep the following in mind:
- The procedure name may not be identical to the name of a reserved word, a variable, a

function or of an already defined procedure.
- The parameters, as defined in the function name, act as local variables. The names of

each parameter must be unique. It is not allowed to use the same names at other
positions in the Micro world.

- The parameters have to be separated from each other by a semicolon (;).
- Only procedures with 0, 1 or 2 parameters can be used in the command list.

The following options may be used:
- In a procedure it is allowed to call an already defined procedure.

To define a function:

• Open the Procedure window.
• Type the procedure.

Example of procedures

Procedure Lamp
   Set(1)
EndProcedure

Procedure Lamp(n)
   Set(n)
EndProcedure

Procedure Lamp(n; State)
   If State = 1 Then
      Set(n)
   Else
      Reset(n)
   EndIf
EndProcedure
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2.4 Coach Standard functions and procedures
Coach Language offers a number of:
- standard mathematical functions (sin(x), cos(x), ln(x), etc.)
- special mathematical functions (Delta(C), Integral(C;r), Sum(C), etc.)
- standard functions (Bit, Counter, Interval, Latched, etc.)
- standard procedures (Count, Set, Reset, Wait, etc. ).
All these functions and procedures are described in the section 'VII. Coach Language'.

33..  CCrreeaattiinngg  IInnssttrruuccttiioonn  bbuuttttoonnss
Students can make programs by manually controlling a system via so-called Instruction
buttons on the screen. Instruction buttons are buttons with pre-defined standard procedures
or Micro world procedures created by an Author. The effect of the button clicking must be
described in the procedure.

By clicking Instruction buttons Coach executes procedures that are associated with these
buttons and translates them into the Program lines.
This Program can be visible on the screen in the Program Editor area4 (but it does not have
to). By executing the Program again, Coach repeats recorded program lines (model actions).

When the mouse cursor is moved over the button a tool-tip with a procedure(s) name (its
action) appears.

When the button area is not visible in the Programming window
• Select in the menu Options > Activity options…
• Mark the Button area under the Program settings.

                                                
4 In this case the 'Editor area' should be marked in the Activity options.

Figure 96. Example of Instruction buttons used in the Crossroads project.
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3.1 Defining Instruction buttons
Instruction buttons are placed in the 'Button area' of the Programming window.

To add a button

• Click an empty place in the Button area of the Programming window.
• Select a button type (see & 3.2 below).
• Select the procedure(s) associated with this button. In the list appear only procedures,

which can be used for the selected button type. These can be standard Coach Language
procedures or procedures created in a Micro world (in the Procedure window).

• Select a button icon from the list of icons.
• Click OK. The new button is placed in the Programming window.

To delete a button

• Right click a button in the Button area.
• Click Delete.
• The button is removed from the Programming window.

3.2 Types of Instruction buttons
In the 'Button area' three different types of buttons can be placed:
- 'One' shot button
- 'Push/Release' button
- 'Stepping button'.

3.2.1 Instruction buttons: type 'One shot'
A One shot button executes a procedure once when it is pressed. Only procedures without
parameters (standard and created in a Micro world) can be selected.
• Mark the 'One shot' option.
• Select a procedure for the button from the drop-down list box.

Figure 97. Define new button dialog window.
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Pushing the button executes the procedure once and places the procedure name in the
program line.

Example:
The procedure Main_road_Red can be associated
with a one shot button.

3.2.2 Instruction buttons: type 'Push/Release'
A Push/Release button executes two procedures: one when the button is pushed, and one
when the button is released. There is a wait between the two operations.
Only procedures without parameters (standard and created in a Micro world) can be
selected.
• Mark the 'Push/Release' option.
• Select a procedure to be executed when the button is pushed.
• Below it, select a procedure to be executed while the button is released.
Pushing the button executes the first procedure once only and places the procedure name in
the program line. As long as the button is pressed a Wait command counts the time in the
next line in the program.
When the button is released the time counting is finished, the second procedure is executed
and its name is placed in the next program line.
This buttons can be used for example to turn a lamp or electric motor on for a set time.

3.2.3 Instruction buttons: type 'Stepping'
Stepping button causes a procedure to be executed a number of times while the button is
pressed. A parameter 'steps' is added to the procedure name.
Only procedures with one parameter can be selected. This parameter must determine the
number of repetitions in the procedure.
• Mark the 'Stepping' option.
• Select a procedure for the button from the drop-down list box.

Pushing button executes the procedure and places the name of the procedure in the program
line. As long as the button is pushed the parameter value counts the number of times the
procedure has been executed.
Releasing button places the final parameter value in the program and closes procedure in the
program line.

Some examples:

Procedure Go_Down(Number)
  Redo Number
  ….
  ….
  EndRedo
EndProcedure

Procedure Go_Down(Number)
  Repeat
    Do_a_Step
     ….
  Until Number
EndProcedure

Procedure Main_road_Red
  Set(4)
  Reset(5;6)
EndProcedure
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44..  MMooddiiffyyiinngg  CCoommmmaanndd  lliisstt
The Command list can be adapted for a specific application - a Micro world. A limited
command list forms an easy programming environment for students. The Command list is a
list with references to Commands (either standard Coach Language commands, or user-
defined Micro-world commands). The Command list is displayed at the right side of the
Program window. Students can create Programs by selecting Commands from the Command
list. To obtain complete Command a user should select items from several Submenus e.g. to
select parameters for the Command, to enter a value or to put together Conditional
Expression. Through this system, Coach ensures that constructed Commands always have
the right syntax.

Each Control Activity with a Program and each Time-based measurement Activity with a
Program has a default Command list consisting of standard Coach Language Commands.
An Author can adapt the Command list to fit the current Micro world
• By including references to self-made Procedures and Functions with the corresponding

Submenus in the Command list
• By deleting references to existing Commands from the Command list.
• This is important because a good Command list simplifies programming by students

enormously.  In this way one can get Commands which are more or less understandable
in ordinary language. Examples are:
- TrafficLight(Red);
- Motor(B;Left);
- If Temperature > 20 Then Fan(On) EndIf

4.2 Simple editing of the Command list

To edit the Command list title
The command list by default has the 'Command' title. To change this title:
• Right click the 'Command' title.
• Edit the title and confirm your changes.

To delete the Command reference from the list Command list

• Right click the command you would like to remove.
• Select Delete item, or press <Del>. The name will be removed from the command list,

together with the submenu for the item.
• When you want to restore the name, you have to create the submenu again.

To cut Command reference from the list Command list

• Right click the command in the command list.
• Select Cut <Ctrl X>. The name and corresponding submenu(s) are moved to the

Clipboard and can be placed elsewhere in the list with Paste.

To copy Command reference from the list Command list

• Right click the command in the command list.
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• Select Copy <Ctrl C>. The name and corresponding submenu(s) are copied to the
Clipboard and can be placed elsewhere in the list with Paste.

To paste the Command reference into the list Command list

• Make sure you have copied or cut an item from the command list.
• Right click the position after which the command should be placed.
• Select Paste (after) <Ctrl V>.

Note: The option Paste (before) <Ctrl+Shift+V> is available only for the first position of the
command list.

4.2 Modifying the command list

4.2.1 Adding a new command
Before you add the new command to the list you have to create a new procedure in Micro
world5. This is done in the Procedure Window.
• Open the Procedure window.
• Type in a new procedure.
• When you are ready right click a command or an empty place in the command list.
• Select Insert. The 'Add new Main menu item' dialog appears on the screen.
• Type in the Name of the new procedure. Here you can type also a name of the standard

Coach procedure or function.
• Coach automatically recognizes the name (as a name of procedure defined in the

Procedure window or the standard Coach Language command) and adds its description
in the Description field. Coach can display the following descriptions:

Operator or unknown command
The name is not recognized to be a standard command or a Micro world procedure or
function. A procedure or function with this name still has to be made, or the name is
wrong.

Procedure with a variable number of parameters
These are standard Coach Language procedures (for example: Set, Reset, Sound etc.).
The corresponding submenus cannot be edited.

Function with a variable number of parameters
These are standard Coach Language functions. The corresponding submenus cannot be
edited.

Procedure with (n) parameter(s) / Function with (n) parameter(s)
Only submenus of commands with 0, 1 or 2 parameter(s) can be edited.

Statement with an expression
These are If, Until, While and Redo. Conditions for these commands can be edited.

                                                
5 This is not necessary if you want to add a standard Coach Language command.
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Other Coach Language word
Like Repeat, Else, EndIf, EndRedo, EndDo. These commands do not need a submenu.

• The description given by Coach determines whether submenus (e.g. for parameters) are
available. The type of submenu can be chosen in the 'When the user selects this
command' part of the dialog box. The following options are available:

Default submenu
Select this option only for standard commands, Loop commands or If statements.

Adapted submenu (Use the Wizard)
With help from the Wizard, an Author puts together a submenu.

No submenu
Select this option for commands without parameters.

Comment
By selecting this option, the item in the list is regarded as a comment only. This is useful
e.g. to create subtitles in the list. Also blank lines have this setting.
Clicking a comment in the list during programming does not lead to any action.

4.2.2 Creating Adapted submenu (using Wizard)
After selecting the Adapted submenu click the Wizard button. This will start the Wizard
that helps to create command submenus (selection list and/or fields for typing values) and
command conditions.

Submenus for procedures and functions with 1 or 2 parameters
For procedures and functions with parameters Coach opens 'Submenu Wizard' which allows
creating the selections list or typing fields for every parameter. For each parameter:
• Type the title of the submenu.
• Mark one of the options:

- 'Type a value' - user has to type a value; or
- 'Selection list' - user has to select an item from the list.

• After the 'Selection list' option is marked, type in the items of the list.
• Click OK when submenus for all parameters are ready.

Conditions for Conditional and Loop statements
For Conditional statements (If…Then… EndIf) and Loop statements (Repeat… Unitl,
While… Do… EndDo) users create conditional expressions via submenus.
For these commands Wizard allows creating a conditional expression by defining separate
submenus on the right side of the operators for each item on the left side (Submenu per
item marked), or to make one submenu which appears for all items on the left side
(Submenu per item not marked).
Only expressions with relational operators can be created.

Left side of the conditional expression
• Type a title for the first selection list.
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• If you mark the Submenu per item check box then each item on the left has its own list
on the right, if you do not mark this check box then all items on the left will have the
same submenu.

• Type the names of functions and variables. When a function has parameters, a Menu
button appears. Click the Menu button to enter submenus for the parameters.

Relational operators of the expression
• Mark relational operators that will appear in the selection list.

Right side of the conditional expression
• Select a function or variable at the left side by marking a radio button at the left side of

the name. Enter the item(s) to which it has to be compared at the right side. Again you
have possibility to select between 'Type value' or 'Selection list' option.

• Click OK when submenus for all items at the left are defined. Remember if you do not
mark the Submenu per item check box at the left side then you have to create only one
submenu at the right side.

4.2.3 Advanced editing of an command

• Right click a command in the command list.
• Select Properties. The 'Add new Main menu item' dialog appears on the screen.
• Edit properties of the command (see & 6.2.1).

4.3 Examples of modifying the command list

4.3.1 Extending the list of commands
Imagine a system consisting of 4 small lamps (3 V bulbs) which can be connected to the
outputs Coach Lab II and can be turned on and off. To control lamps a procedure Lamp
must be defined.

Procedure Lamp(n;m)
  If m=On Then
    Set(n)
     Else
    Reset(n)
  EndIf
EndProcedure

This procedure uses 2 parameters; first parameter gives information which lamp (ouput)
should be activated, second parameter gives information the lamp should be turned On or
Off.

Type in the procedure 'Lamp' in the Procedure window.
1. Remove not necessary commands from the list.
2. Right click a command or empty space in the command list.
3. Select Insert.
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4. Type in the name Lamp.
5. Coach recognizes that this is

the procedure with 2
parameters.

6. Select 'Adapted submenu'.
7. Click the Wizard button.
8. For this command are two

menus needed, first to select
the lamp (output), and the
second to select the state of
the lamp.

9. Submenu for the first
parameter (selection of lamp)
is done in the left part of the
dialog.

10. Give a title of the first
submenu: Select output.

11. Mark the 'Selection list'
option. User will select the
output from the command list.

12. Type list items: A, B, C, D6.
13. Define the submenu for the

second parameter.
14. Mark the 'Selection list'

option.
15. Type list items: On, Off7. It is

not necessary to give a title of
submenus.

4.3.2 Redefinition of structural
statements
A structural statement, like a Conditional statement If… Then… EndIf, always needs a
logical expression to be evaluated (see Coach Language description).
By default you build a structural statement from lists that pop-up as soon as you select the
opening word, e.g. 'If'. This structure can not be modified. A Micro world must use either
the standard structural command or a replacement submenu, designed by the developer of
the Micro world. Below you find an example of creating a replacement submenu of a
conditional statement.

Imagine the system that reacts on the light intensity measured by the light sensor connected
to one of the inputs of the Coach Lab II interface (automatic shop window illumination).
To read a value measured by the light sensor create a function LightIntensity:
                                                
6 When you use variables A, B, C, D instead of the default output numbers, then you have to declare
them explicitly in the Procedure window. For CoachLab I these declaration are: A=1 B=2 C=3 D=4,
for CoachLab II these declaration are: A=1 B=3 C=5 D=7.
7 On, Off are standard Coach Language commands, you do not have to define them in the
Procedure window.

Figure 98. Add new Menu-item dialog window. Coach recognizes
procedure Lamp as Procedure with w parameters.

Figure 99. Submenu Wizard.
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Function LightIntensity(p)
  LightIntensity = Level(p)
EndFunction

1. Type in the Procedure
window the function
'LightIntensity'.

2. Right click the 'If' command
in the command list.

3. Select Properties.
4. Change default 'Standard

submenu' to 'Adapted
submenu'.

5. Click the Wizard button.
6. In this window you have to

create a condition.
7. Remove all settings that are

placed in the fields at the
left side of the window.

8. Type in a new title for the
first selection list.

9. Type in the function name
LightIntensity in the first
field.

10. The function LightIntensity
has one parameter that
allows selecting the input of
the light sensor. For this
parameter the submenu can
be created.

11. To create a list of inputs that
can be selected click the
Menu button.

12. Select the 'Selection list' option.
13. Type in the inputs: 1, 2, 3, 4. Click OK.
14. Mark the operators used in the condition '<' and '>'. (If

necessary remove all default settings).
15. Finally define the right side of the condition. User will

have to type a value of the light intensity. (If necessary
remove all default settings).

16. Type a title of this part for example: 'Type value' or
'Light Intensity value'.

17. Select the 'Type value' option.
18. Click OK. Your new condition is ready.

Figure 100.Edit main menu dialog window.

Figure 101. Create condition dialog window.

Figure 102. The Submenu Wizard.
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55..  UUssiinngg  tthhee  RRCCXX  wwiitthh  CCooaacchh
The LEGO DACTA RCX is a programmable 'brick' which can contain up to five User
Programs. When Programs are loaded into the RCX, it can function without the presence of
a computer.  Communication takes place via an IR (Infra Red) Transmitter (the 'Tower'),
connected to the Serial port of the Computer.
In order to be able to communicate with the computer, the RCX must contain system
software, which consists of two components:
- the Firmware (general system software), which takes care of the communication between

the computer and the RCX and reserves in the RCX five positions for downloading self-
made Control Programs.

- Specific system software for communication with Coach. After adjusting the RCX for use
by Coach, the first three program positions are filled with a standard test program, while
positions 4 and 5 are reserved for user Control Programs.

Setup of the RCX in Coach takes the following steps:
1. Prepare the RCX for setup;
2. Setting the COM port;
3. Downloading the System software.

The RCX Control Panel
Together with Coach, the RCX Control Panel program is included. This external program is
used to monitor the status of the LEGO DACTA RCX and to send certain settings (a.o. the
system software) to the RCX.
• Start the RCX Control Panel by double clicking the icon

'RCX Control' (RCXPanel.exe).

The RCX Control Panel shows 5 icons. When keeping the
mouse over an icon, a ToolTip appears with information about
that item. A red cross through an icon means that there is
something wrong – see the ToolTip for more details.
- The CMA icon,
- The Tower icon, indicating the status of the Tower,
- The beam icon,
- The RCX icon,
- The LEGO DACTA logo (only a logo).
Furthermore a drop-down selection box for selection of the
COM port used by the Tower and two download buttons
'Download Firmware' and 'Prepare for Coach'.
Finally, there is a Status bar (bottom line) occasionally giving
information about the status of the RCX.

To prepare the RCX for setup by the RCX Control Panel

• Place the RCX directly opposite the IR Transmitter.
• Connect the IR Transmitter to a Serial port of the computer.

Figure 103. RCX Control
Panel program.
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To set the COM-port

• Start the RCX Control Panel.
• In the RCX Control Panel, select the COM-port assigned to the IR transmitter.

Notes:

- Take care that no conflicts arise with other devices in the computer also using a COM port
(e.g. an internal modem, some network cards or a Serial mouse). The setting is saved at
the moment the RCX Control program is closed.

- Coach should use the same COM-port as the RCX Control. (See Hardware settings).

To download the system software into the RCX
The progress of the download process is indicated clearly both on the screen of the RCX and
the computer. When the process is finished, the RCX plays a little melody.
• Click the button 'Download Firmware'. Downloading takes roughly 4.
• Click the button 'Prepare for Coach' to prepare the RCX for Coach. The preparation

takes about 1 minute.
After these steps the RCX contains:
- The System software for communication between the RCX and the computer.
- The System software for the use of the RCX in Coach.
- Three test programs in Program positions 1, 2 and 3. The Program positions 4 and 5 are

empty for user programs.
Notes:

- If the RCX has been without power for longer than 2 minutes (i.e. when the batteries are
removed without connection to mains supply), the commands 'Download firmware' and
'Prepare for Coach' have to be executed again.

- 'Prepare for Coach' can only be executed after 'Download Firmware'.

- After the RCX has been used by students, it may be better to reset it.

To set up an IR range
Both the IR Transmitter (the 'Tower') and the RCX can be set up for long range or short
range communication. A range for the IR Transmitter can be selected with a switch on the
tower. The range of the RCX has to be set up in the RCX Control Panel:
• Start the RCX Control Panel.
• Click the icon of the infrared beam to switch between short (two beam symbols) and

long range (three beam symbols).
It is recommended to select short range communication (narrow beam). This will save
batteries and reduces the chance of cross talk between different set-ups in the same room.
Note: Both the Tower and RCX should be set to the same range.

To reset the RCX to its initial state
By resetting the RCX to its initial state, all Programs in the RCX are erased and the three
test Programs are reloaded into Program positions 1, 2, and 3.
• Press the button 'Prepare for Coach' in the RCX Control Panel.
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Downloading by Authors
An Author can fill all five-program positions with self-made Control Programs.
In this case, the user has the possibility to download a Program in each of the five Program
positions. To this end, first start the RCX Control Panel and only then start Coach. Keeping
this order, you will be able to fill position 1 to 3 with a Program.
• First, start the RCX Control Panel.
• Then start Coach.
• Select the desired Program Position by pressing the Prgm button on the RCX. If one of

the position 1-3 is selected the subsequent Test program will be overwritten..
• Download the Program by pressing the Send settings button.

Downloading by students
In general, Students should use Coach without the RCX Control Panel. They can only
download/overwrite a Program at Program positions 4 and 5.
If the RCX is set to Program position 1, 2 or 3, it automatically jumps to Program position 4.
If the program for position 4 is so large that there is no space left for a Program on position
5, an error message appears at an attempt to fill position 5. Students now can either limit the
Program for position 5 or overwrite the Program on position 4.
• Start Coach.
• Select a Program position 4 or 5 by pressing the Prgm button on the RCX.
• Download the Program by pressing the Send settings button.

- If you do not wish the students to use the RCX Control Panel you can remove its icon and
open the RCX Control Panel directly from the Coach directory.

- You may allow advanced students to use both the RCX Control Panel and Coach when
they need to have five program positions at their disposal.

Memory space for Programs
A maximum of 5 Programs can be stored in the RCX with a total of 1500 commands. Only
part of the memory space (32kB) of the RCX is available for Coach Control Programs:
- Part of the memory is occupied by the operating system (the Firmware) of the RCX

(16kB).
- In future, the operating system will undergo changes as new functions are added to the

RCX (10kB is already reserved for this purpose).
- The remaining part of the memory is available for transmitting control programs made in

Coach (32kB - 26kB = 6kB).
- For each Coach Program, another 0.3 kB is reserved for system software. In this way, the

RCX has 6 kB - 5 x 0.3 kB = 4.5 kB available for self-made Control Programs.
This space can be occupied either by one large Program or by several smaller ones.

- The three test programs, which are automatically downloaded into the RCX on
initialization, occupy 0.9 kB.
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11..  PPrrooffiillee  EEddiittoorr
Profile Editor is a tool for Authors to organize the Coach materials (Projects, Activities and
Results) for the students. With Profile Editor user profiles can be made and edited. Every
user in Coach is always working in a Profile. This can be in one of the standard Profiles
included with Coach (Author, Senior or Junior, and some others), or an Author-made
Profile.
A Profile consists of an identification: a name, and when desired a password. A Profile
determines further:
- In which User mode (the ‘Profile type’) Coach will start: the Author-mode, the Senior-

student mode or Junior-student mode (Coach Junior);
- Which Projects are available in the Profile;
- If, and if so, which Project and/or Activity will start automatically on starting the Profile;
- Whether printing is allowed in the Profile;
- Access to disk drives (floppies, network drives, etc.) in the Profile.
Existing Profiles can also be modified in the Profile editor.

A Profile is started via logging in or by starting Coach via a Windows icon in which a
Profile name is included.

To open Profile editor:

• Select Tools > Profile editor (available outside an Activity)
• or press <Ctrl>+ <Shift>+P.

Figure 104. Profile Editor dialog window
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Login
A profile will become active by typing the name (and password) in the Login dialog box.
• Press the Login button or select File > Login to log in a (different) profile (outside an

Activity).

Profile information is stored in the file PROFILES.C5 which is located in the Coach
directory. It is recommended to regularly create a backup copy of this file.

Warning!
Take care to have at least one (but preferably several) profiles with user Author. Never set
all profiles to user Senior Student or Junior Student. Then you are not able any longer to
start the Author version without losing your self-made Profiles.
Solution: Replace the 'faulty' PROFILES.C5 by a backup copy of this file.

1.1 Create/Edit a Profile

To create a Profile

• Open Profile Editor
• Click New to create a new Profile, or select a profile name from the list.
• Enter a Name for the Profile and click OK to confirm (or Cancel to cancel changes).
A new Profile is created and appears as selected Profile in the list. The properties of the new
Profile are displayed on the right side of the dialog.
• Modify the properties of the Profile.
• Click OK to store the changes or Cancel to cancel all changes since you started Profile

Editor.
Note: Both the name and password can be at most 10 characters long.

To edit a Profile

• Open Profile Editor.
• Select a Profile from the list at the left side. All the changes you make will be stored to

this profile.
• Modify the properties of the Profile.
• Click Cancel to cancel the changes.
• The name of the Profile you were in when entering the Profile editor is selected by

default.
Note: Be very careful not to change the Profile type of the Author profile! You will not be able to
work as an Author any longer. So first change to the profile you want to modify.   

To copy a Profile
Sometimes two Profiles are nearly identical, except for e.g. their Profile type. Via the Copy
button this can be easily accomplished.
• Open Profile Editor.
• Select the Profile to be copied.
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• Press Copy profile. The name dialog opens with a suggestion for a Profile name.
• When necessary change the suggested name for the copied Profile and click OK.
• Modify the properties of the Profile.
• Click OK to store the changes or Cancel to cancel all changes since you started Profile

Editor.

Assign a Profile to a Windows icon
(Windows 95/98 and NT experts only)
Coach can automatically start in a Profile via a Windows icon. To create an Icon-with-
Profile proceed as follows:
• Create a shortcut to Coach.exe, e.g. by copying an existing shortcut to Coach.
• Edit the properties of this shortcut, by right clicking its icon and selecting Properties.
• In the command-line field type 'c:\coach5v2\coach.exe /u:<Profile name>.' For <Profile

name> substitute the name of an existing Profile (e.g. 'class-A').
• When necessary rename the Icon to something descriptive (e.g. Coach for Class A').
• When double clicking the icon, Coach will start up with the included Profile (e.g. in the

Profile 'Class-A').

1.2 Profile properties
The Profile properties consist of a number of sections. The options of each section are
described below.

Profile type
The Identification of a Profile consists of a Name (obligatory), if desired a password, and a
Profile type.
• Name: Editing the name of a Profile is not possible. It can be done in an indirect way by

copying the Profile to a Profile with the desired name.
• Password: Type a (new) password, or remove the password by emptying the field. It is

strongly recommended to provide all Author profiles with a password.
• Profile type: Select one of the three Profile types:

Author
An Author has all of Coach's functionality available.
• Select Author for identification if you want the profile to start Coach with Author

functionality.
Senior Student
For Senior Students only the Coach Author functions are shielded.
• Select Senior Student for identification if you want the profile to start Coach in one

of its student modes.
Junior Student
For Junior Students many Coach functions are shielded. There are three User levels:
Fixed, Flexible and Own Lab.
• Select Student for identification if you want the profile to start Coach in one of its

student modes.
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Files and Printing
For the current Profile, you can set:
• which disk drive will be used to store Results (e.g. A:\ for the floppy drive). The default

setting is Projects, i.e. that all file handling starts by default in the current Project
directory and that the user can browse through all Coach Project directories. Select, if
desired, another drive letter from the drop-down list.

• Whether the user may change to other disk drives (default: Allowed). If this is not
allowed in the Profile, unmark the option Can switch disk drive.

• Whether printing is permitted. If not (option unmarked), then the Print Screen button
disappears from the Activity Toolbar.

Project selection

• Select from the list Other Projects all Projects which should be available to the users of
the profile. It is possible to select several Projects at once (use clicks in combination
with <Shift> or <Ctrl>. See Windows help).

• Click    or    to select or deselect Projects for the Profile.
• If [All Projects] is selected, all Projects appear in the Project list when the Profile is

used.
Note: If a selection of Projects exist in the Profile, then Projects which are created when working
in that Profile, will be automatically added to the list of selected Projects for the Profile.

Open on Login

• Select which Project and, if desired, which Activity will start automatically after logging
in the Profile.
With the choice None for a Project, Coach will start in the Start menu after logging in
(and automatically open the Project list). With the choice None for an Activity, Coach
will only open the Project (and display automatically the list with Activities).

- If you are in a user-defined Profile and you add a Project, this Project is automatically
added to the Projects of the Profile.

- If no Projects are selected in the Used Projects window, all Projects (also Projects added
in the future) are available to the Profile.

1.3 Example of a Profile
Grade 8 students need Coach Projects for Biology.
The Profile name could be 'Grade 8' and the password 'Biology'. The Profile type for this
Profile should be set to 'Junior Student'. The Profile properties determine the behavior of
Coach when this Profile is used.
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22..  PPrroojjeecctt  MMaannaaggeerr
The Project Manager is a useful tool for Authors in the organization of the Coach materials
(Projects and Activities). The Project Manager displays two panes which can contain
directory listings. The files or directories can be copied or deleted and some files can be
directly edited. Copying a Project, Activity or Sensor/Actuator with the Project manager
happens in a smart way, that is, all files belonging to the item will be copied along
automatically. Moreover, Project Manager displays the full names of Projects, Activities,
Sensors and Actuators (rather than the file names).
With Project Manager you can copy, edit or delete the Projects, Activities, Results,
Sensors/Actuators, Pictures, Videos, Notes and other related files (like exported Programs,
Models, Notes, Word documents, etc.).

To open the Project Manager

• In the Start menu or Project menu, select Tools > Project manager (available outside an
Activity), or press <Ctrl>+<Shift>+G.
When opened in the Start menu, the Project Manager opens with a list of all Coach
Projects to start with. When opened in a Project, Project Manager opens displaying the
files in the current Project.

To browse directories from the Project manager
To browse a directory outside the Coach Projects directory:
• Open Project Manager.
• Select a Drive from the list. The drive letters are located at the end of the list, so you

often have to scroll to see them).

Figure 105. Project Manager window.
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• When necessary, use    in the directory window to go to a higher directory.

To copy an item

• Open Project Manager.
• Select the target directory in one of the panes.
• In the other pane, select the item that has to be copied. It is possible to select several

items (see Tip below).
• Click Copy.
Note: Projects can not be copied to other Projects.

To delete an item

• Open Project Manager.
• Select the item that has to be deleted.
• Click Delete, or press <Del>.
Note: When deleting an Activity or Result, the files to which they refer are not deleted along (as
they can be referenced from another Activity or Result).

To edit an item

• Open Project Manager.
• When the Edit button is activated, you can press it to edit the selected item:

-  In case of a Project you can edit the Project definition,
-  In case of a Picture, you can edit the Picture (with the associated Program),
-  In case of a Sensor/Actuator icon, you can modify the properties.

To create Project

• Open Project Manager.
• Click the button New Project to create a new Project.
Note: Projects can not be created within other Projects.

- It is possible to select several items at once (use clicks in combination with <Shift> or
<Ctrl>. See Windows help).

- Project Manager is the only place where you can delete whole Projects within Coach.
- When the Project uses BMP and AVI files from the Graphics directory, these files are

only copied to a disk when their Read-only attribute is not set.
- To an Activity file usually belongs a number of other files, such as picture files, sensor

files, etc. When these files are located in the Activity's Project directory, then they will be
copied together with the Activity file. When these files are located in the Library/Graphics
directory and they have their Read-only attribute set however, then they are not copied
along.

- The directory names in the title bar of the windows are placed in drop-down lists. As soon
as an action has been done in a directory with Project Manager, this directory is added to
the drop-down list, so you can easily go back to such a directory by selecting it from the
drop-down list and pressing <Enter>.

- With <F6> it is possible to move items instead of copying them.
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Notes:

- When deleting an Activity also the Result (DAT-files and JRS-files) related to the Activity are
also deleted.

- Sensors/Actuators which are stored in an Activity are not present as a separate file in a
directory so they cannot be copied/deleted with Project Manager.
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AAPPPPEENNDDIIXX  II..  NNEETTWWOORRKK  IINNSSTTAALLLLAATTIIOONN
(minimal requirements Windows 95)

The information on this page is meant for experts with Windows (9x and NT) and for system
administrators.

Coach 5 can be used in a network, such as a Novell-network or a Windows network. The
application files reside in a directory on a server, and by mounting this directory, client
computers will have access to these files.
However, it is possible that some settings are different from one client to another. For
instance, the measurement and control hardware may be different, the serial and parallel
ports or the drive letter of the CD-drive might be different.

Two installation programs that are placed in the Coach 5 directory on the server allow for a
configuration local to the client. Depending on your configuration one of them should be
chosen:
- Netinst.exe for applications without CBL/CBR (makes no Registry settings)
- Netinst_with_cbl.exe for applications with the CBL/CBR (makes changes in Registry).
For this program the client machine requires Windows 9x or NT and administrator rights in
Windows NT.

11..  IInnssttaalllliinngg  CCooaacchh  55  oonn  aa  cclliieenntt  mmaacchhiinnee
The following files determine the Coach 5 settings:
- COACH.INI (Hardware settings)
- PROFILES.C5 (Profiles).
These are by default saved in
the same directory where
Coach is installed. For a
network installation, this
implies that all clients use the
same settings (hardware
settings and profiles) and
therefore, it is also possible to
create a local copy of these
files on each client machine.
• First install Coach on the

server.
• From the client, start the

program Netinst.exe (or
Netinst_with_cbl.exe),
which is located in the
Coach-directory on the
server. With this program
you can create a local configuration and Program icons on the client.

Figure 106. The dialog window of the Netinst program.
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The network drive has to be available on the client machine via a drive letter. If the settings
are the same for all client machines and you want to set these settings directly on the server,
make sure that, during the installation, the paths are correctly specified AS SEEN FROM the
clients. Make sure that the files on the server are secure.

1. The client uses the settings on the server

• In the dialog, select Use settings from the server.
• Click Next en then click Install.
The installation program creates a Coach 5 group with icons on the client.

2. The client uses local settings
The settings are stored in a locally. Now you can:
• Choose between local or global Profiles.
• Indicate an alternative location for the Coach Projects directory.
• In the dialog, select Create new settings.
• Select a directory on the client where COACH.INI file will be placed.
• Under Profiles, select the location where to use the Profiles from:

PROFILES.C5 for Profiles from the server, or
Local profiles for a local Profiles.c5 file.

• If desired, enter for Projects directory an alternative location for the Coach Projects
directory, or click Browse.

• Click Next and select the desired hardware drivers.
• Click Install.
• Edit these settings by restarting Netinst.exe (or Netinst_with_cbl.exe).

The installation program creates a Coach 5 group with icons on the client, and writes the
COACH.INI file with the specified hardware settings in the indicated directory. It also
creates, if indicated, a local copy of the file PROFILES.C5 and a local copy of the Coach
Projects in the indicated directories.
Note:

- By default, the settings are read from the COACH.INI file in the Coach directory. Via the
command-line option /i: it is possible to tell Coach to use the COACH.INI file from another
location.

- Coach will not start if the file PROFILES.C5 is missing or damaged.

Warning:
Make a backup copy of the PROFILES.C5 file!
When the file PROFILES.C5 is removed or damaged Coach 5 will not work anymore.

22..  UUnniinnssttaalllliinngg  CCooaacchh  55
To uninstall the Coach 5 follow following steps:
• uninstall the program on a server
• open the Windows’ Control Panel and select Add/Remove programs. Uninstall the

"Coach 5 Network Client" to remove the installation on the client.
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• remove the directory on the server (and if local configurations are used, also on the
clients);

• remove the icons on the clients.

33..  IInnssttaallll  CCooaacchh  oonn  aa  cclliieenntt  mmaacchhiinnee  uunnddeerr  WWiinnddoowwss  33..11

• For a network installation under Windows 3.1, start the program NETCONF.EXE.
• Proceed further as described above for NETINST.EXE.
• Finally, copy the contents of the directory "HelpDlls" in the Coach 5 CD-rom to

Windows’ system directory (usually this is C:\Windows\System).
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AAPPPPEENNDDIIXX  IIII::  CCOOAACCHH  SSHHOORRTTCCUUTTSS

Shortcuts are special key combinations or key-button combinations which can be used to
accelerate certain actions in Coach.

Shortcuts for menu items

<Ctrl>+D Options > User mode… > Author

<Ctrl>+S Options > User mode… > Senior student

<Ctrl>+J Options > User mode… > Junior student
F3

 (in the Start screen) or

 (in a Project)

F8

F9

<Shift>+ 
Erase all values and Start a new run

<Shift>+ 
  

Erase all values and receive data from Data logger

<Shift>+ 
Open the Activity-options dialog (Advanced users only)

<Ctrl>+F9 Start > Execute in Quick mode

<Ctrl>+ Open the Diagram settings in a Diagram window

<Ctrl>+ Open the Table settings in a Table window

<Ctrl>+ 
(In an Activity) Jump out of the Activity ánd the Project

<Ctrl>+ Re-scales the vertical direction only

<Alt >+F9 Continue Manually-triggered measurements with data-entry

<Shift>+ Open the Diagram Style in a Diagram window

<Shift>+F9 Start  >  Execute and Erases all values

<Alt>+X
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<Ctrl>+P

<Ctrl> + Z Undo the last edit (in a Table also to undo the last Processing
action or Analyse action)

<Ctrl> + A Select all (e.g. in a Table or Text window)

<Esc>

The Escape key can be used to cancel any action. To interrupt
Program execution, the <Esc>-key has to be pressed for some
time (until effective).

Shortcuts for Programming

F6 Go to Command list

<→→> Go to Command list

<Ins> New line (with indentation)

<Del> Remove line or a selection of lines

<Ctrl> + Z Undo the last edit
<Ctrl> + X or
<Shift> + <Del>

Cut

<Ctrl> + C or
<Ctrl> + <Ins>

Copy

<Ctrl> + V or
<Shift> + <Ins>

Paste

<Ctrl> + Z or
<Ctrl> + <BkSp>

Undo/Redo last edit (Toggle)

<Tab> Indent a selection (to the right)

<Shift> + <Tab> Indent a selection (to the left)

Mouse click Select line

Mouse drag Select lines

<↑↑> Line up

<↓↓> Line down

<Shift> + <↓↓> Enlarge/reduce selection, downwards

<Shift> + <↑↑> Enlarge/reduce selection, upwards
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Data Video shortcuts

<→→> one Frame forward among the selected Frames

<←←> one Frame backward among the selected Frames

<PgDn> one Frame forward (among all Frames)

<PgUp> one Frame backward (among all Frames)

<Ins> add current Frame to the selection of measured Frames

<Del> delete current Frame from the selection of measured Frames

<↑↑> zoom in

<↓↓> zoom out

<Shift>+Start Erase all values and start a new Video measurement (or
<Shift>+<F9>)

Shortcuts for editing the Command list

<Enter> Select the item
<Ctrl>+<Enter> Edit item
<Shift>+<Enter> Edit menu title
<Shift>+F6 Edit procedure (own command). Only if the name of an own

command is selected.
F7 Rename procedure (own command). Only if the name of an

own command is selected.
<Ctrl>+<Del> Delete procedure (own command). Only if the name of an

own command is selected.
<Shift>+<Ctrl>+<Ins> Insert (before)

Shortcuts for editing a program and procedures (Author mode)
F5 Jump to Micro-world Procedures
F6 Jump to menu (Command list)
<Enter> New line with indentation according to the previous line
<Backspace> Unindents to a previous indentation level if used in a position

preceded only by spaces.
<Ctrl>+Z Undo (only the last action)
<Ctrl>+X Cut
<Ctrl>+C Copy
<Ctrl>+V Paste
<Shift>+<Del> Cut
<Ctrl>+<Ins> Copy
<Ctrl>+<Backspace> Undo (only the last action)
<Shift>+<Ins>ert Paste
<Tab> Indent the whole selected block
<Shift>+<Tab> Unindent the whole selected block
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Mouse click Move the cursor
Mouse drag Select a block
Arrows, <Del>,
<Backspace>,
<Home>, <End>,
<Ctrl>+<Home>,
<Ctrl>+<End>,
<Ctrl>+Right arrow,
<Ctrl>+Left arrow,
<PgUp>, <PgDn>

Behave like in a text editor

General Windows shortcuts

Ctrl+X Cut

Ctrl+C Copy

Ctrl+V Paste

In addition to these shortcuts you can invoke the action on a button by <Alt> + underlined
letter, e.g. <Alt> + N for New.


